Administrator’s
Guide

G

Configuration Management

Version 2

SOLARWIND.NEC

NETWORK MANAGEMENT SOFTWARE

<3 Printed on Recycled Paper



Administrator’s Guide for Cirrus Configuration Management - Version 2

February 6, 2006

© 1995 - 2006 SolarWinds.Net. All Rights Reserved.

Microsoft® and Windows 2000® are either registered trademarks or trademarks
of Microsoft Corporation in the United States and/or other countries.

Graph Layout Toolkit and Graph Editor Toolkit © 1992 - 2001 Tom Sawyer
Software, Oakland, California. All Rights Reserved.

Portions Copyright © ComponentOne, LLC 1991-2002. All Rights Reserved.

Some images and artwork © 2000 - 2003 European Space Agency. All Rights
Reserved.

About SolarWinds.Net

SolarWinds.Net, Inc., founded in 1995, is a privately held Oklahoma Corporation
with headquarters in Tulsa, Oklahoma. The company develops and markets an
array of network management, monitoring, and discovery tools to meet the
diverse requirements of today’s network management and consulting
professionals. SolarWinds” comprehensive products continue to set benchmarks
for quality and performance and have positioned the company as the leader in
network management and discovery technology. SolarWinds” customer base now
includes over 45 percent of the Fortune 500 and customers from over 100
countries. The SolarWinds global business partner distributor network now
exceeds 100 distributors and resellers.



Table of Contents

Chapter 1: Introduction 7
Who Should Read This GUIde .......cccccouviiiiiiiiiiiniiiiicinccccee e 7
What's Covered in This GUIAE ........cccovrueveueiinnninieicccnniniececcteneeeeneieeens 7
OVETVIEW Of CIITUS....cviiiiiiiiiiiceceec e 7
How to Contact SolarWinds.INet.........c.ccoeeivieineininininiiniincicccceeeee 9

Chapter 2: Installation & Setup 11
Licensing and Version OPtions ... 11
System Requirements............cccoccvunnne.

Step 1: Installing SQL Server

Step 2: Installing Cirrus .......ccoeeivivivininiiiiiiccc s

Step 3: Configuration and Setup...........ccoeerieiiinninniicces 12
Creating a Microsoft Access Database............cccccceviiiiiiciiinininccnee. 14
Creating a SQL Server Database ... 14
Setting the System Defaults ............cccoovviriiiiiiinccce, 15

What t0 DO INEXt...ooiiieiiiiiiiciniccrcr et 17

Chapter 3: Managing Nodes 19
AddIng NOES.......ooiiiiiiiiiiicii e 19
Importing a List of NOdES ........ccccceciviiiiiiiiiiiiiiceces 21

Importing a Text File - Selecting Column Delimiters...........c.ccccoevueunnnns 22

Importing an Excel Spreadsheet — Selecting the Worksheet.................... 23

Importing from a SQL database — Connecting to the Server................... 23
Editing NOdes .........cccoviiiiiiiiiiiiicccc s

Device Details Tab....

Interfaces Tab........cccccoeviriiiiiiiicccc s

Configuration History Tab............cccooeiiiiiiiininiiiicccccnncce, 26

INVENtOTY Tab ...cocuiiiiiiiiiiic e 27
Editing Multiple NOdes .........cccccocuiuiiiiiiiiniiiiiiiccees 28
Custom Properties.........coooeceiiiioieecc e 28

Chapter 4: Managing Configs 31
Downloading COnfigs.........cccocviiriniiiiiiiiiiiiiccccceesesee s 31
Editing COnfigs .......cooevuviiiniiiiiiicieiciccc s 32

Saving Changes with ReVisions ... 32
Decrypting Cisco Type 7 Passwords ...........cccoeermineienininininiiiceneiennns 33
Comparing Configs........covviiiiiiiiiniii s 34
Setting a Baseline Config ...........ccccecuvuiiniiniiiiiiiiiiceces 35
Baseline Entire NetWork..........cccoeeiiiinniiiiiiccccnnccccccen 36
Config Change Reports..........cccccceuiiiiiiiiiiiiiiiiicceeee s 37
Comparison Criteria and RegEx Patterns............cccocoovviniiniiinnicnnnnn. 38
Advanced OPHONS .......c.ccuevviriiiiiiiccicee e 40
Config SNIPPELS .....coviiiiiiiicci s 41

Creating a New Config Snippet ........cccocovriiiiniiininiiicecccccnes 41



Cirrus Configuration Management

Uploading Configs........ccoouiiiiiiiiiiiiiiiicicccieccc e 43
Uploading an Entire Config..........cccovuvimiiiiiiiiiinninicicccccnnas 43
Uploading Selected Lines...........cccoviiiiuiiiiiiiiiiiininiiiiccessscccenenas 45
Uploading a Config Snippet.........cccoviiiiuiiiiiiiiiiiiiiiiicccccccnccenas 47

Finding an Address..........cccooiiniiiniii e 49

Search CONfIGS ......ccciiuiuiiiiiiiiiiic s 50

Purging Configs from the Database............cccooeeuiiinniiiiiiccic 52
Selecting the Purge Method............cccoviiiiiiiiiiiiiiicccccs

Specifying a Selection Criteria
Chapter 5: Command Scripts
Getting Started......
Selecting Nodes
Executing Command Scripts..........ccccoeivivivniiiiinniiinces
Saving and Loading Command Scripts ........cccoeevveiiiiiniiininicenicine, 61
Advanced OPtioNS........cceeuiueiniiiiiiiniicc e 61
Using Macros within SCripts.........cccccoveiiiiiiiiiiiiccccccccenen 62
Example Macro SCript .......coouirumiieiiiiiiicccc e 63
Chapter 6: Inventory 65
Performing a Full INVeNtOry ........cccccovvviviiiiiiiicicccccceciie 65
Running Inventory on a Single Device or Group.........cccccccovvevvviviviciincnnnne 65
Scheduling an INVENLOTY ...........ccccciiiiiiiiiiiiiiiiiiccce s
Inventory Settings ........ccoovoiiiiiiie e
Viewing INVENtOry ..ot
Chapter 7: Reports
Viewing RepPOrtS.......ccviviiiiiiiniiiiiiiicc s
Creating and Editing Reports
General Tab........oociiii s
Select Fields Tab .........cccccoiiiiiiiiiiiiiciiccccce s
Filter Results Tab........cccccococeiviriiiiiiiiiiccccrccec e
Deleting RePorts.......cccoviiiiiiiiiiiiiiiiiiicc s
Scheduling REPOTIES ........ccccuiiiiiiiiiiciii s
Chapter 8: Scheduling Tasks
Creating a New JOb .....ccooviiiiiiiiiiiicc s
Editing @ JoD.....coviiiiiiiiciicc e
Job Specific SEttNGS ........cccoeuiiiiiiiiiiiiicccc s
INOAES TAD ...
Download Config Tab .......ccccccviiiiiiiiiiiiicce
Command Script Tab.......ccociiiiiiiiiiiii s
Report Tab........ccccceuevne
Config Mirror Tab......
Program Tab ........cccccoovrurunnnnne
Config Change Report Tab
Viewing JOD LOZS ....c.oviiiiiiiiiiiiiiiiiiciccccccc e
Chapter 9: Settings
INOE LSt ..ttt

4 Who Should Read This Guide



& Recycled Paper Table of Contents

SECUTIEY oo s
Global Macro Settings
Community String
Login INformation ...........ccocviiiiiiiiiiiiiiiiccccceceeas
Transfer PrOtOCOLS .....c.ccveveciieieeieceeteet ettt ettt eseeae e v v naas
Notification DefaultS.........cccovieieieieieiiiieieeeeeeee e sse s reens
Email Defaulls .....cc.ccveevieieieeieiieeeie ettt ettt ve b veevaenne s
SIMTP SEIVET ...veeieieeiieiieierteeteie et ste st stesseeste st e ste e e esesseessesseessesseessessaensens
Custom Properties......
Reports.....coevereenene
Scheduled Jobs...............
Node Details Window
NOAE DELAILS ...eveveeeiiieiieieieieeeeee ettt re b besbesesaens
TNEEILACES vttt ettt ettt naas
Device INVeNOrY ......cooiiieieici e
Ping WINAOW ..o
Node MONItOTiNG......ccocvuiviiiiiiiiniiiii e
Search CONfIGS .......ccovuiiiiiiiiiicciic e

Config COMPATISONS .....c.curmimiviriiiiiiiiiiccie s 98
Config Mirror
NetworK.....ccoveenee.

MIB BIOWSET ...veinvieeiiieiteiieeeiteeitesteesite st e sitesteesate et esatesssaesaseenaaesseesaseens
AdVANCE ...ttt ettt et b e rsebeereennas
ApPlication Style.........ccocciiiiiiiiiiiii e 107
TOOIDATS ...ttt ettt ettt e te e e e b e be e b e s se e b e s taessessaesbassaensens 107
5€8S10N TTACINEG ......oovieveiciciieie e 108
Chapter 10: Database Manager 109
Getting Started..........ccoovviviiiiiic s
Adding a Server.......
Database Backup ........
Restore a Database
Compact a Database...........ccccoeiviiiiiiiiiiiiiies 111
Compact Individual Tables..........ccccccovviviiiiiiiiiiiie, 111
View Database DetailS ........cccecveeeerrieriiiinieieeeieeerestesresseeeeeeere e ssessessens 112

Who Should Read This Guide 5



Cirrus Configuration Management

View Table DEtails .......ccccveiiririirierieieieieiierecteeeteeesese et ss e s e ese e svesaens 112
Exporting Data.........c.cooiiiiiic e 112
Editing Database Fields..........c.cocooiiiiiiniiiniiiiiccccccccs 113
Detach @ Database ........ccceeieierieriieiiieseeiceeeie sttt st nesre e 113
Creating a Database Maintenance Plan...........cccoooveiiiiinininiiniennne, 113
Using Enterprise Manager ...........cccoeveiiiieininininiiiniiecenecesceeeeeenennes 114
Chapter 11: Cirrus Scenarios 117
Updating the Login Banner.............cccooiiiiiiininiiniiiicccccnccenes 117
Scenario REferencCes .........cocivirierieieieieiieeseee et 119
Configuring an Automated Nightly Backup .......ccccceeviiiviiiiiinne, 120

SCenario REfEIEICES .......ccccivviriirieieeieieieresteieteeee et se s 121
Changing Community Strings on Several Routers............ccccocoviiininininnen. 121
SCeNArio REfEIEICES .......ccoivvirieieieeieieieteetetet ettt e et se s 122
Changing Wireless Settings on All Access Points.............cccoevvuiviriinininiencn. 123
SCeNATIO REFEIENCES .....ecuvivieeiereeiectieieete ettt a e ve v eaeas 124
Changing an Interface’s Description............ccocoiiiciiiiinininccccceicees 125
SCeNATiO REFEIENCES .....ccvivieiicieeeiectieieetecte ettt erean 127
IOS and Firmware Upgrades.............cccoovuviviniiiiiiciiiinicccciceeeees 128
SCeNATIO REFEIENCES .....ecuvivieeiiieciiectieieeteeteste ettt eaeneas 129
Appendix A: Software License Key 131
Appendix B: Custom Toolbars 133
TOOIDATS TaAD.....cvictieiiiieieeteeeeeteee ettt ettt e e e reets e beert e be e s esreens 134
CommMaANAS TaD......c.ccvevieiiieiiirierieeee ettt bess e s ere s 134
MIBs Tab................
Show Commands Tab
Tools Tab........
Options Tab
Appendix C: Macros 143
NOAE MACTOS .....uviveeiectieieeteeieeeete et e ste st e steetsessesstebeessesseessesseessesseessassenssessenns 143
Config-Archive Macros ..........ccociiiiiiiiiiiiiiiniiiic s 145
Command Script MaCIOS.........ccociuiuiiieiiiiiiiiiice s 146
Appendix D: Regular Expression Pattern Matching 147
Appendix E: Frequently Asked Questions 151
Appendix F: Glossary 155
Index 157

6 Who Should Read This Guide



Chapter 1: Introduction

Who Should Read This Guide

This guide is intended for those responsible for installing and setting up
SolarWinds Cirrus Configuration Management version 2. This will normally be
the system/network administrator. The Windows account used to install Cirrus
will need to have administrative rights on the server.

What’s Covered in This Guide

This guide includes sections that discuss

e  Installation and setup

e Adding Nodes and getting started
e  Scheduling tasks

. Performing inventory scans

e Modifying and comparing configs

. Creating and editing reports

Overview of Cirrus

Cirrus Configuration Management is a powerful application providing the
network engineer with a quick and efficient method of managing the
configurations of network devices: Routers, Switches, VPN Concentrators,
Wireless Access Points, Firewalls, etc. Cirrus is a highly advanced, yet easy-to-use
application designed to streamline and automate routine network configuration
management tasks such as:

o Scheduled Back Ups of configs

. Ability to make Bulk Changes

o Updating access lists

o Device Inventory

. Changing SSIDs on Access Points

. Altering community strings for a group of routers or switches
o Ability to roll out Mass Config Changes

. Config Comparisons

Cirrus Configuration Management is available in two different versions; Desktop
and Enterprise. The Desktop Edition is for stand-alone use on a laptop or desktop
by one user. The Desktop Edition is limited to managing 25 network Nodes.
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The Enterprise Edition can be used in a stand-alone or workgroup environment
with multiple users. The Enterprise Edition is scalable and is available in packages
from 50 Nodes to an unlimited number of managed Nodes. Many features (such
as SQL Server support, Device Inventory, and integrated MIB Browser) are only
available in the Enterprise Edition.

Cirrus Configuration Management supports many types of network devices from
many hardware vendors. Device Command Templates for Cisco, Foundry, Dell,
HP Juniper, Motorola, Arris and many others are included.

Cirrus Configuration Management includes detailed Device Inventory. The
inventory includes interface and port details, IP Addresses, information about
ARP tables, cards in each slot, firmware levels and much more. The information
can be easily extracted and used by other applications.

8 Overview of Cirrus
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How to Contact SolarWinds.Net

The SolarWinds website is an excellent resource located at
http://www.SolarWinds.Net. If more information is needed, please do not hesitate
to contact a SolarWinds representative.

Support

Visit the Support website at http://SolarWinds.Net/Support/index.htm to access
the Knowledge Base, Frequently Asked Questions, obtain Program Updates,
contact the Support Team, provide feedback, visit the User Forum, and more!

E-Mail

The SolarWinds Support Team can be E-Mailed at Support@SolarWinds.Net.

Sales

Send e-mail to a Sales representative at Sales@SolarWinds.Net for any sales needs.

Mail

SolarWinds.Net
8221 East 63 Place
Tulsa, OK 74133 USA

How to Contact SolarWinds.Net 9
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Chapter 2: Installation & Setup

This chapter will walk through the installation process for Cirrus. Installation

proceeds in 3 steps:

¢ Installing Microsoft SQL Server
o Installing Cirrus
e Running the Startup Wizard

Licensing and Version Options

Cirrus is available in four different packages:

Desktop Enterprise

DL25 DL50 DL100 DL200 | DL500 | DL1000 DLX
Maximum
number of N.
Nodes that 25 50 100 200 500 1000 ) 04
can be Limit
managed
Database Access SQLor | SQLor | SQLor | SQL or | SQL or | SQL or
Format Access | Access | Access | Access | Access | Access

System Requirements

The System Requirements for Cirrus vary based upon the number of Nodes,
frequency of config downloads, how long configs are maintained in the database,
and several other factors. The table below represents some general guidelines for

a minimum configuration.

Minimum System Requirements

Operating System | \indows 2000 Server with Service Pack 4
Windows 2003 Server with Service Pack 1

Windows XP Professional with Service Pack 2

CPU Intel Pentium 3 (or equivalent) - 800 MHz or higher

Memory 256 MB of RAM

Hard Drive Space 1 GB of space available
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Step 1: Installing SQL Server

2
U Installing SQL Server is NOT required to run Cirrus. Both the Desktop and Enterprise
versions can support an Access database.

Alicensed copy of Microsoft SQL Server 2000 Desktop Engine (MSDE) is
distributed with each copy of Cirrus. MSDE supports a maximum database size
of 2GB. Depending on how the tool is used, it may be necessary to acquire and
install either the Standard or the Enterprise version of SQL Server. MSDE may be
installed from the CD or by logging into the customer area of the SolarWinds.Net
website and downloading Cirrus.

ﬁ SQL Server installation defaults are specified in the SETUP.INI file. If SQL Server needs to be
installed anywhere but the default location, or logging needs to be enabled for
troubleshooting, this file can be modified once it is saved to the hard drive. More information
about installation options can be found on Microsoft’s website at
http://www.microsoft.com/sql.

Step 2: Installing Cirrus

1. Begin the Installation of Cirrus from either the CD or the download
file.

2. Choose the target directory where for the Cirrus installation. The
default is C:\ Program Files\ SolarWinds\.

3. Follow the steps of the Installation Wizard and if prompted to do so,
restart the computer.

Y
U If prompted to install the Software License Key, please follow the instructions in Appendix A:
Software License Key on page 131.

Step 3: Configuration and Setup

After installing Cirrus, it will be necessary to run the Startup Wizard to continue
the installation and setup process. The Wizard will configure connectivity to the
database and establish the default settings such as the Global Community String,
Username, Password, Enable Level, and more.

The two database formats supported by Cirrus are Microsoft Access and SQL
Server 2000. The Desktop package only supports the Microsoft Access database
format, and the Enterprise packages include additional support for SQL Server.

12 Step 1: Installing SQL Server
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To begin,

1. Open SolarWinds Cirrus Configuration Management from the
Windows Start menu: Start > SolarWinds Configuration Management >
Configuration Management.

=10l
Eile Help
FEAorIaRha o bR X ASRoRa nEeEEef
@uultkstarl‘ Lz
JOLARWiND).NET [

Network Management Tools

Configuration Management V8 DL1000

Configuration Management Version 8.0 - July 2005

Welcome to SolarWinds Configuration Management.

C i provides a quick and efficient method of
managing the configurations of netwark devices ... Routers, Switches, VPN
Concentrators, Wireless Access Paints, Firewalls, etc.

Simply select a device and, click the right mouse button ... the device's comfiguration is
downloaded in in real time via TELNET or S3H1._ All dovmloaded configurations are
archived to a central database for versioning, review, and easy comparison

E]\ Startup Wizard | Click on the Startup Wizard button to get started.

Use the Startup Wizard to create a new Configuration Management database and
setup the default SNMP Community Strings and passwards usad on your network

2. Click the Startup Wizard button in the middle of the Quick Start page, or
select New/Open Database Wizard from the File menu.

3. Click Next > on the Welcome screen to begin the Wizard.

Configuration Management - Startup Wizard

Database Selection

This portion of the wizard will guide you through selecting the name. type.
and location of the datahase to be used for this installation of Solafwinds
Configuration Management.

(%) Create a New Database
() Dpen an Existing Database

Muore Information sbout chanaing databases..

Select one ofthe above options, then click 'Next' to continue. ..

Cancel

4. Ensure that Create a New Database is selected and then click Next > to
open the New Configuration Management Database dialog.

Step 3: Configuration and Setup 13
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Creating a Microsoft Access Database

1. Select Microsoft Access Database at the top of the dialog.

4@ New Configuration Management Database ... El
Which type of D atabase would you like to create ? -UK

() SOL Server Database
i a——

Select Microsaft Access Database ..

Microsoft Access Database Filename
LC:Program Files'S alare/indstConfiguration M anagement\Configurationt anagement. Configh gmt v | D

2. The options at the bottom change to display a drop-down text box
prompting for a filename. Type a path and filename for the new

database, or use the Ellipsis J button to browse to a location. Once
satisfied with the path and filename, click OK to continue.

Creating a SQL Server Database

1. Select SQL Server Database at the top of the dialog.

4@ New Configuration Management Database ... El
Which type of D atabase would you like to create ? -UK

(&) SOL Server Database
I ———

Select SOL Server Database .
Logon ta SOL Server using:
(@ Windows NT Integrated Security
(4 S0L Server userid and password

SOL Server |YDUHSEHVEH\SDLAHW\NDS v‘

Datahase Name | CorfigurationManagement B

Download SOL Server

2. Select the name of the SQL server from the drop down list provided.
Normally every SQL Server on the network will be displayed in the drop
down list, but the name (or IP address) may need to be entered.

3. Create a new database by entering a Database Name in the text box
provided or connect to an existing database by selecting the Database
Name from the drop-down list.

14 Step 3: Configuration and Setup



&3 Recycled Paper Chapter 2: Installation & Setup

4.  Use the radio buttons to select the authentication type for the SQL Server
and then click OK to continue.

2

U If the SQL Server ID and password option is used, an ID with sufficient rights to create
new databases on that server must be used (for example, the SQL Administrator
account).

x
=2-8 C\ -
(23 Documents and Settings

3 Inetpub

(1423 Program Files

(] Accessones

{1 Common Files

ComPlus &pplications

Internet Explarer

Microsoft Baseline Security Analyzer

Microsoft FrontPage

Microsoft Script Debugger

Microsoft SOL Server

Hethesting -
{3 Outloak Express

-3 Selatwinds

£ Comman

Configuration Management

Urinstal Information =l

Selected Directory  C:%Program FileshS olafw/indshD ata

5. Select a location to save the database by navigating to the desired path
and then click OK to continue.

Setting the System Defaults

After creating a database, the System Default settings will need to be set. These
are fields such as Default Community String, Default Username, and Default
Execute Protocol. When adding Nodes, the System Default settings are used
unless otherwise specified.

(G SOLARWIND.NE

Configuration Management - Startup Wizard

System Defaults

This portion of the wizard will guice you through setting the authentication and
transfer type defaults foryour enterprise. By using these default settings, you
can easily change and set ane transfer method or set of credentials for all or
some the devices inyour enterprise. When adding devices to Configuration
Management, you have the option of using the system defaults, or manually

assigning those settings.

To utilize a default setting for & particular device, selectthe option that
begins with ${Global. }in the Node Properties view.

Click the 'Next' button to setthe system defaults. or click the 'Finished' button

complete the wizard.

Step 3: Configuration and Setup 15
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1. Click Next > to begin the System Defaults setup.

Configuration Management - Startup Wizard

Default Community String

Enter the default commurity sting below. You can set a device to use this default
community string by sslecting ${GlobalCommuritySting} in the Community String section in
the Mode Properties.

Commurity String

public

Click the 'Next' buttan to continue..

2. Enter the default community string for the Nodes on the network, and
click Next - to continue.

@m?ﬂnm.nzt‘ Configuration Management - Startup Wizard
etwork Mana ols

Default Authentication Settings

Enter the default suthentication settings below, Y'ou can set a device to uze these default
settings by selecting the ${Global...} option in the respective section in the Node Properties.

Usemame admin ${Globall semame}
Password admin ${GlobalPassword}
Enable Level enable 0 A ${GlobalEnablel evelt
Enable Password | admin ${GlobalEnablePassword}

Click the 'Next' button to continue...

3. Enter the Default Username, Password, Enable Level, and Enable
Password. Click Next - to proceed.

@mﬂ’winm.nzt Configuration Management - Startup Wizard

Network Management Tools

Default Communication Settings

Enter the default communication settings below. You can set a device to uze these default
settings by selecting the ${Global...} option in the respective section in the Node Properties.

Execute Commands and Scripts using | TELNET + | protocol - ${GlobalE kecPiotocal}

Download / Upload Configs using TELMET w | protocal  ${GlobalT ransferPratacall

Click the Nend! button to continue..

16 Step 3: Configuration and Setup
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4. Enter the Default Execute Protocol and Download/Upload Protocol,
and then click Next - to continue.

Configuration Management - Startup Wizard

Group the Node List

The devices [Modes) that are added to the Configuration Management database can be
grouped by Machine Type, Yendor, SNMP Status, ete. Use the Node Group field to assign &
group to each Node such as Finance, Accounting, Firewalls, Building &, or Sales.

Group the Flouters/Suitches by + | Nods Group v

Nodes can also be grouped by custom propesties such as Building, State, Department,
Application, or any other set of Custom Properties you create.

Create Custor Properties

Click the Nend! button to continue..

5. Select a field to group the Nodes by in t he Node List from the
dropdown menu. If no grouping is required, select “<none>" at the top
of the list.

Configuration Management - Startup Wizard

Scheduled Job Authentication

Cirrus Configuration Management is installed with some sample Scheduled Jobs. However, these
sample jobs need authentication credentials to run. Enter the authentication credentials below.

Please Note: When adding new Scheduled Jobs, you will need to reenter this information in the
New Job Dislog bor:

Enter your Windows login DOMAINVUSER NAME

Enter your password

Confim the password

Set Usemame and Password

6. Enter the default Windows User information for Scheduled Job
Authentication. This is the username and password of the Windows
account the Scheduled Jobs will run as. Click the Finished button to
complete the Startup Wizard.

What to Do Next

After successfully completing the Startup Wizard, the database must be populated
with the network Nodes that are to be managed. This can be accomplished by
either adding Nodes individually or by importing a list of Nodes.

Instructions on adding Nodes individually are located in Chapter 3: Managing
Nodes on page 19.

Details on importing a list of Nodes can be found in Chapter 3: Managing Nodes on
page 21.

What to Do Next 17






Chapter 3: Managing Nodes

After creating a database, Nodes will need to be added to the Cirrus database.
There are two ways to add a Node; add one device at a time, or importing a list of
Nodes from a file. These two processes are described in this chapter.

Adding Nodes

2
To add a single Node, click the = button on the toolbar, or select Add New Node
from the Nodes menu. Once the Add New Device dialog is displayed, enter the
Node’s hostname or IP Address, login information, and communication protocols.
In some cases, the Device Command Template will not be discovered automatically.
If this happens, set the template manually by using the dropdown menu to assign
a specific Device Command Template.

2
U The default Device Command Template (Auto Detect) should always be tried first. If Cirrus is
unable to determine the appropriate Device Command Template, or assigns the wrong template,
then set it manually.

Also be sure to enter an appropriate Node Group for the Node. The Node Group is
used by default to organize the Node Tree that is listed on the right side of the
application. If the Node that is being added uses HTTPS when connecting to its
web interface, set Browse via HTTPS to Yes.

73 Add New Device X

Hostname or IP Address

SHMP C il tring  H{Globalc ity =
Device Template Auto Determine
Mode Gr

Commenits

= Login Information
User Name SiGlohalllsertams }
Passwored SiGlohaPassword}
Erable Level HiGlobaErableL svel;

Enable Password FiGlobaEnablePassword}

enahls 0

= Communication
Command Exec Protocol  ${GlobalExecProtocol; = TELNET
Config Transfer Protocols  §{GlobalTransferProtocol) = TELNET

Browse via HTTPs

PING

ety SHMP
Cammunity

Veiity Login
Information

[] Keep this window open so | can add more devices [] Show Login Trace:

2
U To find Node information, use the Telnet or Web Browse buttons to connect to the device.




Cirrus Configuration Management

When entering the Login Information, enter the values just as they would be typed
when manually logging into the device. For example, if the only thing that needs
to be typed for Enable Level 15 is “15”, then simply enter “15” for the value.

Four options are available for Command Execute Protocol and Config Transfer
Protocol; TELNET, SSH1, SSH2, and SSH Auto. When selecting SSH Auto, Cirrus
will first attempt to negotiate an SSH2 connection, if SSH2 is not supported, it will

default to SSHI1.

To confirm the community string is valid, click the Verify SNMP Community button.

%2 Add New Device 23

= Hede Details
Node Group
ShMP Community String

Comments

= Login Information
User Name
Pazzward
Enable Lewel
Enahle Password
=l Communication
Command Exec Protocol

Config Transfer Protocols 34 GlobalTransferProtocoly

Hosmame or IP Address 10.10.5.128

FBlokalCommunity } = pulhlic

admin

admin

o

acmin

F{GlohalExecProtocol = TELNET
= TELMET

Cancel

P Address
o validate SNMP

" SNMP Community

10.10.5.128
Responding to SNMP Queries
Fead-Write SNMP Community String

["] Keep this window open so | can add more devices

FING

Verity SHMP
Commurity

To ensure the login information is accurate, click the Verify Login Information

button.
%2 Add New Device 3
Hosmame or IP Address 10.10.5.128
= Hede Details
Node Group
ShMP Community String P GlobalCommunity } = pulhlic
Commerts
= Login Information
User Name admin
Pazzward admin
Enable Lewel o
Enahle Password acmin
=l Communication
Command Exec Protocol F{GlohalExecProtocol = TELNET
Config Transfer Protocols 34 GlobalTransferProtocoly = TELNET
P Address 10.105.128 PING
f Validate Login Usemarme and Password OK Werly SHMP
Commurity
Werfy Login
Inform.
["] Keep this window open so | can add more devices

Adding Nodes
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Click the OK button to add the Node to the database. Clicking OK will
automatically verify the community string and login information before adding
the device.

2
U To keep the window open and add additional Nodes, ensure the Keep this window open so |
can add more Nodes checkbox is selected.

Importing a List of Nodes

As opposed to entering Nodes one at a time, a list of Nodes can be imported from
several different file types. Nodes can be imported from text files, Excel
spreadsheets, Access databases, SQL databases, and Orion NPM or Engineer’s
Edition NPM databases. Cirrus can even import Nodes from a CiscoWorks or
Kiwi CatTools database export.

Although there are small differences in the import process depending on the type
of file used, most of the options are the same. The file-specific options are listed at
the end of this section.

To launch the Import Wizard, select Import Devices from the File Menu.

i 2 Import Wizard ;‘@El

Import Devices ...

This Import Wizard will assist you in importing Devices into Configuration Management. You can import
Devices fiom a text fils, Excel spreadshest, Metwark Performance Monitor database, Network Sonar discavery
database, or other databases. Your import file/database will need to include the P Address of each device.

“wihat type of File / D atabase would you like ta import from :

Text File

Excel Spreadsheet

Engineer's Edition Metwork Performance Manitor Database
Network Sonar Discovery Database

Qrion Metwork Performance Moritor D atabase

SOL Server Database

Microsoft Access Database

Bl E 6 EEC

Select the file type from the list and then click Next ->. Select the file to import by
either typing in the path, or by browsing to it, and then click Next ->.
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% Import Wizard [\@l@l

Assign Import Colurns

Click the top callin ths calumn you would ke to impart, then sskect the import field from the dopdown
Columns that are marked <ignare> will not be imported.

AgentlP ModeCaption  Carmunil <ignor + |<ignore>  <ignore>  <ignore>
1010192 Cisco-12004P1  public Ggnore> 0 test
1010153 Cisco-1600-4 public MadeCagption 0 test
1010156 Cisco45002 public MadeGroup 0 test
10101124 Foundy Testlab  public AgentP 0 test
1070.1.61  Dell-3248 public Cornmunity 0O test
1070111 AvaysiwirelesssP  public (M EmmiEis 0 test

Usemame

Passward

Enahlelevel

EnahlePasgward

ExecProtocal

TransferProtocol [ Rz Earcel

Assign each column a field name by clicking on the column header and selecting a
field from the drop down list. To bypass a column during the import process,
select “<ignore>” from the list. Once satisfied with the column name assignments,
click Next >.

3 Import Wizard

Select Import Rows

The following rows will be imported. Uncheck the rows that should be skipped. Press the space bar to Check/UnCheck a
group of selected roves.

AgentlF ModeCapgtion  Community  Usermame  Password Enshlelevel EnablePassword
1010112 Cisco-1200-4P1 public admin test 0 test
1010153 Cisco-1600-4 public adrnin test 0 test
1010156 Cisco-4500-2 public adrnin test 0 test
10101124 FoundpTest-Lab  public admin test 0O test
1010161 Del-3248 public admin test 0 test
1010111 Awapa'wireless-4P  public admin test 0 test
I Check Al ] [ Uncheck All l I Toogle selected ows ] [ < Back ] I Mext > } [ Cancel l

By default, all Nodes in the list will be included in the import. If there are Nodes
in the list that need to be excluded, uncheck them, and then click Next > to
continue.

The last page has two options; one allows the user to exclude Nodes that already
exist in the Cirrus database, the other will discover details about the Nodes being
imported. Leave the box checked to exclude Nodes with IP Addresses that
already exist in the database. If importing a large list of Nodes, to save time,
uncheck the option to discover device details after the import. Click Import to
begin the import process. Once the process has complete, click Done to close the
dialog.

Importing a Text File - Selecting Column Delimiters

When importing from a text file, Column Delimiters will need to be defined.
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b3 Import Wizard : fﬁl@l

Select column delimiters
wie need to know how each colurn in the text il is delimited. You can select more than one delfimiter i nesded.

[Otab [ semicalon Camma [ Space [ Other: I:l

1010112 Cisco-1200-4P-1 public  admin test 0 test

1010153 Cisco-1600-4 public  admin  test 0 test
1010156 Cisco-4500-2 public  admin test 0 test
10101124 Foundip-Testlab  public  admin  test O test
1010161 Del3248 public  admin test O test

1010111 Avayawieless4F  public admin test 0 test

(o [ ] [ |

Select the column delimiter used in the text file to separate each field. This is
normally a comma or a space, or a combination of characters. As changes are
made, the columns will align differently based on the selection(s). Once the
columns are separated properly, click Next .

Importing an Excel Spreadsheet — Selecting the Worksheet

When importing from an Excel spreadsheet, the worksheet will need to be
selected.

¥ Import Wizard : @lgl

Select Excel WorkSheet

“which workshest fiom Routers-10.xls should we use 7

NodeCaption NodeGroup IP Community Username Password
Foundry-Test  Foundry Test Routers 10,104,127 public admin admin
SW-AP1 Cisco Aps 10.10.5.118  public Cisco admin
SW-AP2 Cisco Aps 10105119 public Cisco admin
Ciscol2-2 Cisco Test Routers 1010124 public admin admin
< b

[ ) [os ] [come ]

Select the worksheet from the drop-down list at the top of the dialog and then
click Next > to continue the import process.

Importing from a SQL database — Connecting to the Server

When importing from an Orion NPM database or any other SQL database, a
connection to the server will first need to be established.
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B Import Wizard

Select Database
Select 3 SOL Databage to Import from

SOL Server |SEHVEH—NAME/SDLAHW\NDS "l

Database Name | Corfigtgmt v

() Logon to SAL Server using Windows NT Integrated Security
( Logon to SAL Server using a SEL Server userid and password

[ <~ Back H Mext > I [ Cancel ]

Select the SQL server from the drop-down list or type the server’s IP Address or
hostname. Then select the database name from the second drop-down list and
choose the type of authentication required for the connection. Click Next - to
continue the import process.
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Editing Nodes

Once a Node has been added, the device’s details can be modified by right-
clicking on the Node in the Node List and then selecting Edit Selected Nodes.

Device Details Tab

The Device Details tab is used to change the Node Name, Node Group, IP
Address, login information, and more. Fields that appear in gray boxes can be
edited. Double-click the field to edit the existing value, or use the drop-down list
to select a different value.

%A Cirrus Configuration Management [Config-Mgmt]

File Edt Nodes Configs Schedule [nventory Reports Show MBs Iocks Windows Help
‘CSPENL Fy i RBEXALF. hBY. DB QG EOBEe®
@) cuickstart & Fnundry—TEstl arx
Horke o
=1@ Cisco APs (P Foundiy.Test l@ Actions ] [ = smwl [@ M\Bs] [E Tuu\sl E
@ eapt )
& sww-ap2 {60 Device Datails | ¢ Iterfaces \ “8) configurstion History \ & Invertory } B
=@ Cisco Test Routers i
@ Ciecotz-t Property Vale AssignedMacros A
= & Foundry Test Routers = Hode Details
@ Foundry-Test Hotke D {51FBOBAD-2480-4CDF-BFC3-02D2645CCIAE )
Node Hame Foundy-Test E
Mode Group Foundry Test Routers =
IP Address 10404127 &
SNMP Communty String public b
Comments
=) Discovered Properties
Reverse DNS
Response Time 1ms
Responss Errar oK
Device Status 9w
SNMP Level SNMP V2
System Name Founchy-Test-greg
et o Founeiry Networks, Inc. FI4802, Irori#are Yersion 07 6.04cT51 Compiled on Aug
22 2003 ot 21:4234 labeled ws B2507604c
System Cortact BK Rogers
System Location SolarWines LAB
System OD 153644119911 3211
“endor E& Foundry Networks, Inc
Waching Type Founsiry Networks, nc
Last Boot /3002005 10:40 AM
OS Inage
05 Version 07 504cT51 Compiied on Aug 22 2003 at 21:42:34 Iabeled s B2S07604c
Supported Config Types Running, Startup a

Interfaces Tab

This tab is used to display interface details of a specific Node. Choose a category
from the Interface Details drop-down menu and then click the Refresh button to
display the selected statistics.
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A Cirrus Configuration Management [Config-Mamt]

Fle Edt Nodes Configs Schedule Inwentory Reports Show MIBs Tools Windows Help

F HICSrDNL Fy i BEXAE BB, DS R HOEEe®-|
@) quickstart & Cisca12-1-test.tul solarwinds.net € Fourdry-Test £ SW-AP2 | arx
Nade o
g
. 5
=@ Cisco APs 9 swapz [@ Acmns] I smwl |0 M\le IJZ! Tnn\sl =
@ SW-aP1 v
@ sW-ap2 D Device Details ¥ Interfaces Ha Configuration History I & \nvemury} 3
= Cisco Test Routers i
@ Ciseo1 241 Inteface Detals | Intertace / Port Status | | [ Retresh | [ Auto Refresh
= & Foundry Test Routers
@ Foundry-Test . _
Admin  Admin =
Index Interface MAC Address ottt B Status Status Type  Type g
1 Dott 1Radiod ODOF24E8D200 @ Up 9@ u (%) Spread Spectrum Radio [
2 FastEthernetd ODOF 24BE4FE2 @ Up 9 u T Ethernet ]
3 il 9 w @ uw P other
4 Bt O0OF24BE4FEZ. @ Up 9 u T Ethernet
E Yirtual-Dot1 1Radiod  000F 24E3.0200 ] Up @ Down @ Spread Spectrum Radio

Check the Auto Refresh box to automatically update the statistics every 30 seconds.

2,
U To change the Auto Refresh time interval, select Settings from the File menu and then select
Interfaces under the Node Details Window section. Adjust the slider to the desired interval and
click OK to save the changes.

Right-click on an interface to see additional options such as Bandwidth Gauges,
Graph Selected Statistics, Shutdown Selected Interface, and more.

Configuration History Tab

The Configuration History tab lists all configs that have been downloaded for the
selected Node. The configs are separated by time periods such as “Last Week”,
“Two Weeks Ago”, “Last Month”, and so on.

Right-click on a config or group of configs to be presented with additional options
such as Edit Configs, Compare Selected Configs, Upload Selected Configs, and
more.

26 Editing Nodes



d

&3 Recycled Paper Chapter 3: Managing Nodes

D Device Details } =F iterfaces {a] Configuration Histary }@ Inventory I

ConfigTypelcon Config Type  ConfigTitle Dowvnload Time Modified Time
=l Last Week

@ 99552005 05:48 PM - Running  Running Q/E/2005 0545 Phi - Running /82005 05:43 P

@ /82005 05:47 PM - Running  Running 9/8/2005 05:47 PM - Running 9/8/2005 0547 PM

& 8152005 05:41 PM - Running  Running 8/6/2005 05:41 PM - Running 8/612005 0541 PM

@ 91812005 05:40 PM - Running  Running 9/5/2005 05:40 PM - Running  9/8/2005 05:40 PM

a 8/Bi2005 05:37 PM - Running  Running 8/8/2005 05:37 PM - Running 8/872005 0537 PM

& 91512003 05:25 PM - Running  Running 8/6/2005 05:23 Pk - Running 9/62005 05:25 PM
@ 9182005 05:23 PM - Running  Running 9/B/2005 05:23 PM - Running ~ 9/8/2005 05:23 PM

[@] 9620050508 PM - Running Rurning 9/5/2005 0508 P - Running. 982005 05,08 i
@ 91512005 01:23 PM - Running  Running a5/, Ph
[&] 2812005 0118 PM - Running  Running as Copy QT o
[&] 962005 01:01 PM -Running  Rurming 9572 Select all Chrth 1M
@ 91552003 09:35 &M - Running  Running a5z Df £t Configs 5 A
= Two Weeks Ago
[&] 9122005 03:34 AM - Running  Runing s G Compare Selected Configs 4 aM
@ 9Hi2005 01:48 PM - Running  Running 9MJ2 ¥ Delete Corfigs ... 43 P
[G] 853172005 03:31 PM - Running. Running. 8631 31 P
[8] 8/30/2005 08:42 AM - Running  Running gan| B Download Configs ... 142 Ab
[S) 313002005 08:00 &M - Running Funning /30 Upload Selected Config .. 00 &M
[@] 8290005 03:52 P - Running.  Running 6/20/2005 052 PV - Running 812972005 03:52 PM

@ 81292005 03:30 PM - Running  Running §/29/2005 0330 PM - Running /2802005 03:30 PM
=l Last Month

@ 82452005 10:57 AM - Running  Running B/24/2005 10:57 AM - Running  8/24/2005 10:57 AM
952472005 10:01 AM - Running  Running §/24/2005 10001 AM - Running  8/24/2005 10:01 &M

Inventory Tab

The Inventory tab displays the information collected by the Inventory Engine. A
dropdown menu is listed at the top categorizing the different statistics that can be
displayed. Click a category to display the associated statistics. If no statistics are
available, it may be necessary to perform an inventory on the selected node.

U For detailed instructions on performing Inventory, please refer to Chapter 6: Inventory on page
65.

n Management [Con!

Fle Edit Modes Configs Sthedule Inventory Reports Show MIBs Tools Windows Help

o A n oA R L Ol BBEXALAE BRI B8 S
Rl N el | (3) quick Start ©) sw-APL ‘ a4bx
Hade: ] o
R o E]
=@ Cisco Access Points (2D swapt [@ Actions ] [ Show ] [ ® MEs ] I 3 Took ] =
1@ SW-ART )
(@ SW-AP2 (@ Device Details } < Imarlsces} “2) configuration History 4 Inventory I B
= Cisco Test Routers &
@ Ciscol2-1 Inwventory Details ~| | [# Refresh
=1 & Foundry Test Routers Tyteminia =
# @ Foundry-Test IP Addresses ~
A SW-AP1 -
=
Cisco 1200 Ac|TCP Ports 2
UDF Ports &
Cisco 105 Softy YLANS . RELEASE SOFTWARE (fe2) &
Techrical Supplhysicsl Entitiss 1005 by Cista Systems, Inc. Compiled

Thu 31-Mar-035 1816 by pwade

Cirrus Configuration Management Inventory includes details about each managed device.
The following details can be included during dewice inventor.

ARP Cache

Interfaces or Pors

Interface types (Frarme Relay, ATM, Ethemet, FDDI, etc))
MAC Address of each Interface

IF Addresses assigned to each Interface
Subnetting Infarmation

Port Speeds

MTU {madimurm transmission unify for each port
Active UDP and TCP ports

WLAM assignments

Bridge Tahle

:hagsis drtails nf Ciscn drvices
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Editing Multiple Nodes

Many times it is necessary to make changes to more than one Node at a time. To
edit two or more Nodes at the same time, select the devices on the Node List by
using the Shift and Ctrl keys on the keyboard, and then right-click and select Edit
Multiple Nodes.

The Edit Multiple Devices dialog is displayed listing the Nodes that have been
selected at the top. To add or remove Nodes from the list, use the associated
buttons below the list.

42 Edit Multiple Devices X

Changes made below will affect the following list of Devices
hode

= Cisco APs
& sw-ap
@ SWaR2

I Add Devices I [ ¥ Remove Devices ] [ 'F::, Grouping

Property Value A
= Hede Details
Mode Mame
Moce Group
SHMP Community Siring
Comments
= Login Information
User hame Cisco
Password solar8912
Enahle Level 0
Enahle Password
= Communication w

Done

Make the appropriate changes to the Nodes and click Done to accept the changes.
It may be necessary to refresh the Node List to show the changes by pressing the
2 button at the top of the Node List.

Custom Properties

Cirrus includes the ability to add Custom Properties to each Node. Custom
Properties are additional fields such as country, building, asset tag, serial number,
etc. that can be defined and stored in the Cirrus database.

Cirrus provides a collection of the most commonly utilized properties to choose
from. New custom properties can also be defined. Once a custom property is
created, the properties can be edited in the Node Details of each device.

To define a Custom Property, click the button on the toolbar, or select
Settings from the File menu, and then select Custom Properties from the menu on
the left. Select a property from the drop-down list or type in a new property, and
then click the Add New Property button to create the Custom Property.
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7A Configuration Management Settings

Node List

Security

Global Macro Settings
Community Sting

X
~| @ Custom Properties

Custom Fropstties such as Buiding, Location, Assst Tag, sic can bs added to the Configuration
Management system. Thess Custom Propetties are stored in the active Configuration Management

Login Informatian database.

Transter Protocols
-I Natification Defaults Custom Properties:

Building
Flaot

Email Defaults
SMTP Server
Custom Properties
Reports
Scheduled Jobs
= Node Details Window
Node Details
Interfaces
Device Inventary
Ping Window
Node Monitoring
= Search Configs

Serislhumber | [_AddHewFropery

Node List
= Configs
Config Editor
Config Transfers
Config Comparisans v

Once a Custom Property exists, the field will be displayed when viewing Node
Details. To edit the Custom Properties, right-click on a node or group of nodes
and click Edit Selected Nodes or Edit Multiple Nodes. The new Custom Properties
will be displayed at the bottom of the Node Details.

Za Edit Multiple Devices 3

Changes made below will affect the following list of Devices
hode

= Cisco Access Points
& sw-ap
@ SWaR2

I Add Devices I [ ¥ Remove Devices ] [ 'F::, Grouping

Property Value
= Hede Details
Mode Mame
Moce Group Cisco Access Points
SHMP Community Siring public
Comments

# Login Information

+ Communication

=iCustom Properties
Buildling Warehouse B
Floor 2

Done

Enter the new values for the Custom Properties and then click Done to save the
changes.
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Chapter 4: Managing Configs

After adding Nodes, it’s time to start managing configuration files. Configs can be
downloaded, edited, compared, and uploaded all from the same console. This
chapter explains the various tasks that help ease the pain of managing Configs.

Downloading Configs

To download a config from a single node, or group of nodes, right-click on a node,
group, or selection of nodes and select Download Configs.

%A Download Configs &l

Dawnload Configs fram the following Devices

Node IP Address
=149 Cisco Aps
@ SWAP1 2062314156
@ SW.APZ 2062314457

[ Add Devices I I # Remove Devices ] [ E{ Grouping

Download which type of Config ? | Runring v

After Downloading ..
[ Wiew / Edit Downloaded Canfig
[] Compare to last Config Downloaded
[C] Compare to last Baseline Config
[ Compare Dawnloaded Configs

Download Canesl

Nodes can be added or removed from the list of Nodes by using the associated
buttons below the list of Nodes.

Select the type of config to download, either Running or Startup, and then check
any After Download options needed such as View / Edit Downloaded Config. Click
Download to start the transfer.

%A Config Transfer Status 5]
MNocle IP Address  Transfer Pratocol Status Error
b fg Download - SW-AP2 1040584 teinet Connecting

Close window after Download completes @ cancel | | Closs Window

Once the download has finished, the configs are written to the database and any
After Download options will be performed.
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Editing Configs

To edit an existing configuration file, right-click on the file from the Node List and
a select Edit Selected Configs, or simply double-click the file.

A Cirrus Confipuration Management [Config-Mamt] g@@
Eile Edit Modes Configs Schedule Inwventory Reports Show MIBs Tools windows Help
+ o = = = [ "
@ BECrEdna @, v 2BXAL, e i OB i o BoBE® ¢
@) quick Start  |2] Edit SW-AP1 - 9/13,/2005 1... ‘ b x
Mode '5“
=1 Cisco Access Points || SW-AP13/13/2005 12:52 PM - Runring ¥ a2
=1 @ S™-aP ; = &
o ! a
(&) 8132005 01:01 P.. ! Last configuration change at 15:29:46 5 Mon Sep 12 2005 by Cisco C
[&) sn300s 1252p | NVEAN config last updated at 15:29:46 § Mon Sep 12 2005 by Cisco
= @ SWLaF2 \
[&) sn3r005 1251 P wersion 12.3
-1 6@ Cisco Test Routers no service pad o
@ Cisco12-1 service timestamps debug datetime msec localtime show-timezone year EN
=& Foundry Test Routers service timestaups loy datetime msec localtime show-timezone year &
© Foundry-Test service password-encryption =
service sequence-mumbers T
: @
hostname sw-apl
'
logging buffered 6000 debugging
enahle secret § §1§330L§6d0cwkFaPaRM]gChr Lvi FO
!
username Cisco privilege 15 password 7 071CZE404F1B415C4640
username 000£2450a566 password 7 1159485511405F54542E7ETZ7E
username DO0£2Z480a566 autocommand exit
usernane 000£24bedfel password 7 1159495511405F0EOLTEZDZ174
username 000fZ4bedfeZ autocomwand exit
clock timezone § -6
clock summer-time 3 recurring
ip subnet-zero v

Saving Changes with Revisions

After making any changes to the configuration file, clicking the Save Changes
button will open the Revision Comments dialog. This is used to enter any details
regarding the changes made to the configuration file.

@ 30LAIWINDY.NEC Revision Comments

Network Management Toals

Pleaze enter detailz about thiz change

[ Da nat ask for Revision Comments again

Enter a description of the changes made and click OK to save the configuration file.
The revision is saved below the existing configuration file as a separate file with
the Revision Comments as the name.
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Mode

- {4 Cisco Access Points
=@ Sw-aP1
@ 9M 372005 01:01 PM - Running
= Bj 9M3/2005 12052 PM - Running
[ Added private RO Community...
=1 SW-AP2
@ 9M3/2005 12051 PM - Running
-| 4 Cisco Test Routers
& Cisco12-1
-| 4@ Foundry Test Routers
& Foundry-Test

Decrypting Cisco Type 7 Passwords

When viewing a configuration file, encrypted Cisco Type 7 passwords can be
decrypted with the touch of a button. With a configuration file open, click the
Actions button and then select Decrypt Type 7 Passwords.

#m Cirrus Configuration Management [Config-Mgmt]
File Edit Modes Configs Schedule Inventory Reports Show MIBs Tools Windows Help

BE B9 8% E. > B XAs ¥ B8 G EE

-1 @ Foundry Test Routers
% € Foundry-Test

Decrypt Type 7 Passwords

( enagble password 7 121A0C041104

service
|

host:

tcp-small-servers

cla
clock summer-time CDT recurring
ip subnet-zero

no ip rcod domain-lookup

ip remd rep-enable

Hodle El] o
-1 Cisco Access Points * Cisco12-1 ‘94‘22f2005 01:35 PM - Running | ¥ =
&
1 @ SW-AP1 \ © Undo az | 2
& Q-S\N—AP2 ! Last configuration change at 10:51:32 CDT Moy = Er
=@ Cisco Test Routers | NVEAM config last updated at 14:57:13 CDT Mon &
=@ Ciscol24 | %8  Upload Entire Config ...
B Q2272005 01:36 F... weraion 12.2
[8) orzzznos 135 P, || service nagle | (B Decrypt Type 7 Passwords
Q402005 0550 4 service timestamps debug datetime localtime —— Cl+F T
@ 91 4/2005 09:50 & service timestamps log datetime localtime # e 2
[ e — UB:33 A. ’ service password-encryption #7 Replace .., Chrl+R. §
I_i' : o gervice udp-small-servers ﬁ
0

Cirrus will scan the entire configuration file for all Cisco Type 7 encrypted
passwords. All passwords that have been decrypted will appear green.

u Decrypting the Type 7 Passwords alters the text of the configuration file. If the configuration
file is saved after decrypting the passwords, the passwords will be saved without encryption.

Editing Configs
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A Cirrus Configuration Management [Config-Mgmt]

Fle Edt Modes Configs Schedule Inventory Reports Show MIBs Tools ‘Windows Help
F AT ErETNe F, o RBXHE. RRY. DS B R EE
e @) quickstart () Ede Ciscala-1 - 9/22/2005 01:3... ] * Edit Ciscol2-1 - 9/22/200... | 1P X
Mocle jal
§ o
=@ Ciseo Access Points * Cisco12-18/22/2005 01:35 PM - Running | Sevelhanges =
[+ € SW-AP1 . ol (1
b=]
2 O_SW'APQ ! Last configuration change at 10:51:32 CDT Mon Sep 19 2005 by greg E'
=@ Ciseo Test Routers | NYEAM config last updated st 14:57:13 CDT Mon $ep 19 2005 by greg @
= Cisco12-1 |
B 92202005 01:36 P wersion 12.2
@ Q2202005 01:35P.. service nagle
|_£| O 412005 0950 A gervice timestamps debug dat;:lma J.ocal..t,ime g
B 9H 42005 09:50 A service tlmest.al;vps log 2§:et1me localtime =
SELVICE password-encryptlion =
@ s service udp-small-servers ﬁ
=@ Foundry Test Routers service top-small-servers w
+ €9 Foundry-Test |
host;
“ engble password cisco
N
cloc]
clock summer-time CDT recurring
ip subnet-zero
no ip rcmd domain-lookup
ip rcmd rcp-enable v

Comparing Configs

Another feature of Cirrus is the ability to compare configuration files. Configs can
be compared between two Nodes, or compare an older version with the current
configuration.

To compare two configuration files, select the two files that are to be compared
from the Node List and then right-click and select Compare Selected Configs.

#A Cirrus Configuration Management [Config-Mgmt]

File Edt Nodes Corfigs Schedule Inventory Reports Show MIBs Tooks Windows Help

D& @8 08 e &, i 2BXAL el dJEdae i@ HeEESE- .

@) quickstart [ Srippet - tew snippet L Compare \ 4 b x| Config Snippets 2 x
Harke Z
=€ Cisco Access Points SW-AP1 - 9/13/2005 12:52 PM - Running | SW-AP2 - 9/13/2005 12:51 PM - Running | =
=@ sweapt aaa accounting network acct_methods star|aaa accounting network acci_methods start &
18) 91372005 01:01 P aaa session-id comman aaa session-id comman L Hew srippet &

[ arano0s12:52P |
=@ SW-4P2
[§) an3moos12:51 P
=@ Cisco Test Routers

dott1 phone
dotl1 ssid SolanmindsAir

authentication open

authentication shared

@ Cisco12-1 I
=€ Foundry Test Routers accounting acel_methods
& Foundry-Test guestmode

1
dotl1 ids eap attempts 3 period B0

dotl 1 network-map dotl 1 network-map
dotl1 arp-cache optional dott 1 arp-cache optional
N

1

1 |
| |
bridge ith bridge irb

1 |
1 |

interface Dot11Radio0 interface Dot! 1Radia0
deseription BK1

noip address noip address

na ip route-cache naip route-cache

| |
enchyption key 1 size 40bit 7 E4172FRE444 ) encryption key 1 size 40bit 7 E4172FEB444°

encryption mode wep mandatory eneryplion mode wep mandatory
| 1

ssid SolatVind sAir ssid SolatWindsAir -
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The compared files will be shown in a side by side view. Lines that have been
changed will be highlighted in yellow. Missing lines are highlighted in red. A
green highlight means that the line has been added.

A Comparison Overview is displayed to the left of the side by side comparison.
This scales to fit the size of the window allowing for an overview of the entire
comparison. Click anywhere on the Comparison Overview to jump to the
associated section of the configs being compared.

Also, the comparison can easily be printed by selecting Print from the File menu.

Setting a Baseline Config

A Baseline Config is a configuration file that is known to be a good configuration.

When making a number of changes to a Node’s configuration, it’s a good idea to
establish a known good configuration as a Baseline for future comparisons.

To set an existing configuration file as a Baseline, right-click on the config in the
Node List and select Set/Clear Baseline Setting.

& |Cirrus Configuration Management [new]

File Edi Nodes Configs Schedule Inventory Reports Show MIBs Tools Windows Help

@ EH S BRI P R AL BRI DEES R EHCEeH

ist
@) cuickstart & sw-aP1L ‘ b x
Hode @
=€ Cisco Aps P sw-ap1 [@ Actions ] [ Shuw] [@ M\Es] [JZ! TuDlS]
= @ sw-aPt
[8] 9i28r2005 05:28 AM - Startup (D Device Details ¥ Interfaces I@ Configuration History } & Inventary I
|8 9:29/2005 09:28 AM - Running
2@ sw.ar2 X ~| [# Refresh  [Auo Refresh
[8) 9/2912005 09:26 A - Running [B] Set/Clear Baseline Setting
=/ Cisco Test Routers - = Receive 1
@ Ciscot 2.2 Ly oot Twpe Type Speed xceived mnsmitted D
=€ Foundry Test Routers 45 Upload Canflg ... TLE 1
@ Founy.Test ) Spread Spectrum Radio SdMeps  TT7hes  Obps 0g0%
W Delete Corfigs ... T Ethernet 100Mops  1933kps 3055 bps 0g0%
L~ P Other 43Ghps  Obps Ohps 000%
@ v 4 Transoarert bridge interface 54 Mbps  Olbis 2655 bins 0g0%
@ VitualDott1Radicd () Seread Spectrum Radio S4Mkps  Obps Okps 0g0%
x
< >
4b %

7[4 SW-AP1 : SNMP Statisibes

SU-AP1 : SNMP Statisites [3) Refresh | | @ mips

MB OID Mame: Vlue ~
srmpirBadvalues 0 0 messages
srmpirReadOnlys. 0 0 messages
srmpinGenErrs.0 0 messages
srmpiTotalReqvars D 2640922 messages
RFC1213-MIB snmplnTotalSetyars 0 54 messages
srmpinGetRequests 0 2434449 messages
srmpinGethlexts.0 206458 messages
SetfClear Baseline Setting £% 4 devices new

Sjaddig Bijuoa

The config will then be highlighted in bold, and the word “Baseline” will be added

to the beginning of the name of the config.

-1 Cisco Aps
= SR
B Q29,2005 0926 AM - Startup
@ Baseline: 9292005 09:26 AM - Bunning

Setting a Baseline Config
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2
U Several baseline configs can be established. To assign additional Baselines, right-click on a
Node or group of Nodes and click Set/Clear Baseline Setting.

When downloading new configurations with a Baseline Config established for the
same Node, check the option Compare to last Baseline Config in the Download
Config dialog to automatically compare the new config to the Baseline.

£ Download Configs @l

Download Configs fram the following Devices

Mode
=@ Cisco Aps
@ SA-APT

(B AddDevices | [ % Remove Devioss | [ e Grouping

Download which type of Config 7 | Running v

After Downloading
[]*iew ¢ Edit Downlaaded Config
[ Compare to last Config Downloaded
Compare ta last Baseline Canfig

Dawnlaad Cancel

To remove the Baseline flag from a configuration file, right-click on the config in
the Node List and select Set/Clear Baseline Setting.

Baseline Entire Network

In some situations, it may be appropriate to establish a Baseline configuration for
every Node on the Network. The Baseline can be set to the last config
downloaded for each Node, or it can be set to the configs downloaded on a
specific date.

To create a Baseline for all Nodes, click the ol button on the toolbar, or select
Baseline Entire Network from the Configs menu. Select either the option to
designate the last downloaded config of each node as a Baseline, or set the
Baseline based on configs that were downloaded on a specific date. Click the Set
Baseline button to flag the specified configs as Baseline Configs.

Fi Baseline Entire Network

Baselining the Entire Network provides a methad of comparing future changes to a set baseline.
e | The Metwork Baseling can be set to Now or a any date in the past

(%) Set the Network Bassling to the last Config downloaded from each Nods

() Set the Metwork Baseling to a specific date

[@ SelBasehnel [ Cancel ]

36 Setting a Baseline Config



&3 Recycled Paper Chapter 4: Managing Configs

Config Change Reports

A Config Change Report shows all changes made between each configuration file
over a specific time period. These Reports can show all changes that occurred
during a specific date range, or all differences between the latest downloaded
config and the Baseline Config.

To view this Report, select Config Change Report from the Configs menu.

#A | Cirrus Configuration Management [ConfigurationManagement]

Eile Edit Modes Configs Schedule Inwentory Reports Show MIBs Toolks Windows Help

G AN BTOER R E B BB XA BRI DBES B [

Mode List x
”U Lt i @ Quick Start @] Config Change Report | dLBss
Node ]
-1{@ Cisco Aps Canfig Change Repart 1 Results ]
+ @ Sw-ARt
26 s Select Nodss
-1 Cisco Test Routers Made Command Exec
=1 Cisco12-2 & Cizcol2-2 TELMET
[@ 101072005 01:59
[B) Baseline: 10/1072...
-1 Foundry Test Routers
+ (@ Foundry-Test
[ tdoDevices | [ % Remove Devices | [ T Grouping | Select Modss Directly =
Show the following Config changes
(%) Compare most recent Download to the last Baseline Config iRy Geneate Report
) Compare the most recent Download to the Configuratian on ‘10/ 342005 j
) Show changes mads over the past [7 | daps
O Show changes mads between |10/ 3/2005 | and [10/10/2005 ~| -
&
Node ... | Confi..  Find ...

% |4 devices | ConfigurationtManagement

At the bottom of the dialog, select the type of Config Change Report to generate.
The default selection (Compare most recent Download the last Baseline Config) will
display all the differences between the last Baseline Config, and the most recent
Downloaded Config.

The second option, Compare the most recent Download to the Configuration on a
specific Date, will show all differences between the most recent Downloaded
Config and a Configuration on the specified date.

2
U If there was no Config downloaded on the specified date, the next Config after that date will
be used for the comparison.

The last two options will show all changes made to a Node configuration that
have occurred during a specific date range.
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Select the type of Config Change Report to create, and then click the Generate
Report button. The Report will be displayed on the Results tab.

A Cirrus Configuration Management [ConfigurationManagement]

Fle Edt Nodes Configs Schedde Inventory Reports Show MIBs Tools Windows Help

@ AN BTPINL . DR XA B OBRES G E

ML NN | @) quickstart [Bh Config Change Repnrtl b x
Hode B
- @ Cisco Aps Confiy Changs Report £ Fosd
e

@ SW-AP2 [ SaveResuls

- @ Cisco Test Routers

=@ Cisco12-2 =/ Ciscol2-2
@ 10/ 0/2005 02:54 .. E Today 10/10/2005 02:54 PM 2 adds
#[g) 10402005 01:58 X snmp-server community public RO
[B) Baseline: 10/1072... A bamner login “CCUnauthorized uss

= € Foundry Test Routers
€@ Foundry-Test

' Mode... |confi... Find...

Z% |4 devices |ConfigurationManagement

Comparison Criteria and RegEx Patterns

When viewing Config Change Reports, some changes can be ignored such as the
'Last Configuration change' line in Cisco configs. To determine which lines
should be ignored, click the Comparison Criteria button.

Edit Comparison Criteria ...

FlegEx Patterns are used by Cimus Configuration Management to ignore differences in certain lines when comparing configuration
files. RegEx Patterns describe the lines which you do nat want compared. When a RegEx Pattem is enabled. it is used for all
| companizon operations throughout Cius Configuration Management, including scheduled jobs

Each line that matches a given RegEx Pattern will be ignared when comparing files, however, when a changed line that is being ignored by a

RegEx iz above or below another line which iz not ignored due to a RegEx Pattern. both lines are shown. Bath lines must match one or more
RegEx Pattems for the lines to be ignored.

Enabled Title Pattern Comment
O Cigeo 'l Last Updsted' ine (Part 1) M Last lgniores the Last Configuration change' ine in cisco configs.
Cigco Clock Period “ritp clock-period lgnores the ntp clock period lin in Cisco Configs
] Cizco 'l Last Updated' ine (Part 2) M MwRARM Ignores the ' WY RAM' Last write time line.
Cizco wiccp “wICCP Bp Username cisco  lgnores the wiccp line in Cisco Access Points

[ Add Pattern H ¥ Remove Pattern ” Df Edit ]

RegEx Patterns are used by Cirrus Configuration Management to ignore
differences in certain lines when comparing configuration files. RegEx Patterns
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describe the lines that are to be ignored. RegEx Patterns are global, and when a
RegEx Pattern is enabled, it is used for all comparison operations throughout
Cirrus Configuration Management, including Scheduled Jobs.

Each line that matches a given RegEx Pattern will be ignored when comparing
files, however, when a changed line that is being ignored by a RegEx is above or
below another line which is not ignored due to a RegEx Pattern, both lines are
shown. Both lines must match one or more RegEx Patterns for the lines to be
ignored.

There are a few example comparisons included with Cirrus. To enable a
Comparison Criteria, check the box next to the pattern that is to be ignored. To
create a new pattern, click the Add Pattern button.

K Edit Comparison Criteria ...

Enter the pattermn ta be ignored during Config Compare operations.

Title: Enable this RegEx Pattern during Config Compares
|Cisco Clock Period |

FegEx Pattemn:

|Anlp clock-period |

Comment; Mare Information about Begf » Patterns

Ignares the ntp clock period line in Cisco Configs

[ ox ][ cows ]

Give the Comparison Criteria a name and add a comment if necessary. In the
RegEx Pattern field, enter the RegEx Pattern that Cirrus is to ignore when running
the Config Change Report.

When the Config Change Report is executed, any lines that match one of the
Comparison Criteria will be excluded in the Report.

Y
U For more information about RegEx Patterns, refer to Appendix D: Regular Expression Pattern
Matching on page 147.
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Advanced Options

Before generating a Report, click the &/ button to display the Advanced Options

A Cirnus Configuration Management [ConfigurationManagement]

Fle Edt Nodes Configs Schedue Inwerntory Reports Show MIBs Tools Windows Hslp

G EAmBBPENS EL A B XA MR I R Es 0o B

e ———— @ Quick Start @; Config Change Report | 4px
Nate E]
= @ Cisco Aps { Config Changs A

¢ | Resute |

. g mj:; Select Nodss ©
-1 Cisco Test Routers. Mode Command Exec
=€ Ciscat2-2 @ Ciscol2-2 TELNET
[@) 101 0i2005 02:54

[&) 10mai2005 01:59 .
[B) Baseline: 10i08/2...
= & Foundry Test Routers
# € Foundry-Test

tdd Devices | [ ¥ Remave Devices | [ & Grouping | [ Selectodes Diecty -]

Shaw the following o changss
© Compare most recent Dowrlaad to the last Baseline Corfig
() Compare the most recent Download to the Configuration on
& Show changes made over the past days
©) Show changss made between | | and | |

Advanced Options

S e Ignore lines that match any of the following patterns

Edit

Check this box to show the detalled changes
between each downloaded Config

Mode ... |Confi...  Find ...

2% |4 devices |ConfigurationManagement

Check Show detailed changes to display the differences between each
configuration file separately. This will show each change from one config to the
next. For example, if there were 4 configuration changes made in a specific date
range, the Report will show the differences in the first config compared to the
second config, and then show the differences in the second config compared to the

third, and so on. The Report will be grouped by date, showing all changes made
on each day.
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A Cirrus Configuration Management [ConfigurationManagement]

File Edit Modes Configs Schedule Inventory Reports Show MIBs Tools Windows Help

@A BHOOEN D Bl BXAL. kR D@&8 el C

- @ Quick Start @; Config Change Report ‘ 4k %
HNeie E]
=@ Cisco Aps Caonfig Change Report | I
+ ) SWLAPT

+ @ S-aP2 [ SaveResuls

- @ Cisco Test Routers

- (@ Ciscol2-2 =l Ciscol2-2
&) 10 0r0s 0z . Fl Today 1071072005 02:54 DM 1 adds
[@) 10mai2005 01:59 X banmer login "CCCUnauthorized us
@ Baseline: 10/0872... = Yesterday 104972005 01:5% PM 1 adds 1 changes
= Foundry Test Routers X snump-server community public RO
+ (J Foundry-Test ¥ banner login “CCUnauthorized use banner login “CCCUnauthorized use of these

Mode ... |Confi...  Find ...

§§ 4 devices |ConfigurationManagement

Config Snippets

A Config Snippets is a string of text that can be saved to a file allowing the user to
merge sections of configs with ease. Config Snippets can be used to edit an
existing config, or can even be uploaded directly to a Node or group of Nodes.

Creating a New Config Snippet

To create a new Config Snippet from scratch, click the New Snippet button at the
top of the Config Snippets panel on the right-hand side.
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Za Cirrus Configuration Management [Config-Mgmt]

Fle Edt Nodes Configs Schedue Iwentory Reports Show MIBs Took Mindows Help

F DTN F. 0% RBXAR, h®

i E@Ss R EOEEe®

Node
= @ Cisco Access Points
S
91352005 M:01 P.
[@) 8130005 01:01 P
I 3005 12:52 P
91132005 12:52 P,
- @ swapz
[@ 9n1aio0s 12:51 P
[@ 9#aro0s 12:51 P,
= @ Cisco Test Routers
@ cisco12:1
=€ Foundry Test Routers.
@ Foundry-Test

@ Quekstat [ Snippet - New Snippet |

4 b x | Config Sri

Snippet [New Snippet

v Ea

[ New Snippet

Ss24ppy puld

2
U If the Config Snippets panel is not displayed, it can be opened by selecting Config Snippets
from the Windows menu.

Enter text for the new Config Snippet in the large text box provided. Give the
Snippet a name (“New Snippet” by default) and click the Save Changes button.

Config Snippets can also be created by right-clicking on a selection of text and
selecting Create Snippet from Selection.

#a1 Cirrus Configuration Management [Config-bgmt]

]

Node
=@ Ciseo Access Points
=@ Sheapt
[@) an32005 01:01
[@) an 32005 01:01 P
[@) an3ra0512.52P
[@) 9n3005 12.52P.
1@ S-aP2
[@) anaroos 1251 P
[@ amaroos 1251 P
=1 Cisco Test Routers
@ Cisoo121
=1 Foundry Test Routers
@ Foundry-Test

Edit | View the selected config

Ele Edt Nodes Configs Sthedule Inventory Reports Show MIBs Tools Windows Help

BTN E. ol RXAL. GBI, GEEOS B BOBES®®- .

@ Quckstrt [F srippet - Hew Srippet ) Edt SW-AP1 - 9/13/2005 01:01 ... (3] * Edit SW-AP2 - 8/13/2005 . | s
* SWLAP2 [3/13/2005 1251 PM - Running | ¥ [& cions | [ Save Changes
auplex aute ~
speed auto
bridge-group 1
no bridge-group 1 source-Learning
bridge-group 1 spanning-disabled
interface EVIL
ip address dhep client-id FastEthernet0
no 1p route-cache
ip http server
ip Bttp help-path KEep: //uver. 51560, com/varp/public/ 779, snbiz/prodconfig/help feag/122-15, JA/1L00
ip radius source-interface BVI1
Logiing history debugting
loguing 216.241.4.81
logging 216.241.4.142
comnuni{© Undo chz
snmp-server communit _
snup-server locatio SE Upload Selected ines ..
snup-server contact [y greate Snippet from Selection
snup-server chassis
snup-server enable { % Cub Ctrlex
snup-server enable
radius-server accrit B PV culec
radius-server host I Ppaste 4y 1813 key 7 0822455D0ALE
radius-server autho
radius-server vsa s Select Al Qul+A
bridge 1 rout
prvE L EONEE AR gy culte
E g
wlcep ap username c
' v

ssappy puiy

Sjaddus Byuos
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Uploading Configs

After editing configurations files, they can be uploaded to a node or group of
nodes with ease. There are three different ways to upload configuration changes;
Uploading and Entire Config, Uploading Selected Lines, and Uploading a Config
Snippet.

Uploading an Entire Config

To upload an entire configuration file, right-click on the file and select Upload
Config. Configuration files can also be uploaded when editing the config by
clicking on Action - Upload Entire Config.

A Cirrus Configuration Management [Config-Mgmt]

File Edit Nodes Configs Sthedule Inventory Reports Show MIBs Tools Windows Help
@) quick start  {2) Edit SW-AP1 - Added privat... | (2] Edit Cisco12-1 - 9/13/2005 0%:1...
Nade T
3
=1 @ Cisco Access Points SW-AP1 ‘Added private RO Community 9132005 0405 PM | ¥ =
-1 @ Sw-aR1 =
@ R S HE Y ot no ip address Chrl+Z 3‘
8] Sl no ip route-cache i
=I[g) 901372005 12:52 FM - Running duplex anto =
[ Acdedt private RO Communty . speed auto [#2 Uplosd Entire Config ..
-1 @ sw-ap2 bridge-group 1 3
[8] 81372005 12:51 PM - Rurning no bridge-group 1 source-learning o
i bridge-group 1 spanning-disabled g
5@ Cisco Test Routers bridge-yroun 1 spanning # mnd.. e || =
=9 Ciscol2-1 . B b | . [
interface ] 2
[&) 91342005 0419 PM - Runring : “yp Replace ... crtR Y
description BE3 2
= @ Foundry Test Routers ip address dhep client-id FastEthernet0 (i
2 Foundry-Test no ip route-cache
,
ip http server
no ip http secure-server
ip http help-path
htep: //www. cisco. con/warp/public/779/subiz /prodconfig/help/eay
ip radius source-interface BVIL
|
logying history size 10
logging history debugging
logging trap debugging
logging snup-trap emergencies
logging snup-trap slerts
logying shup-trap critical
logging snmp-rrap errors
logying srmp-trap warnings v
Upload Entire Corfig ...

The Upload Config dialog is displayed. Additional Nodes can be added to the list
of Nodes to upload to by using the associated buttons below the list.

Upload Configs ta the following Devices

Mode:
-1 Cisco Test Routers
@ Ciscol12-1

[ Ed Add Devices ] [ # Remove Devices ] [ E{ Girouping

Additional actions after upload.
[ wite Conlig to NVRAM
[ Rebaot Device

. Creale Upload Goript Cancel
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If the configuration needs to be written to NVRAM or if the device needs to be
rebooted following the upload, check the appropriate options at the bottom, and
then click Create Upload Script to open the Execute Script dialog.

“a|Cirrus Configuration Management [Config-Mamt]

Modz

=@ Cisco Access Points
=@ swap
8] 92212005 01:36 M -
[=] 972212005 01:36 PM -
(8] 9222008 01:35 PM -
(8] 9132005 01:01 PM -
I[g] 91312005 12:52 Pt -
+ @ SH-aP2
=@ Cisco Test Routers
=@ Ciseot24
(81 92272005 01:36 PM - Startup
(8] 912212005 01:35 PM - Running
[8] 9472005 0 50 AM - Runring
[+ 91472005 03:50 AM - Startup
[3] 91472005 05 33 AM - Runring
= @ Foundry Test Routers
+ @ Foundry-Test

Running
Startup

Running
Running
Running

Ele Edt Nodes Corfigs Schedule Inventory Reports Show MIBs Teols MWindows Help

BT 0 DD W L

Ol BRBXME, R Y. DEEEe i EOoEeo-

vt |2] Edit Ciscot2-1 - 9/22/2005 01:3.

AR # Edit Cisendz-1 - 9jzziz005 01, @ ${Entertnnﬁgr‘lnd:...‘ b x

g
Exeoule Seript | Resuts | Ef
g
Select the Nodes ta run this Command Script on 3
s
hode IP Address Command Exec u
@ Ciscol21 20623152 TELMET
.
)
2
=
z
g
]
[ AddDevices | [ % Remave Devices | [ T Grouping Select Nodes Diecly =
Command Serit to Execute :

H{EnteConfighiode} ~
(]

| Last configuration change at 10:51:32 CDT Mon Sep 19 2005 by areq
| NVRAM config last updated at 14:57:13 CDT Mon Sep 19 2005 by gieg
l

version 12.2
seivice nagle

seivice timestamps debug datetime localime
seivics timestamps log datetime localime
seivice passworchenciyption

seivice udp-smallservers

seivics top-smallservers

I

lhostname Ciscol2-1-test ™

wecute Command Seript

B Lowisein :

In the Execute Script dialog, Nodes can be added or removed, and the command
script can be saved. Also, previous command scripts can be loaded to replace the
automatically generated script. Once satisfied with the command script, click the

Execute Command Script button to begin the upload process.

“a|Cirrus Configuration Management [Config-Mamt]

=@ Cisco Access Points
=@ swap
8] 92212005 01:36 M -
[=] 972212005 01:36 PM -
(8] 9222008 01:35 PM -
(8] 9132005 01:01 PM -
I[g] 91312005 12:52 Pt -
+ @ SH-aP2
=@ Cisco Test Routers
=@ Ciseot24
(81 92272005 01:36 PM - Startup
(8] 912212005 01:35 PM - Running
[8] 9472005 0 50 AM - Runring
[+ 91472005 03:50 AM - Startup
[3] 91472005 05 33 AM - Runring
= @ Foundry Test Routers
+ @ Foundry-Test

Running
Startup

Running
Running
Running

Ele Edt Nodes Corfigs Schedule Inventory Reports Show MIBs Teols MWindows Help

BT 0 DD W L

Ol BRBXAE)RRY DB YR EOBee-

vt |2] Edit Ciscot2-1 - 9/22/2005 01:3.

Maode: [E]

AR # Edit Cisendz-1 - 9jzziz005 01, @ ${Entertnnﬁgr‘lnd:...‘ b x

&

r El

Executs Script | I Ed

El

Cisco12-1 : 1 Last configuration change at 10:51:32 CDT Mon Sep 19 ZIJ ¥ Outine View gw

= Cisco12-1 (206.231.5.2)
= config terminal

Enter configuration commands, one per line. End with CHTLIZ.

' ul

. E

=/ !Last configuration change at 10:51:32 CDT Mon Sep 19 2005 by greg =

ILast configuration change ot 10:51:32 CT Mon SepSchange ot 10:51:32 CDT Mon Sep 19 2005 by arey £

a
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As the script is executed, the Results tab displays the progress as the configuration
changes are uploaded. Once the upload command script completes, the results
can be save by clicking the Save Results button at the top of the dialog.

Uploading Selected Lines

There are times when it is only necessary to upload a few lines of a configuration
file. Cirrus includes the ability to upload only specific lines of a config. When
editing a configuration file or Config Snippet, highlight the line(s) need to be
uploaded, right-click, and select Upload Selected Lines.

#A Cirrus Configuration Management [Config-Mgmt]

File Edt Modes Configs Scheddle Invertory Reports Show MIBs Tools Windows Help

G HECTNL F. el BXAL. D Y. B8 L @OEEe®-
5
B el | (Z) quickStart (2] Edit Ciscol2-1- 9/14/200508:3... | Snippet - public RO Commurity ... (2] * Edit SW-AP2 - 9/13/2005 ... | 4bx
Node a
g
= (4 Cisco Access Points. * SW-AP2 \S/TS/ZDDETZSI PM - Running \ ¥ | ¥ actions @ Save Changes é“
= @ S-APY s
no ip route-cache &l |2
=G Sw-ap2 e 3
[8] 9n3rzo0s 1251 P ip http secver i
=@ Cisco Test Routers ip htp help-path http: //ww. cisco. con/warp/public/779/subiz/prodeontig/help/eay/122-15. JA/1100
=@ Cieeai21 ip radins source-interface BYIL
[ 842005 08:33 4 logging history debugging
[&) 9132005 0419 logging 216.241.4.91
=€ Foundry Test Routers. loguing 216.241.4.142

logging 216,241, 4,121
SHNp-Server community public RO

& Foundry-Test

Ssauppy puid

Community private
smup-server locarion Houston L{*<? Undo Chri+2
snup-server chassis-id SU-AP2 (o
amup-server enable trape oy | L. UPoadsclectediines ..
sump-server enable traps rogue|[ Create Snippet from Selection
radius-server attribute 32 inc
radius-server host 216.241.4.1 dh €Ut Chrbx 0522455DOALE
radius-server suthorization pe Copy @hE
radius-server vsa send account =
bridge 1 romte ip B Paste Chrl+y
'

i Select Al ChrieA
VLCCD &P uSrname C1SCO PAZIVO) 4R pind CtrieF
" Fi

line con 0 I

line vty 5 15

'

ntp clock-period 2860615
ntp server 207.46,130.100
end

Upload Selected Lines ...

The Upload Config dialog is displayed. Additional Nodes can be added to the list
of Nodes to upload to by using the associated buttons below the list.

A Upload Config... E@@

Upload Configs ta the following Devices

Mode:
-1 Cisco Access Points
@ swap2

[ Ed Add Devices ] [ # Remove Devices ] [ E{ Girouping
Additional actions after upload.
Wirite Config to NVRAM
[ Rebaot Device

LCreate Upload Sciipt } I Cancel
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If the configuration needs to be written to NVRAM or if the device needs to be
rebooted following the upload, check the appropriate options at the bottom, and

then click Create Upload Script open the Execute Script dialog.

a|Cirrus Configuration Management [Config-Mgmt]

fle Edit Wodes Configs Srhedule Inventory Reports Show MIBs Tocks Windows Help

@A TS D F OiRERXAA BB Y. DEE8 QG EeEHe®-L

[ E— rt &) Edit Ciscol2-1- 9/22/2005 01:3.., &) * Edk Ciscol2-1 - 9/22j200501... 2 ${EnterConfigMode... ‘ abx
=€ Cisco Access Points Execute Script } Results |
=@ sv-apt
[8) 972212005 01:36 PM - Running Select the Nodes 1o run this Command Script on
(<] 872272005 01:35 FM - Startup b F Adoress Command Exec
[8) 912212005 01:35 PM - Rurrig @ Ciscol2-1 20823152 TELMET
[8) /1312005 01:01 PM - Running
#[g] 81372005 12.52 PM - Running
7@ SW-aP2
=@ Cisco Test Routers
=@ ciseo121
(=) 972212005 01:36 PM - Startup
(] 972212008 01:35 PM - Running B addDevices | [ X Remove Devices | [ & Giouping Select Nodes Dieclly  ~
[8] 371412005 0:50 AM - Runnings
(] 91412005 03.50 AM - Startup o & .
[8] 91472005 08 33 AM - Running e S lEems
=@ Foundry Test Routers ?(Er\lertor\thOde) A
@ Foundry-Test | Last configuration change at 10:51:32 CDT Mon Sep 19 2005 by greg
| NURAM config last updaled at 14:57:13 CDT Mon Sep 19 2005 by gieg
f
version 12.2
seivice nagle
senvice timestamps debug datelime localtime
sewvice timestamps log dalefime localime
service password-enciyption
[service udp-small-servers
service top-smal-servers
|
lhostname Ciecol2-1-test s
? Execute Command Seript T Load Seipt T SaveScipt | A

Sjaddius Byuos

ssalppy puly

In the Execute Script dialog, Nodes can be added or removed, and the command

script can be saved. Also, previous command scripts can be loaded to replace the
automatically generated script. Once satisfied with the command script, click the

Execute Command Script button to begin the upload process.

“a|Cirrus Configuration Management [Config-Mamt]

Ele Edt Nodes Corfigs Schedule Inventory Reports Show MIBs Teols MWindows Help

@ AE DO %D &, i BBXARSL BRI DEE&8 QG BB

vt |2] Edit Ciscot2-1 - 9/22/2005 01:3.

Cisco12-1 : 1 Last configuration change at 10:51:32 CDT Mon Sep 19 ZIJ ¥ Outine View

= Cisco12-1 (206.231.5.2)
= config terminal
Enter configuration commands, ene per line. End with CHTLIZ

AR # Edit Cisendz-1 - 9jzziz005 01, @ ${Entertnnﬁgr‘lnd:...‘ b x

Modz

5]
=@ Cisco Access Points
=@ swap
8] 92212005 01:36 M -
[=] 972212005 01:36 PM -
(8] 9222008 01:35 PM -
(81 91312005 01:01 PM - Running
(3] 91312005 1252 PM - Running
# @ SM-AP2 '
=€ Cisco Test Routers = ILast configuration change at 10:51:32 CDT Mon Sep 19 2005 by greg
=@ Ciseot24 ILast configuration change ot 10:51:32 CT Mon SepSchange ot 10:51:32 CDT Mon Sep 19 2005 by arey
(81 92272005 01:36 PM - Startup
(8] 912212005 01:35 PM - Running
[8] 9472005 0 50 AM - Runring
[+ 91472005 03:50 AM - Startup
[3] 91472005 05 33 AM - Runring
= @ Foundry Test Routers
+ @ Foundry-Test

Executs Script |

Running
Startup
Running

syeadiug Byuay

ssaIppy puLy
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As the script is executed, the Results tab displays the progress as the configuration

changes are uploaded. Once the upload command script completes, the results
can be save by clicking the Save Results button at the top of the dialog.

Uploading a Config Snippet

To upload a Config Snippet, either right-click on the Snippet in the Config
Snippets window and click Upload to Devices, or click Actions > Upload Entire
Config when editing the Snippet.

Config Snippets

[ ﬁ MHew Snippet ...

L EditSnippet ...

|%g Upload to Devices ...

AR Rename Snippet

D Mew Snippet ...

¥ Delete Selected Snippets

The Upload Config dialog is displayed. Additional Nodes can be added to the list
of Nodes to upload to by using the associated buttons below the list.

#a Upload Config... g@@

Upload Configs to the following Devices :

MNade:
- Cisco Access Points
@ Swi-AP2

[ fudd Devices | | ¥ Remove Devices | [ T Grouping

Additional actions after upload
‘wérite Config to MYRAM
[] Reboot Device

I Lreate Upload Script H Cancel l

_ |

If the configuration needs to be written to NVRAM or if the device needs to be
rebooted following the upload, check the appropriate options at the bottom, and
then click Create Upload Script open the Execute Script dialog.

Uploading Configs
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“a|Cirrus Configuration Management [Config-Mamt]

File Edt MWodes Configs Schedule Inventory Reports Show MIBs Tools Windows Help
@ E'E TS0 @ F DiBRBXAR. BB Y OEBESE B BOBee-

vt () Edit Ciscol2-1 - 9/22/2005 01:3... (&) * Edk Ciscad2-1 - 9j22j200501... 2 ${EnterConfigMode... ‘ b x

Nade
=€ Cisco Access Points Exeoule Seript | Resuts |

=G s
[@] 912212005 01:36 PM - Running Select the Nodes to run this Command Script on

syeadiug Byuay

a 9f22/2005 01:36 PM - Startup
ij 972272005 01:35 PM - Running
a 91372005 01:01 PM - Running
# ﬁ 9M3/2005 1 2:52 PM - Running
+ @ APz
=1 Cisco Test Routers
=1 Cisool2-1
a 8/22/2005 01:36 PM - Startup
(8] 872212005 01:35 PM - Runing [ AddDevices | [ % Remave Devices | [ T Grouping Select Nodes Dirsctly =
ij 9/14/2005 09:50 AM - Running
% o mt0n 0o att -y ||| Command Sitto Execute:
=149 Foundry Test Routers ${E nterConfightode]} -~
+ @ Foundry-Test !

hiode IP Address Command Exec
@ Ciscol21 20623152 TELMET

ssaIppy puLy

| Last configuration change at 10:51:32 CDT Mon Sep 19 2005 by areq
| NVRAM config last updated at 14:57:13 CDT Mon Sep 19 2005 by gieg
{]

version 12.2

seivice nagle

seivice timestamps debug datetime localime
seivics timestamps log datetime localime
seivice passworchenciyption

seivice udp-smallservers

seivics top-smallservers

I

lhostname Ciscol2-1-test ™

¥ Execute Command Seript T Load Seript A

In the Execute Script dialog, Nodes can be added or removed, and the command
script can be saved. Also, previous command scripts can be loaded to replace the
automatically generated script. Once satisfied with the upload command script,
click the Execute Command Script button to begin the upload process.

“a|Cirrus Configuration Management [Config-Mamt]

File Edt MWodes Configs Schedule Inventory Reports Show MIBs Tools Windows Help
@ E'E TS0 @ F DL BREBXAR. R Y DBES NG EBOBeG-

vt () Edit Ciscol2-1 - 9/22/2005 01:3... (&) * Edk Ciscad2-1 - 9j22j200501... 2 ${EnterConfigMode... ‘ b x

|

Made [E]
= @ Cisco Access Points Executs Script |
=& sw-ap

[@] 912212005 01:36 PM - Running Cisco12-1 : 1 Last configuration change at 10:51:32 CDT Mon Sep 19 ZIJ ¥ Outine View

syeadiug Byuay

[S] 972272005 0135 PM - Startup
8] 972272008 01:35 PM - Running = Cisco12.1 (206.231.5.2)
[g) /1372005 01:01 FM - Rurning =/ config terminal
#[g) 91312005 12 52 PM - Funniing Enter configuration cammands, one per line. End with CHTLIZ

# @ SM-AP2 '
=€ Cisco Test Routers =/ !Last configuration change at 10:51:32 CDT Mon Sep 19 2005 by greg

=@ Cisoot2-1 1Last configuration change at 10:51:32 CDT Mon Sepfchange ot 10:51:32 CDT Mon Sep 19 2005 by arey
(& 972272005 01:36 PM - Startup
(8] 972272005 01:35 PM - Running
8] 971472005 09:50 AM - Running
(& /1472005 0950 AM - Startup
[8] 971472005 05:33 AM - Running
=/ Foundry Test Routers

+) Foundry-Test

ssaIppy puLy

As the script is executed, the Results tab displays the progress as the configuration
changes are uploaded. Once the upload command script completes, the results
can be save by clicking the Save Results button at the top of the dialog.
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Finding an Address

Cirrus includes a search engine that will search the entire database (Nodes,
configuration files, and Inventory) for a specific address. To open the Find
Address too], click the Find Address tab on the right side of the screen.

2
U If Find Address is not displayed here, select Find Address from the Windows menu.

Select MAC Address, IP Address, or Hostname, enter the Address Pattern, and
then click the Find button.

%A | Cirrus Canfiguration Management [Config-Mamt]

File Edit Modes Configs Schedule Inventory Reports Show MIEs Tools Windows Help
W EHETEENS H o BEAA, DESE Gy HOBNES -
x
Hodslist  ~ * X|| @) quickstart © Ciscolz-1 |
Node Type of Addiess MAC Addresses v g
=14Q Cisco Access Points 2 Ciscotz1 — ES
+ Q) SW-4P1 MAC Address Pattemn |24 'Q
2, e Device Details. —F Interfaces 1 &] Gonfiguration Histor e B
21 Cisco Test Routers = 12) Confia v| @ Physical addhess of FastEthemetd7 on FoundipTest | &
6 Ciscal2- Interfacs Details | Interfac ¢ Port Status SIEL AL Y
=r Physical address of Dot11Riadiall on SW-4P1
& Foundry Test Routers
& Foundry-Test Physical sddhess of VituakDot11R.adial on Sw-AP1
Index Interface MAC Address gt‘:"‘"'“ ;:::t" = 000F. 24204568 T
e S Physical addiess of FastEthemetd on Sw-4P1 2
1 BRID *  Shute Physzical address of BYI1 on S%w/-AP1 §
B e X shue Downstieam from D ot11 Fradia on Foundiy-Test 3
5 —— O Downstrea from Fast themel1 on Foundy Test &
N . oo @ Up Downstieam from D ot11 Fradia en Foundiy-Test
: Downsheam from BRIO on Foundiy-Test
e @ W o too 243 0200
f ie;';” @ 5” Physical address of Dot1Fiadiall an SWHaP2
. o o Physical addiess of Yitual Dot11Radiol on SW/AP2
. LT @ U o oooF 24e€ 4FE2
9 Serial0101 @ Physical address of FastEthemet0 on Sw-aP2
IO serai0] @ W Physical addiess of BVIT on Sw-4F2
1 BRID-Physical x shute Downstieam from 00t11 RadiaD on Foundry-Test
12 EBRID-Signaling ®  shue Diownstream from FastE themet on Foundry-Test
13 BRIOA-Bearer Channel X shue Downstieam from 0011 RadiaD on Foundry-Test
14 BRI0:2-Bearer Channel X Shute Downstream from BRIO on Foundip-Test
<
l [0 Update Inventory ]

Once the results are displayed, right-click on a result and select View Selected Node
to see the Node Details of the associated device.

To ensure the most accurate and complete results are available, click the Update
Inventory button listed at the bottom of this tab to rescan all Nodes in the database
for any updated information.
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Search Configs

To search for specific strings of text within the configuration files stored in the

Cirrus database, click the F button on the toolbar or select Search Configs from
the Edit menu.

A Cirrus Configuration Management [Config-Mgmt]

File Edit Wodes Corfigs Schedule Invertory Reports Show MIBs Tools Windows Help

@ @' DO % F clBREXMAHL. R Y. HB&e [ EOEHeD

MoC ist X
Hode List Y @) Quick start 2] Edit Cisco12-1 - 9jzz/z005 01:3...  Fly Search Configs ‘ RS
Hode [E] o

- @ Cisco Access Points Search Conligs | Resuts | 2
1 SaR1 E)
) SW-aR2 Search the Configs from the following Nodes : g

=& Cisco Test Routers Mol Machine Type tf
@ Ciscal2-1

= & Foundry Test Routers
€ Foundry-Test

ssa/ppY puld

[ AddDevices | [ % Femave Devices | [ T Grouping [ st Nodes Directy -]

Find | v | By StatSeach | &

(&) Search the last downloaded Config from each Node only

Click the Add Devices button to select which nodes to search. Alternately, click the
Select Nodes Directly dropdown list and select either All Nodes or Specify a
Selection Criteria.

Once the devices or selection criteria have been selected, enter a string of text and
click Start Search to search through the last downloaded config of each Node
selected.

To search through more than just the last downloaded configuration files, click the
# button to expand the Search Criteria.
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%@ Cirrus Confipuration Management [Config-Mgmt]

[
=@ Cisco Access Points
¥ @ SW-2P1
@ SW-AP2
=@ Cisco Test Routers
7 @ Ciscol 21
=& Foundry Test Routers
@ Foundry-Test

Eile Edit Modes Configs Schedule Inventory Reporks Show MIBs Tools Windows Help

i BBXAG. Y. DEES R

@) quickstart {21 Edt Gscotz 1 - izz/za05 0113, (4 Search Configs |
Search Configs | Reauts |

Search the Configs from the following Nodes :

HNode  Machine Type

B AddDevices | [ % Remave Devices | [ Bz Grouping [ select Nodes Directy

]

Find

E v | | By Stert Search

() Search the last downloaded Config from each Node orly
(&) Speciy a date range

Canfigs downloaded

O Within the past wesk

) This month
O Last month From date
O Speciy dates Todue [vzm ]

Include the folloving Config types

¥ Running
v Startup

S3a0ds Do)

s524ppY PUId

With the Search Criteria expanded, specify this week, this month, last month, or a
specific date range. The type of configs to search can also be selected in this
expanded window. Click Start Search to scan the database for the specified text
within the date range selected.

Once the search completes, the Results tab is displayed. The results can be saved
by clicking the Save Results button at the top of the dialog.

%@ Cirrus Confipuration Management [Config-Mgmt]

o

[
=@ Cisco Access Points
¥ @ SW-2P1
@ SW-AP2
=@ Cisco Test Routers
7 @ Ciscol 21
=& Foundry Test Routers
@ Foundry-Test

Eile Edit Modes Configs Schedule Inventory Reporks Show MIBs Tools Windows Help

B SO&d % = Dl BBXALS, BRI OEEa8 G EOBe®-

@) quickstart {21 Edt Gscotz 1 - izz/za05 0113, (4 Search Configs |

|

[Q Save Results ] ID? Edit Selected Config ]

Search Configs | Resuls |

4b %

= Cisco12-1
=@ 9142005 08:33 AM - Running
username greg password 7 0601102448
ip fip passwvord 7 1410000E08243924282921 20281 DO30S4DOFS34D
=[d) 9142005 09:50 AM - Startup
! Last configuration change &t 10:16:24 COT Tue Aug 30 2005
username greg password 7 0801102448
ip fip password 7 1410000E08243924262821 22281 DO3054D0FS3D
= @ 944/2005 09:50 AM - Rurining
username greg password 7 0601102448
ip fip password 7 1410000E08243924262821 22281 DO3054D0FS3D
=) 9222005 01:35 PM - Runring
username greg password 7 0601102448
ip fip password 7 1410000E08243924262821 22281 DO3054D0FS3D
=[d) 9222005 01:36 PM - Startup
username greg password 7 0601102448
ip fip passwvord 7 1410000E08243924282921 20281 DO30S4DOFS34D
= SW-AP1
= @ 943/2005 12:52 PM - Running
username 000124306566 password 7 1153495511 405F54542B7E727E
username 000124808566 autocommand exit
username 000124bedtel password 7 1159435511 405F0EDFE2D21TA
username D0{24hed{e2 autocommand exit
speed basic-1.0 basic-2.0 basic-5.5 6.0 9.0 basic-11.0 12.016.0 24.0 360 48.0 54.0

S3a0ds Do)

s524ppY PUId

Search Configs
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Purging Configs from the Database

As the Cirrus database grows in size, it may be necessary to delete existing

configuration files from the database. To purge the database, select Purge Configs
from the Configs menu.

4 Purge Configs ...

Select the Metwork Devices to purge configs from, select the purge methad, then click the 'Purge’
buttan ta delete the desired configs. Configs will be deleted from the database only.

Select Devices | Select Purge Methad |

Select Nodes

Hode Machine Type

@ SW-AP Cisco 1200 Access Point
@ sw-ap2 Cisco 1200 Access Poirt

@ Ciscol2-1 Cisco 2503
& Foundry-Test  Foundry Networks, Inc

[E addDevices | [ % Remove Devices | [ & Grouping | [ Select Nodes Diecty - |

On the Select Devices tab, choose the nodes that need to have configuration files
removed. There are three ways to select Nodes; All Nodes in the Database, Select
Nodes Directly, and Specify a Selection Criteria. To change the selection method,
click the Select Nodes Directly button and choose the new method.

i Purge Configs ...

EIBX

Select the Metwork Devices to purge configs from, select the purge method, then click the ‘Purge’
button to delete the desired configs. Configs will be deleted from the database only

Select Devices 1 Select Purge Metho

Select Modes

Moke Machine Type

@ SWni-P1 Ciseo 1200 Access Point
@ Sn-ap2 Cizco 1200 Access Point

& Ciscol2-1 Cigco 2503
& Foundry-Test  Foundry Networks, Inc

[ B Add Devices ] [ ¥ Remove Devices ] [ E{ Grouping ] [ Select Nodes Directly ']

@ Specify a Seletion Criteria b

2
U For details on how to specify selection criteria, please refer to page 54.

Selecting the Purge Method

With the Nodes selected, click the Select Purge Method tab to establish which
configs will be removed.
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4 Purge Configs ...

Select the Metwork Devices to purge configs from, select the purge methad, then click the 'Purge’
buttan ta delete the desired configs. Configs will be deleted from the database only.

Select Devices | Select Purge Msthod |

For each selected device

(&) Purge all Configs downloaded before: Include Time

[971 72005 =] BODOOAM v

(O Purge all Configs except the last 10

(@ Puge |[ Dome |

To remove configs older than a specific date, select Purge all Configs downloaded
before: and then, specify the date and time (if required) by using the drop-down
menus or by typing the date/time in the appropriate boxes.

Select the Metwork Devices to purge configs from, select the purge method, then click the 'Purge’
buttan to delete the desired configs. Configs will be deleted fram the database only.

Select Devices  Select Purge Method I

For each selected device:

(&) Purge all Configs downloadzd before: Include Time:

e

['541 v2005 |
J September 2005 J

O Pun

T2 3
4 5 B 7 8 3 10
112 13FD 5 16 17
18019 20 21 2 23
B % 7 o o2 30

3 Today: 971472005 (B Puge J[ pore |

Alternately, to remove all configs and keep only the last few, select Purge all
Configs except the last 10, and then move the slider to adjust how many
configuration files should be kept in the database.

s Purge Configs ...

Select the Network Devices to purge configs from, select the purge method, then click the 'Purge’
buttan to delete the desired configs. Configs will be deleted fram the database only.

Select Devices  Select Purge Method

For each selected device:

(O Purge all Configs downloaded befare:

(2 Delete all except the 10 mast current configs

[

[ Puge ][ Dane
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Once the Purge Method has been established, click the Purge button to remove the
configuration files from the database.

4 Purge Configs ...

Select the Metwork Devices to purge configs from, select the purge methad, then click the 'Purge’
buttan ta delete the desired configs. Configs will be deleted from the database only.

Purge Complete!

Purge More Configs..

Once the Purge has completed, click Purge More Configs to setup another purge, or
click Done to close the window.
Specifying a Selection Criteria

In some instances, it may be easier to specify selection criteria as opposed to
selecting a group of nodes. On the Select Devices tab, click the Select Nodes Directly
button and select Specify a Selection Criteria.

v Purge Configs ... E]@

Select the Network Devices to purge configs from, select the purge method, then click the 'Purge’
button ta delete the desired configs. Configs will be delsted from the database only.
Select Devices | Select Purge Methad |
Select Nodes
J Select Modes where all of the fallowing apply E]
Specily a Selelion Crtera
(@ Puge |[ Dome |

Two types of filtering conditions are available, each of which may be chosen from
a list accessed by clicking the Ellipsis button at the left of each filter’s entry.
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Choose the type of condition needed, referring to the following Condition Table
for guidance in selecting the appropriate condition type.

Condition Options

Elementary
equal

greater

less

greater ar equal
less or equal
nok equal

is empby

is mot empky
conkains

starts with
Records where * (=DatabaseField) —== *(= SpecifiedValue)

Complex BT of the follawil
all
any

Select records where of the following apply

Add an Elementary Condition using the Ellipsis button. Click the first asterisk (*)
and select the desired field using the flyout menu.

f+ Purge Configs ... Q@@

Select the Metwork Devices ko purge configs from, select the purge method., then click the 'Purge’
button to delete the desired configs. Configs will be deleted from the database only,

Select Devices ] Select Purge Method

Select Nodes :

Select Modes where all of the following apply

where B is equalto *
Node Details

[+ ]

|
] Status
Login Infarmation 4 SMMP Level
Communication » Machine Type
r
3

FTR/TFTP Server Vendor

Cuskom Propertiss

Respanse Time
T A Responss Error Specify a Seletion Criteria =
System Contack

Vendar Icon

System Descr

System Name
System OID
Last Boat

05 Image

03 Yersion
Next Discovery
Next Poll

After selecting a field, choose a comparison, such as “is equal to”, and then enter
the value or select it from the dropdown list.
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r Purge Configs ...

Select the Metwaork Devices to purge configs from, select the purge method, then click the 'Purge’
buttan to delete the desited configs. Configs will be delsted from the database only.

Select Devices | Select Purge Method |
Select Nodes

B

T A

‘wihere System Location is equal to

Select Nodes where all of the following apply

0
Tulss, 0K 74133

(* =)

Specify a Seletion Criteria

[ ﬁ. Purge ] [ Done ]

<
U When clicking the dropdown menu for the value, all values currently in the database for that
field are displayed.

Once finished creating the selection criteria, choose a purge method and then click
Purge to remove the configuration files from the database.

2
U For details on selecting a purge method, please refer to page 52
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Command Scripts can be executed to accomplish several different types of tasks
such as Downloading Configs, Uploading Configs, Uploading IOS Images,
Updating Login Banners, Access Control Lists (ACLs), and more. With the use of
macros, a single script can be executed on several different device types without
having to worry about syntax differences between each device.

Getting Started

To launch the Execute Command Script window, click the b} button on the
toolbar, or select Execute Command Script from the Nodes menu.

A Cirrus Configuration Management [ConfigurationManagement]

File Edt Modes Configs Sthedule Inventory Reports Show MIBs Tools Windows Help

F AL BOPON L EF] FolBXAL. B, DEES § G EHCES®- .

e List
@) quickstart "8 sh version ‘ 4bx
Node [H]
(@ Cisco Aps Execute Script IResuns ]
# @ SW-AR1
@ SW-aP2 Select the Modes ta run this Command Seript on
- Cisco Test Routers Node Command Exec
# @ Ciscol 241 51 Cisco Aps
41 @ Ciscol2-2 @ sweap TELWET
=G Foundry Test Routers @ Swar TELHET
gl MR =@ Cisco Test Routers
/9 Juniper Test Routers & cissora -
@ Juriper-Test @ Ciscatz-2 TELWET
[E AddDevices | [ ¥ RemoveDevices | [ B Grouping Select Nodes Directly =
Command Seript to Execute More Information on Scripts and Macios
<h version
%8 Evecute Command Seript T Load Seript Th SaveScipt | &
Mode ... | Confi... Find ...
£} |7 devices | ConfigurationManagement

Selecting Nodes

Once the Execute Command Script window is displayed, devices can be added
using the associated buttons below the list of Nodes. To select a group of Nodes,
choose the option Select Nodes Directly or Specify a Selection Criteria. Otherwise,
select All Nodes in the Database to execute the script on every Node.
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@ Quick Start ﬁ <h version |
Erecute Script IRasurts ]

Select the Nodes to un this Command Script on :

4 b x

Mode

-1{J Cisco Aps
VE
@ Sw-np2

-4 Cisco Test Routers
@ Ciscol2-1
@ Ciscol2:2

[ Add Devices ] [ ¥ Remove Devices ] [ E:_ Grouping

Command Script to Execute :

Command Exec

TELKET
TELMET

TELMNET
TELMET

Select Modes Directly =

All Nodes in the Database
tly

sh version

Specify a Seletion Criteria

With the option Select Nodes Directly selected, click the button
and choose the Nodes and/or Groups that are to be applied to this script and then

click the OK button.

7a|Select Routers / Switches ...

Select the Devices you would like to Add to the Existing List

3

Node

= Cisco Access Points
@ SW-AP1
@ SW-AR2

=@ Cisco Test Routers
@ Ciscot2-1

= & Foundry Test Routers
& Foundry-Tast

Hald the Shift or Contral key as you select sach device to select multiple devices

To select a group of Nodes based on a specific set of conditions, select the option
Specify a Selection Criteria. Add a condition by clicking the J button and then

click Add a Simple Condition.
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“A Cirrus Configuration Management [ConfipurationManagement]

File Edt Modes Configs Schedule Inventory Reports Show MIBs Tooks Windows Help

F AL BTPINL F, B BEXAL BT OBES GG EOEe®-

Bl NS | @) quickstart B sh versinnl b x
Madle (€]
-1 Cisco Aps Execute Seiipt IResuhs |
G SW-8P1
4G 5w Select the Nades ta run this Command Serpt on
= ? ;'zf:c::: Rauters [T Setect Modes where all o the fallowing aply
@ Cisca 2.2

#dd a Complex Condition
#dd a Condition Group

= Foundry Test Routers
+ @ Founciry-Test

=@ Juniper Test Routers
@ Juniper-Test

V,  Add Condiion Specily a Seletion Criteria ™

Command Script to Execute Mo Infoimation on Sciipts and Macios

sh version

¢ Execute Command Seipt T Load Script 2

#% 7 devices | ConfigurationManagement

| ode ... [confi. Find..

Click the first asterisk (*) and then select the desired field using the submenu.

A Cirrus Configuration Management [ConfigurationManagement]

File Edt Modes Configs Schedule Inventory Reports Show MIBs Tools Windows Help

F S B T O & G ol RBEXMAL. BRI UBES [ G EBOEeD

R I | @) quick Start 8 sh version ‘ 4bx
Node [H]
=@ Cisco Aps Executs Soript IResuns |
# @ SW-AR1
@ SW-aP2 Select the Modes ta run this Command Seript on
- Cisco Test Routers
@ Select Nodes where sl of the following apply
7 @ Ciscal 240
et ]| WhereBlis equelto =

Maode Details

=& Foundry Test Routers.

7 € Foundry-Test Status
1€ Juniper Test Routers Lagin Information SHMP Level
Communication Hachine Type

# @ Juniper-Test

FTPJTFTP Server
Vendor Icon
Response Time
Response Error

System Contact
Sysan Dess
System Location
Command Script to Execute System hame More Irformation on Seripts and Macios
System OID
Last Boot
05 Image
05 Version

sh version

Hext Discovery
Hest Fol

8 Evecute Command Script T Load Seript 2

3 7 devices | Configurationtanagement

Confi,.. Find ...

Select a condition (the default condition is “is equal to”) and then click the second
asterisk (*) to assign a value for the condition. Type a value, or select one from the
drop-down list.
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2
U When clicking the dropdown menu for the value, all values currently in the database for that
field are displayed.

Click the OK button once satisfied with the selection criteria, or group of Nodes.

Executing Command Scripts

Once satisfied with the selection of Nodes, type the script that is to be executed.
The script consists of a single command or list of commands to be sequentially
executed. The script should mirror commands entered when manually entering
instructions using the command prompt. For example, when sending the “show
version” command to a router via a TELNET session, the prompt requires the user
to enter “sh version”. Add one line to the script that has the exact phrase as it is
typed in the command prompt “sh version” (without quotes) with a carriage
return (ENTER key) at the end of the line.

Click the Execute Command Script button to start the script. The Results tab will be
opened automatically and the outcome of the script will be displayed as the
output is received.

A Cirrus Configuration Management [ConfigurationManagement]

File Edt Modes Configs Sthedule Inventory Reports Show MIBs Tools Windows Help

F A BOSPEIN L EF B BEYAL. R Y. DEES GG EOESE-
st 4

@ quickstart g " Remulely...‘
Mode: [E]
~I14 Cisco Aps Execute Script | F\esu\ts{l
@ SW-AP1

@ Sn-ap2 [@ SaveResuls W Outline View

I Cisco Test Routers

# (@ Ciscol2-1 -l Cisco12-1

@ Ciscol 22 =/ ping 198.133.219.25
=& Foundry Test Routers Type escape sequence to abort.

7 € Foundry-Test Sending 5, 100-byte ICMP Echas to 185.133.219.25, timeout is 2 secands:
= Juniper Test Routers ]

% @ Juriper Test Success rate is 100 percent (5/5), 1ound-irip minfawginas = 52/55/56 ms

| Mode.., [confi.. Find..

3 7 devices | Configurationtanagement

g Uncheck the Outline View check box to display the results without any formatting.

60 Executing Command Scripts



&3 Recycled Paper Chapter 5: Command Scripts

Saving and Loading Command Scripts

After running a successful script, the script can be saved for later use. On the

Execute Script tab, click the Save Script button, type a filename and then click the
Save button.

To load a previously saved script, or one of the example scripts that ships with
Cirrus, click the Load Script button. To view the prepackaged example scripts,
open the \Sample Scripts folder and select one of the available scripts.

Eile Edt Modes Configs Schedule Inwentory Reports Show MIBs Tools Windows Help

@AM BTSIND F B0 RBEXHAE ] BRI OBES B EOBe®-

Mode List 1 x

4k x

Mo =
== 5] Load Command Script ...
- Cisco Aps P
G SW-AP1 Look i | 5 Gimple Sciipts v % m
@ TAP2 Select the
- (J Cisco Test Routers = r 2] Change Interface Description.kxt —
@ Ciscol2-1 =@ c [ =) Change Login Banner.txt
€ Ciscol2.2 P My Rrecent hange SMMP Community Strings bt
=1 Foundry Test Routers Documents et Serial humber from each Device txt
+ @ Foundry-Test = f
=€ Juniper Test Routers [
# @ duriper-Test Desktop
o My Documents T
Command gj i Macios
b Remod M Compuer
i i, " Fie name: | Fremotely PING a sst of adhesses it v [ open |
132 1 .
[ My Metwork | Files of type [ Tet Files (1) v [_cancel |
TR Evecute Command Script W savesoipt | &

Wode ... | Confi... Find...

2% |7 devices | ConfigurationtManagement

Advanced Options

To display the Advanced Options, click the ‘A button at the bottom-right of the
window. The additional options are displayed below the Command Script to
Execute text box.
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& Cirrus Configuration Management [ConfigurationManagement]

File Edit Modes Configs Schedule Inventory Reports Show MIBs Tooks Windows Help

]

B F | By
st

Node

~/14 Cisco Aps
€@ SW-AP1
@ SH-AP2

I Cisco Test Routers
# €@ Ciscon 21
# @ Ciscol 242

=& Foundry Test Routers
# € Foundry-Test

=€ Juniper Test Routers
€@ Juriper-Test

COERL F. i A BRI IEEe R BOBSD

@ quikstart 8 " Get Serial Numb...

Select the Modes to run this Command Script on

q4br %

Hode
=@ Cisco Test Routers
@ Cisco121
@ Ciscot2-2
=@ Cisco Aps
@ sweapt
@ MRz

[E AddDevices | [ ¥ RemoveDevices | [ B Grouping

Command Seript to Execute

Command Exec

TELNET
TELMET

TELNET
TELMET

Select Nodes Directly )

Muore Information on Scripts and Macios

' Get Serial Number from each device ~

* The Advanced Option "Filter results that match a pattem” is set to "Serial”

show wersion

Advanced Optians
Filter results that match a Pattemn
[]Save Results ta a File

Serial

CJ

Muare information on Patten Matching
Show Commands in Output

%8 Evecute Command Seript T Load Seript ¥

3 7 devices | Configurationtanagement

| Hode.., [confi.. Find..

The Filter results that match a Pattern option allows the user to show only the
results that meet specific criteria when the script is executed. For example, adding
the word “Serial” to the filter will only display lines that start with the word
“Serial”. This specific filter is useful in trying to find the Serial Number of a Node
or group of Nodes. The example script Get Serial Number from each Device.txt
demonstrates this feature.

2
U For details on Pattern Matching for filters, see Appendix D: Regular Expression Pattern Matching
on page 147.

To automatically write the results of the script to a file, check the Save Results to a
File check box. Type the path and filename for the log file, or click the e button to
browse to a path and select a filename.

To hide the commands that are sent when the script is executed, uncheck the Show
Commands in Output check box.

Using Macros within Scripts

One of the features that makes the Cirrus Scripting Engine so powerful is the
ability to use macros within scripts. Cirrus Configuration Management uses a
similar macro system as the one in Orion Network Performance Monitor. Macros
always begin with a dollar sign and curly brace ${ and always end with a curly
brace }.
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These script macros are used to substitute the appropriate commands based on the
device type. For example, the macro ${EnterConfigMode} will parse as "config
terminal” when communicating with Cisco IOS devices, but will parse as
"configure" when communicating with an HP Procurve Switch.

Example Macro Script

${EnterConfigMode}
Script containing macros that no snmp-server community public RO
removes the “public” Read-Only ${ExitConfigMode}
Community String ${SaveConfig}

${Reboot}

config terminal

no snmp-server community public RO
end

write memory
reload${CRLF}y${CRLF}y

The same Script as it parses for
Cisco I0S devices

config

The same Script as it parses for no snmp-server community public RO

a Dell PowerConnect Switch end )
copy running-config startup-configb{CRLF}${CRLF}
reload${CRLF}Yes

Note: the ${CRLF} macro parses as a Carriage Return Line Feed.

Script Macros are defined in Device Command Templates. These templates reside
in the C:\ Program Files\ SolarWinds\ Configuration Management\ DeviceTypes
folder. Each .ConfigMgmt-Commands file contains a System OID that is used to
uniquely identify a device. Also included is a list of Command Names and the
commands that will be sent to the device when the Command Name is called.
These Command Names are the macros that are used when creating a script.

Here is a line taken from the Cisco IOS Device Command Template:
<Command Name="EnterConfigMode" Value="config terminal"/>

In this example, when a script is run on a Cisco IOS device, the macro
${EnterConfigMode} will parse as “config terminal”. New Command Names can
be added as well as existing Command Names can me modified within these files.

u Changing Device Command Templates alters the way Cirrus communicates with network
devices. SolarWinds does not recommend changing a Device Command Template unless the
user has advanced knowledge and experience with device commands and use of macros.

For a list of macros that can be used in Command Scripts and Device Command
Templates, refer to Appendix C: Macros on page 146.
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Chapter 6: Inventory

In addition to all of the config management functions, Cirrus has a very robust
Inventory Engine. Inventory can be performed on all nodes, a group of Nodes, or
just one Node at a time. The statistics collected by the Inventory Engine can easily
be viewed in each device’s details view.

Performing a Full Inventory

To perform an inventory on all Nodes managed by Cirrus, select Start Full
Inventory from the Inventory menu.

#n Device Inventory Status x|

Mode P Acldress Percent Complete Status

Cisco-1200-4P-1 1040112 N Active UDP Ports : UDPAddress
Cisco-1600-4 1040153 | T Logical Ertiiss - Typs
Cisco45002 10101 56 T Flash Files : FlashFileStatus
Foundry-TestLab 10401124 . Interface Detalls - IntsrfaceName

¥ Cancel All Updates I Close Window

Y
U A Full Inventory can take several minutes, or even hours to complete depending on how
many Nodes are being managed, and what Inventory statistics are being polled.

To establish what statistics will be collected, please refer to Inventory Settings on
Ppage 66.

Running Inventory on a Single Device or Group

When needing to perform inventory on a single Node or group of Nodes, right-
click on a node, node group, or selection of nodes and select Inventory Selected
Nodes.
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#m Configuration Management =0 x|
file Edit Modes Configs Schedule Inwentory Reports Show MiBs Tools Windows Help
GEHOrENEE 2 EFHe s BX AN a GESEES]
() quick start ‘ 4bx
Mode
= @ Cisco APs =
@ SW-AP m—
@ sw-aP2 mmmﬂnb). n:l.
5@ Cisco Test Routers Network Management Tools
@ cisco12-2 F
=@ Foundry Test Routers i AddNew Device ...
@ Founcry-Test Oy Edit Selected Devices ... jtion Management
By Edit Multiple Devices ...
¥ Delete Selected Devices
1 Ping Selected Devices ... ‘Welcome to the March 2005 Alpha Release
Current Traffic of SolarWinds Configuration
- Management.
06 Iwventory Selected Nodes .. g
T Execute Command Script ... The Configuration Manag {Pre-Rel
42 Download Configs ... “ersion) program enables guick and efficient
3 S - configuration management of Routers, Switches, and
Zelect Fields and Grouping ... — Firewalls. Simply point, click, and the device's
1 configuration is downloaded in in real time via TELMET
» .
Show SSH1, or SMMP. All downloaded configurations are
& ws 4 archived to a central database for versioning, review, and
@ Tools » easy comparison. Configuration Archives can also be
— "mirrored” to a directory tree for external program
|| 8CCESS LI
Inventory Selscted Nodss ... |z

Scheduling an Inventory

A full Inventory can be scheduled to run on a regular basis. To create a new
Inventory Job, select Schedule Inventory from the Inventory menu. Give the Job a
name, and then establish the time interval for the Job.

Schedule Inventory

‘When should this Job un ?

Scheduls Job Start Time

eekly - 12:00 AM

Starting On Ending On

91372005
Every |1 weskls] on
[ Monday [ Thursday [ Sunday
[ Tuesday [ Friday

[ Wednesdsy [ Gaturday

Cancel

For more detailed instructions on Scheduling Tasks, please refer to Chapter 8:
Scheduling Tasks on page 75.

Inventory Settings

Different networks require different statistics to be recorded during an inventory.
To specify which statistics are collected during an inventory, open the Inventory
Settings window by selecting Inventory Settings from the Inventory menu.
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#A Configuration Management Settings |
42 Mode List . :
Device Invento
#{1 Global Macro Settings N E
B FTP/TFTP Server Detals sbout each device can be sdded to the database duing Device nventory
K Custom Proper
< Custom Propetties
B Reports “wlhich items should be included in the Inventary 7
&1 Scheduled Jobs Starsiad =
[ Mode Details Window ARP ARP Table
@ NDDdE Mﬂlmn'mg Bridge Table Layer 2 Forwarding Takles
E\F" e‘”\f: Q"e”m"' Entity MB Physical and Logical Entities
_,é? C:ﬂghgs‘" o Intertaces Extencied! information shout Interfaces
&)
&
5 Network IP Addresses IP Address Tables
5 acros Active Ports TCP and UDP Ports
Tools and Actions Clsco)
(29 Advanced Cizca Cards Cards in each router / switch
Hotification Diefaults Cisco COP Cisco Discovery Protocol
Cisco Chassis Cisco chassis type serial number, memory, etc.
Cisco Flash Cisco Flash Details
Cisco Image Details about the running 105
1=C0 Memoary Poals Eemaory Podl locations e
Cisca M Paol M Poal Allocat
windows
Windows Services Running services on Windows machines =

Check the statistics that are required for inventory and click OK to save the

changes. The next time an inventory is performed, only the selected statistics will
be collected.

Viewing Inventory

To view the inventory statistics collected by Cirrus, right-click on a Node, select
Edit Selected Nodes, and then click the Inventory tab.

The Inventory tab displays the information collected by the Inventory Engine. A
sub menu is listed on the left side categorizing the different statistics that can be
displayed. Click a category on the right to display the associated statistics. If no

statistics are available, it may be necessary to perform an inventory on the selected
node.
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#A Cirrus Configuration Management [Config-Mgmt]

File Edt Nodes Corfigs Schedule Inventory Reports Show MIBs Tooks Windows Help

@ ([E'8 DO &) % &L clBBXALLRRY. DEB&E R GIECEHESS-L

@) quckstart S SW-AFZ‘ 4 x
Hore B
3
E1€@ Cisco Access Points (P sw-apz I@ Actions ] l £ Shnwl [@ M\Bs] [E TUD\SI >
P &
— i
LG & Device Datails ]z‘f Intertaces ‘ “8) cortiguration History 49 | @
= @ Cisco Test Routers i
@ ciscot2-1 -~
=1 Foundry Test Routers SW-AP2
S fonayyest Cisco 1200 Access Point g
Cisco Internetvwork Operating System Saftware I0S (tm) C1200 Softwware (C1200-KSW7-M), Version 12 20154, RELEASE SOFTWARE (fel) gv
Technical SupRort: hitp: My, cisco.comechsuppart Copsriht (<) 1986-2004 by clsco Systems, Inc. Compled Fri 09-Apr-04 g
H
System Info Select one ofthe Inventory sections from the left menu
ARP Table
Cirrus Configuration Management Inventary includes details about each managed device.
Interfaces
The following details can be included during device inventory.
IP Addresses
TCP Ports « ARP Cache
o Interfaces or Ports
UDP Ports « Interface types (Frame Relay, ATM, Ethemnet, FODI, tc.)
VLAN © MAC Address of each Interface
o = IP Addresses assianed to each Interface
Physical Entities « Subnetting Information
* PortSpeeds
* MTU (maximum transrission unit) for each port
Cisco Specific » Active UDP and TCP ports
P * ULAN assignments
Cisco Discovery = Bridge Table
Protocol
» Chassis details of Cisco devices
« Chassis serial number (newer 108 on newer Cisca hardware onfy)
= Reason for last system reload
» Total and used maemory v

These statistics can also be viewed directly from the database. To do this, open the
Cirrus database using Microsoft Access or SQL Enterprise Manager. Each group
of statistics will be stored in a corresponding table. Reports and queries can be
performed just like any other database. For details on how to create reports or
queries, refer to the documentation provided with Microsoft Access or SQL
Enterprise Manager.
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SolarWinds has developed a Report viewer application, which provides a quick
and easy way of extracting data from the database and displaying it in an easy to
read format.

Several standard reports are included in the distribution of the program, which
can be modified, and new reports can be created as necessary. Reports can be
printed or emailed with just a click of a button.

Viewing Reports

To view a Report, select View Report from the Reports menu, select a Report and
then click OK, or simply double-click the Report.

%A | Cirrus Canfiguration Management [Config-Mamt]

Fle Edit Modes Corfigs Schedule Inventory Reports Show MIBs Tools Windows Help

B RNE s R win AN DR S HhE. DBES nw BOEBESS-. hw ¥,

M E‘ Quick, Skart Current Response time of e... | 1k x
Modle: ) i o
-1 Cisco Access Points Current Response time of each Device EX
= € SWi-AP1 o
+ @ SW-AP2 Hode Vendor Machine Type Responss Time  Respanse Error 5
=19 Cisco Test Routers =@ Cisco Access Points &
+ @ Ciscol2-1 =@ SW-aP 4k Clsco 1200 Access ot 2ms oK
=149 Foundry Test Routers [) 8/13(2005 01:01 PM - Running
@ Foundry-Test =I[@) r13/2005 12:52 PM - Running
[ sdded private RO Community 913/2005 04:05 P T
=@ SW-Ap2 4k Cisco 1200 Access Foint 165 ms oK .
[8) 9r1312005 12:51 PM - Runining g
=@ Cisco Test Routers 3

=@ Ciscol2-1 4k Cisco 2503 3ms oK
[8) 8/14/2005 08:50 AM - Running
[ 81412005 08:50 AM - Startup
[8) 81412005 08:33 AM - Running
= Foundry Test Routers
@ Foundry-Test E¥  Foundry Networks, . 2ms oK

The report is displayed in a new tab with Report specific buttons added at the top
of the tab. To print the Report, select Print from the File menu. To email the
Report, select Send To > Mail Recipient from the File menu.
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Creating and Editing Reports

To create a new Report, select New Report from the Reports menu. The Customize
Report dialog is displayed.

Alternately, to edit an existing Report, select View Report from the Reports menu,
and then open the Report that is to be modified. Click the Modify Report button to
display the Customize Report dialog.

General Tab

The General tab is used to establish basic Report settings such as the Report Title,
the Print Orientation, and the Filename.

E3]

B Customize Report
General WSE\ECI Fields I Fitter Results I

Filename =
Report Title | Mew Report

Sub Title:

Category User Defined

Description

Print Orientation

O Partrait

(® Landscape

[ Display current Device Up/Down Status
Group/Merge similiar rows

Huorizontal Lines -

Click the Ellipsis button to the right of the Filename field to choose a path and
filename for the Report.

2
U The default location for Reports is C:\Program Files\SolarWinds\ Configuration
Management \Reports. In order for a Report to be included with the list of existing Reports, it
must be saved in the Reports folder under the Configuration Management folder.

Give the new Report a title, and then create a Sub Title and Description (these are
optional fields). Set the Print Orientation (Portrait or Landscape), and select
Display current device Up/Down Status and/or Group/Merge similar rows if desired.
Also set what type of line will be displayed (No Lines, Grid Lines, or Horizontal
Lines).
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Select Fields Tab

General  Select Fields IFmer Resunsl

Giroup the Routers/Switches by | <none> |

Select the Propetties that should be displayed in the list of Fouters / Switches

All Properties Selected Properties
= Node Details -~ Node Name
Node D — (=R Vendor lcon
Node Name IP Address
Node Group Machine Type
IP Address System Location

Spstem Contact

tP Cammunity String
ts

= Discovered Properties
Reverse DNS
Response Time
Fiesponse Emor
Device Status
SMMP Level
System Name:
Sustem Descriotion ha

“ |

On the Select Fields tab, select the properties that are to be added to the Report and
click the [ J button to add the field.

B Customize Report E]

General  Select Fields WFmar Results I

Group the Routers/Switches by : | <nones e
User Name ~
Select the Properties that should | P assword =
Al Properties e
Enable Password
ALEDEE ot Tt Prtacl
Hode 1D E
- E_ =
Mode Group Machine Type ¥
IP Address System Location
SHMP Community String L3 System Contact
Comments
= Discovered Properties
Reverse DNS

Response Time
Responze Ermor
Device Status
SMNMP Level
System Mame

Sustem Desciiotion hd

To group the nodes by a category, click the dropdown list at the top and select the
desired category. Custom Properties can be used when grouping Nodes.

&
U For information on how to create Custom Properties, please refer to the Custom Properties
section in Chapter 3: Managing Nodes on page 28.
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Filter Results Tab

The results of a Report can be filtered to display only the necessary information.
Two types of filtering conditions are available, each of which may be chosen from
a list accessed by clicking the Ellipsis button at the left of each filter’s entry.

Choose the type of condition needed, referring to the following Condition Table

for guidance in selecting the appropriate condition type.

Condition Options

Elementary
equal

greater

less

greater or equal
less or equal
niat equal

is empky

is nok empky
contains

skarks with
Records where * (=DatabaseField)

*(= SpecifiedValue)

Complex BT of the follawi
all
any

none

not all

Select records where

of the following apply

Add an Elementary Condition using the Ellipsis button. Click the first asterisk (*)

and select the desired field using the flyout menu.

B Customize Report

General | Select Fieids  Filter Resuls I

Select Nodes where all of the following apply

J Wwihere Vendor s equal to

Metworks, Inc.

Top xx records only
() All Records

O ShowonlytheTop 10| Fiscords
O Show the Top l:l % of Recards

(¢) ]

_ |

After selecting a field, choose a comparison, such as “is equal to”, and then enter

the value or select it from the dropdown list.
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2
U When clicking the dropdown menu for the value, all values currently in the database for that
field are displayed.

At the bottom of this tab is a section called Top xx records only. This section is used
to limit the amount of records displayed when the report is executed. All Records
is selected by default. Select Show only the Top XX Records to specify a number of
reports to display. Alternately, select Show the Top XX % of Records to display
only a specific percentage of results.

Click OK once finished creating any filters and establishing the amount of records
to display.

To save the changes to the Report, click the Save Changes button displayed above
the Report.

Deleting Reports

To delete an existing Report, select View Report from the Reports menu, select a
Report or group of Reports, and then click the Delete Selected Reports button.

Scheduling Reports

To schedule a Report to be emailed or printed, select Schedule Report from the
Reports menu. The Schedule Report dialog is displayed prompting for a name for
the task. Give the task a name and then finish the Schedule Task Wizard. For
detailed instructions on how to configure scheduled tasks, please refer to Chapter
8: Scheduling Tasks on page 75.
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Chapter 8: Scheduling Tasks

With Cirrus’s scheduled task feature, managing routers has never been easier.
Some of these tasks include config uploads, config downloads, Node reboots,
executing command scripts, and more.

Cirrus uses the Windows Task Scheduler to organize the scheduled operations.
Any Job created with Cirrus can be viewed and modified with the Windows Task
Scheduler. This can be opened by clicking on the Windows Start button and going
to Start > Programs > Accessories > System Tools - Scheduled Tasks.

Creating a New Job

To start creating a new Job, select Create New Job from the Schedule menu. Type a
name for the Job and then click Next .

SOLAIWINDY.NET

Configuration Management - New Job Wizard

Network Management Tools

Enter a name for this Job

| [Newdob

| This name should be something descriptive sa that it can be identified in
| Configuration Management, as well as the ‘windows Scheduled Tasks
g list.
30 j

SOLAIWINDY.NET

Configuration Management - New Job Wizard
Network Management Tools

‘what Type of Job would you like to create ?

B Erecuts Command Soript on Devices
*p Download Configs from Dievices

#p Upload Changes to Devices

Fieboot Gelected Devices

Check Palicies

Fun Fiepott

Update Invertory

Export Configs

Evecute Program

OfF@OEE

<~Back Cancsl |

Set the Schedule Type, Start Time, Starting Date, and Ending Date. Depending on
the schedule type (Daily, Weekly, Monthly, etc.), the area at the bottom of the
dialog will display additional options.
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Configuration Management - New Job Wizard

‘When should this Job un 7

Scheduls Job Start Time

[weekiy =l [0224Pu

Starting On Ending On

[515¢2005 |
Every |1 weskis] on
[ Monday [ Thursday ¥ Sunday
[ Tuesday [ Fridsy

[~ Wednesday [T Saturday

<~ Back

Cancel |

2,
U To assign a Job to run with no End Date, leave the Ending On field blank.

Set the Windows User Information by assigning the Job a Windows user account
and password to run as, and then click Finish.

Configuration Management - New Job Wizard

Enter Windows User Information

Enter the name and password of the Windows Account
that will run this Job. The Job will be run as if it were
started by this user,

Enter the user name [ Administrator

Enter the password l—
Confirm the password |—

Cancel |

After clicking Finish, the Edit Job dialog is displayed. Follow the steps listed in the
following section, Editing and Copying Jobs, to finish configuring the Job.

Editing a Job

After creating a Job schedule, the Job details need to be configured. If the Edit Job
dialog is not already displayed, right-click on a Job and select Edit Job.

2,
U To display the list of Jobs, click the @ button on the toolbar, or select Display/Edit Jobs from
the Schedule menu.

On the General tab, the Job can be Enabled/Disabled, the schedule can be modified,
and comments can be added.
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+ Edit New Jab’ Job 3]
New Job
Download Configs fiom Devices
General INndes | Downinact Config | Natifications | securtty |
Enable this Job

Run this Job on the following Schedules
At12:01 AM every Sun of every week, staing 3/15/2005

@ Add Schedule

Comments

“wWeekly Configuration B ackup

Job-100681.Confight gmtlob
Created by Test using Configuration Management at 9/15/2005 B:44:19 AM

|

2

U The second tab, “Nodes” in this example, will be different based on the type of Job created.
For details on the different settings displayed in this tab, please refer to the Job Specific
Settings section on page 78.

When a Job completes, a notification can be sent along with the completion status
details. Use the Notifications tab to setup printer or Email notifications. Recording
the Job status details can also be enabled here.

52 Edit ‘New Jab' Job 3]

New Job
Download Configs fiom Devices
General | Nodes | Download Canfig  Notiications }sMumyl

[ Frint Riesults

Pinter

E-Mail Results
Emai To | Emai From | swTe Server |

E-Mail Flecipients

Ta | Yourame@ivourCompany Conl
|
Bcc |

Subject |Su\alwinds Met Configuation Management Job Completion Notifica

Log Job steps to Job-100681 log Test Notifications

|

Click Test Notifications to ensure all Notification settings are configured properly.

On the Security tab, set the Windows User Information by assigning the Job a
Windows user account and password to run as, and then click the Set Username
and Password button.
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+ Edit New Jab’ Job 3]
New Joh
Download Configs from Devices

General | Nodes | Downioad Canfig | Netifications  Secuity I
Enter Windows User Information

Enter the name and password of the Windaws Account
that will run this Job. The Job will be run as if it were
started by this uger.

Enter the ser name SERVER Adminishator
Enter the password | =

Confirm the password

Set Usemame and Password

Job Specific Settings

Different settings will be displayed on additional tabs in the Edit Job dialog
depending on the type of Job that is being configured.

Nodes Tab

When editing a Job that with one of the following types, the Nodes tab will be
displayed:

e Execute Command Script on Devices
e Download Configs from Devices

e Upload Changes to Devices

e Reboot Selected Devices

e Config Change Report

By default, the Job is assigned to All Nodes. To select a group of Nodes, choose the
option Select Nodes for this Job Directly or Specify a Selection Criteria.

With the option Select Nodes for this Job Directly selected, click the

button and choose the Nodes and/or Groups that are to be
applied to this Job and then click OK.
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7 Select Routers / Switches ...

Select the Devices you would like to Add to the Existing List :

]

Mode

= Cisco Access Points
@ S-AR
@ SW-AP2

=@ Cisco Test Routers
& Cizcol2-1

=& Foundry Test Routers
9 Foundry-Test

Hald the Shift or Cantral key as you select each device to select multiple devices,

|

If, instead, the option Specify a Selection Criteria is selected, click the J button and

select Add a Simple Condition.

52 Edit ‘New Jab' Job 3]

New Job
Download Configs from Devices

Execute this job on the following Nodes

(2 Specify a Selection Criteria

Genersl Modes }ann\nad Contig | Wtitisations | securty |

O &llNodes ) Select Nodes for thisJob directly

[T 5elect Nodss whers all of te folloving apely
imple Conditi

Add a Complex Condition
Add & Condition Group

KaNCY

|

Click the first asterisk (*) and select the desired field using the fly-out menu.
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« Edit ‘New Job® Job
New Job
Download Configs fiom Devices
Genersl Modes }ann\nad Contig | Wtitisations | securty |
Execute this job on the following Nodes

O &llNodes ) Select Nodes for thisJob directly
(2 Specify a Selection Criteria

Select Nodes where al of the following apply

| s Bz sl +
Mode Details

»
Discovered Properties ¥
Login Information 3
Zommunication 3
»
»

FTP/TFTP Server

Floor

[« &

|

Select the condition (the default is “is equal to”) and then click the second asterisk

(*) to assign a value for the condition.

« Edit ‘New Job’ Job
New Job
Download Configs fiom Devices
Genersl Modes }ann\nad Contig | Ntitications | securty |
Execute this job on the following Nodes

O &llNodes ) Select Nodes for thisJob directly
(2 Specify a Selection Criteria

Select Nodes where al of the following apply

|| where Buiding is eaualto

v

Central Tower

Headguarters
Warehouse &
"wWarehouse B

« B

X

Cancel

|

2
U When clicking the dropdown menu for the value, all values currently in the database for that

field are displayed.

Download Config Tab

This tab is used to select which types of configs to download, and what actions are

to be perform upon the completion of the downloads.
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« Edit *Weekly Config Backup® Job

Weekly Config Backup

Download Configs from Devices

|

Genersl | Nodes | Dawninad Config | Nefiications | Secury |

Download Options
Canfig Types

support a config type. it will simply be skipped

¥ Running
Startup

Changed Configs
Send a notification if the downloaded Config is different than the:
[[] Last Config
[] Baseline Config

[] Only save Configs that have changed

Select the config types ta download from the selected devices. |f a particular device does nat

3

G| Edit Comparison Criteria

A notification E-mail can be sent when a downloaded config is different than the
last config or different than the Baseline config. Check Only save Configs that have

changed to discard any configs that have no changes.

Click the Edit Comparison Criteria to configure Cirrus to ignore specific lines of a
configuration file. For more information on Comparison Criteria, see Comparison
Criteria and RegEx Patterns in Chapter 4: Managing Configs on page 38.

Command Script Tab

When editing a Job that executes a command script, the Command Script tab will

be displayed.

8¢ Edit ‘Community Update® Job @

Community Update
Execute Command Script on Devices

Genersl | Nodes  Command Script }Nm.f.cat.unsl Securty |

conf t

v snmp-server community public A0
srmp-server community 123@dmin RO
exit

war mem

& Load Seript From File

Type the command script that is to be executed in the text box provided. The

Job Specific Settings
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script can also be loaded from a file by clicking the Salowseiniene | bytton, selecting

a file, and then clicking OK.

Report Tab

When editing a Job that runs a Report, the Report tab will be displayed.

8¢ Edit ‘test” Job
test
Fun Report
General 'HEDDI{I Notifications | Securty |

Select a Repart

3

All Modes

Community Strings for sach Mode
Down Nodes

Last Boot Time for each Device
Login information for each Device
Mew Repart

Rediscovery and Poling

| e e iR e e e P R R i

System Information of sach Device

Devices that do not respond to SKMP

Current Response time of each Device

On the Report tab, just select the Report that is to be executed. Only one Report
can be executed at a time. To execute more Reports, a new Job will have to be
created for each additional Report.

Config Mirror Tab

When editing a Job that exports configs, the Config Mirror Location tab will be

displayed.

5l: Edit ‘Export Configs’ Job 3

Export Configs
Export Configs

Export Canfigs to the following Location

Iwaficatinns | securty |

Configs ars always stored in the Configuration Management datahase
This Job will create a backup copy of the Configs by exporting them from the database.

| € \Program FilesS olarwinds\Configuration Managsment\Config-Archive' | (L]

Use the following template for the filename when exporting Configs

‘ $H{ModeGrouph${CaptionP D atel\${Caption}-${ConfigTypet. Config ‘

Export the following types of Configs

| Running
Startup

© Export all Configs in Configuration Management Database for the selected

(3) Export only the latest Config for each sslected Nods

82
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Select the path to export the configs to, and set the template for the filename
structure. Select which configs (Running and/or Startup) to export, and choose
whether to export all configs, or just the last downloaded for each node, and then
click OK to save any changes.

Program Tab

When editing a Job that executes a program, the Program tab will be displayed.

8l Edit ‘Server Backup® Job &‘

Server Backup
Execute Program

General  Program INmicaﬂons} Securnyl

Start the following program
C:\Program Files\Backup\Backup.exel |

Click the Ellipsis button and browse to the application that needs to be executed.
Select the application and click the Open button. Click OK to save the changes.

Config Change Report Tab

When editing a Job that executes a Report showing the changes between Configs,
the Config Change Report tab will be displayed.

» Edit *Test Job Job 3

Test Jobh
Generate a Config Char

Generel | Nodes LG Notificatianss | Security |

Show the fallowing Config changes
(%) Compare most recent Download to the last Baseline Config
() Compare the most recent D ownload to the Configuration on | 1041172005 =
) Show changes made over the past daps
(O Show changes mads between |10/11/2005 | and [10/18/2005 ~|

Adwanced Options

S Ignore lines that match any of the following patterns

Check this box to show the detailed Edit
changes between each downloaded
Config

Cancel
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Select the type of Config Change Report to generate. The default selection
(Compare most recent Download the last Baseline Config) will display all the
differences between the last Baseline Config, and the most recent Downloaded
Config.

The second option, Compare the most recent Download to the Configuration on a
specific Date, will show all differences between the most recent Downloaded
Config and a Configuration on the specified date.

=y
U If there was no Config downloaded on the specified date, the next Config after that date will
be used for the comparison.

The last two options will show all changes made to a device configuration that
have occurred during a specific date range.

Check Show detailed changes to display the differences between each
configuration file separately. This will show each change from one config to the
next. For example, if there were 4 configuration changes made in a specific date
range, the Report will show the differences in the first config compared to the
second config, and then show the differences in the second config compared to the
third, and so on. The Report will be grouped by date, showing all changes made
on each day.
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Viewing Job Logs

To view a Job's log, the list of Job’s must first be displayed. To display the list of

Jobs, click the %@ button on the toolbar, or select Display/Edit Jobs from the
Schedule menu. Right-click on a Job and select View Selected Job’s Log.

[ conguraion ramogemene ————— il

Fle Edit Modes Configs Schedule Inventory Reports Show MIBs Tooks Windows Help

IRl - R XMHGpaEa heebEed

B) quickstat % scheduled Jobs [ "New Job® Iugl 4bx
hode g
=@ Cisco APs Rehesh | 65 Actions ES
)
B/16/2008 AN Started : New Job Job-7E6344 ‘%
a/16/2008 MM : Starcing Dowmlead of Ranning confiy on ciscolz-2 3
-1 @ Cisco Test Routers 271672008 AM : Dowmload of Punming confiyg from ciscolZ-2 was successful. W
1 @ ciseo2-2 =/16/2008 AM : Starting Download of Startup config on eiscolZ-Z
/@ Foundry Test Routers a/16/2008 MM : Dowaload of Starctup config from ciscel2-2 was swecessful.
1@ Foundry-Test 2/16/2005 AM : Starting Dowmload of Running config om Foundry-Test
2/1le/Z00E MM : Dowmlead of Punning confiy from Foundry-Test was successful.
a/16/2008 MM : Starcing Dowmload of Starcup config on Foundry-Test
8/16/2005 M Dowmload of Startup config from Foundry-Test was successful.
=/16/2005 M : Starting Download of Bunning config om SW-APL
a/16/2008 M : Davmload of Runming config from SW-APL was successful.
8/16/2005 M Starting Dowmload of Startup config on SW-APL
B/1l6/Z005 AM : Dowmlead of Startup confiy from SW-APL was successful.
a/16/2008 MM : Starcing Dowmlead of Running config on SU-LPZ
8/16/2005 M Dowmload of Punming config from SW-APZ was successful.
a/16/2008 MM : Starcing Dowmlead of Starcup confiy om SU-APZ
&/16/2005 AM : Dowmload of Starcup config from SW-APZ was successful.
B/16/2008 AN Finished : New Job
L4
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Chapter 9: Settings

SolarWinds Cirrus Configuration Management has a large amount of
customizable settings. These settings range from how Nodes are listed, to how
buttons and toolbars are displayed. To access the Configuration Management

Settings, click the button, or select Settings from the File menu.

Node List

The Node List settings appear first in the list, and are used to determine how the
Nodes are grouped, and what properties are to be displayed in the Node List.

2 Configuration Management Settings El
Node List % Node List
Security
+ Global Macro Sellings The infoimation displayed in the Node List can be customized

+ Notification Defaults
Custom Properties
Reports Select the Properties that should be displayed in the list of Routers / Switches
Scheduled Jobs

Group the Routers/Switches by . | Node Group -

+ Node Details Window All Properties Selected Properties

Ping Window -| Node Details A~ Mode Mame

Node Monitoring Mode ID e E]
+ Search Configs Mode Mame
+ Configs Mode Group E]
+ Network IP Address
+ Macros SNMP Community String
+ Tools and Actions Comments
+ Advanced =| Discovered Properties

Reverse DNS b

Show all Configs for each Node in the Mode List
hd >

Cancel

By default, only the Node Name is displayed in the list, but additional fields can
be added such as IP Address, System Location, System Contact, and more.
Custom Properties can also be displayed in the Node List.

Automaticaly expand the Mode List to the | Nodes w | level

2
U For more information regarding Custom Properties, please refer to the Custom Properties
section in Chapter 3: Managing Nodes on page 28.

Adjusting the Show all Configs for each Node in the Node List slider will change
how many configuration files appear under each node. With the slider all the way
to the right, all configuration files will be displayed.

2
U Adjusting the slider to show less than all Configs will not delete any files from the database.

Use the last dropdown list to determine how to automatically expand the Node
List when Cirrus is opened.
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Security
2 Configuration Management Settings El
Node List & Security
Security
+ Global Macro Settings i .
+ Notification Defaults Application Security
Custom Properties Fieguire a password to use Cius Configuration b anagement
Reports
Scheduled Jobs Application . 4 [essssess
# Node Details Window AL
Ping Window Feenter Password

Node Monitoring

+ Search Configs

+ Configs

+ Netwark Hide / Encrypt Passwords

+ Macros

+ Tools and Actions [ Hide SHMP Commurity Strings

+ Advanced
[ Hide lagin Usermames [ Llsemames will not be displaped unless requested |

Encrypt Usemames in the database

[ Hide Passwords [ Passwords will be not be displayed unless requested )

Encrypt Passwords in the database

The Security category is used to determine how to protect the data stored within
Cirrus. To set a password to use Cirrus, check the box Require a password to use
Cirrus Configuration Management. Enter a password on both lines to ensure it is
typed correctly. In the Hide / Encrypt Passwords section, select the options needed
to secure the data in the Cirrus database.

When a password is set for Cirrus, each time the application is launched, the user
will be prompted to enter the password before being granted access to the
program.

SOLAIWINDY.NEC
MNetwork Management Tools

-
— .

7 CGRIWD

= Configuration Management
s

; Copyright @ 2005 SolarWinds Met. All rights reserved.

o~ — . .
( Application Password

2
U The Application Password is unique to each database. If Cirrus is installed on more than one
machine, if each installation is sharing the same database, the password will be the same on
each box.
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Global Macro Settings

The Global Macro settings are used to set the default Community String, Login
Information, and Transfer Protocol. When adding new Nodes, the default settings
will be used unless otherwise specified.

Community String

2 Configuration Management Settings

5

Node List
Security
Global Macro Settings
Community String
Login Information
Trarsfer Protocols
Notification Defaults
Custom Properties

Node Monitoring
Search Configs
Configs

Network

Macros

Tools and Actions
Advanced

3 Community String
SMMP Community stiings can be set at a global level for all Devices.

SHMP

SMHMP Cormmunity String | public + | ${BlobalConmmmunity}

Eeset all Devices to $iGlobalCommunit

Reports
Scheduled Jobs

+ Node Details Window Devices and Scripts can use the Global SNMP Commurity Sting by refering to the global macra
Ping Window ${GIohalCommurity}

You can stil overide the Global Settings for individual Devices by changing the Cammunity String of each
Device.

&

Enter the default SNMP Community String in the text box provided. To set all

Nodes in the Cirrus database to the new default SNMP Community string, click

Reset all devices to ${GlobalCommunity}.

Login Information

2 Configuration Management Settings

Node List

Security

Global Macro Settings
Community String
Login Information

Node Monitoring

#t Login Information
Login information can be set at a global level for all Devices.

Global Login | nfarmation

Transfer Protocols 5e name admin | %{Globallsemame}
+ Nuotification Defaults
Custom Properties Password adrin ${GlobalPassword}
Reports Enable Level 0 - ${GlobalEnableLevelt
Scheduled Jobs =
+ Node Details Window Enable Passward admin | 3{GlobaEnablePassword}
Ping Window

Reset al Devices bo use Global Login Settings

+ Search Configs
+ Configs Devices and Sciipts can use these Global Settings by refening to the global macios
+ Network HGlabalUsert amet, ${GlobalPassward}, $1GlebalE nableLev], and ${GlobalE nablePassword).
M
: T::Il:;nd Actions You can stil overide the Global Settings for individual Devices by changing the properties of each Device,
+ Advanced

&

Global Macro Settings
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Enter the default Login Information using the text boxes provided. To set all
Nodes in the Cirrus database to the new default Login Information, click Reset all
Devices to use Global Login Settings.

Transfer Protocols

3]

2 Configuration Management Settings

Node List st Transfer Protocols
Security
= Global Macro Settings The Command Exec and Config Transfer protocols can be set on a global level for all Devices.
Community String
Login Infarmation Global Cormmunications Protocols

Trarsfer Protocols
Notification Defaults
Custom Properties
Reports
Scheduled Jobs
Node Details Window
Ping Window
Mode Monitoring Devices and Scripts can use these Global Settings by refening to the global macios
#{GlobalE xecProtocal} and ${GlobalTransferProtocol}.

Execute Commands and Scripts using | TELNET « |protocol  ${GlobalExecProtocolt

5

Download # Upload Configs using TELMET » | protocol  ${GlobalTransferProtocolt

Beset all Devices to use Global Protocal Settings...

¥

Search Configs
Configs

Network

Macros

Tools and Actions
Advanced

*Y'ou can still ovenide the Global 5 ettings for individual Devices by changing the properties of each Device,

Enter the Global Communication Protocols using the text boxes provided. To set
all Nodes in the Cirrus database to the new Global Communication Protocols,
click Reset all Devices to use Global Protocol Settings.

Notification Defaults

The Notification Default settings are used to determine what email addresses and
servers to use when sending Job completion notifications.
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Email Defaults

%A Configuration Management Settings rz|
Node List st Email Defaults
Security
+ Global Macro Settings Ta save time, the default Email Maolification information can be entered here and will be placed in new
- Notification Defaults scheduled jobs automatically. These defaults can easily be overriden in the individual scheduled jobs.
Email Defauits Email Notification Defaults
SMTP Server
Custom Properties Fiznn e |Sulalwinds Configuration Mgmt ‘
Reports - "
Scheduled Jobs Fiply Address |Solalwmds@yourdomam.name ‘
+ Node Details Window Subject |So|a|winds.Net Canfiguration Management Job Completion Matification ‘
Ping Window
Node Monitoring
+ Search Configs Ta | ‘
+ Configs
+ Network e | ‘
+ Macros BCC | ‘
+ Tools and Actions
+ Advanced

Enter the From Name, Reply Address, and Subject lines in the text boxes
provided. Enter any default email address in the appropriate boxes.

Cancel

SMTP Server

2 Configuration Management Settings f'5_<

Node List #t SMTP Server

Security

Global Macro Settings To save time, the default SMTP Server information can be entered here and will be placed in new

= Motification Defaults scheduled jobs automatically. These defaults can easily be overiden in the individual scheduled jobs.
Ermnail Defaults
SMTF Server

Custom Properties

Reports

ST D SMTP Port Humber

Node Details Window

Ping Window D Usze SMTP Authentication

Node Monitoring SMTP Usemarme |SMTPUsemame |

Search Configs

Configs SMTP Passward |

Network

Macros

Tools and Actions

Advanced

+

Default SMTP Server Dptions

Hostname or Address of SMTP Server | SMTP.MyDarair Com |

+

CRCRCRCEEEE

Add the Hostname or IP Address of the email server for Cirrus to send email
messages to. Set the SMTP Port Number in the text box provided. Port 25 is the
default port for SMTP.

If the email server requires authentication, check the SMTP Authentication box and
enter a Username and Password.
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Custom Properties

2 Configuration Management Settings E|

Node List Custom Properties
Security

+ Global Macro Settings Custom Properties such as Building, Location, Asset Tag, etc can be added to the Configuration

+ Notification Defaults Management spstem. These Custom Properties are stored in the active Configuration Management
Custom Properties database
Reports
Scheduled Jobs Custam Properties:

+ Node Details Window Building
Ping Window Floor

Node Monitoring
+ Search Configs
+ Configs
+ Network
+ Macros
+ Tools and Actions
+ Advanced

“ Add New Property

Cirrus includes the ability to add Custom Properties to each Node. Custom
Properties are additional fields such as country, building, asset tag, serial number,
etc. that can be defined and stored in the Cirrus database.

Cirrus provides a collection of the most commonly utilized properties to choose
from, or new properties can be created. Once a custom property is defined, the
properties can be edited in the Node Details of each device.

Select a property from the drop-down list or type in a new property, and then click
the Add New Property button to create the Custom Property.

Once a Custom Property exists, the field will be displayed in Node Details. To
edit the Custom Properties, right-click on a node or group of nodes and click Edit
Selected Nodes or Edit Multiple Nodes. The new Custom Properties will be
displayed at the bottom of the Node Details.
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Reports

2 Configuration Management Settings

Node List

Security

Global Macro Settings
Notification Defaults
Custom Properties
Reports

Scheduled Jobs
Node Details Window
Ping Window

Node Monitoring
Search Configs
Configs

Network

Macros

+

+

5

Tools and Actions
Advanced

CECRCECECEE

Reports

The following reports are currently installed.

B i Modes

Community Strings for each Node
Dovwen Modes

Last Boot Time for each Device

Login information for each Device
Devices that do not respond to SMNMP
Redizcovery and Polling

Currert Responsze time of each Device
System Information of each Device

DODDRRODO

Report of &l Modes in the Configuration Management Database

Create a Mew Report ] [ Edit Selected Report

Delete Selected Reports

Cancel

The Reports category is used to create a new Report, edit an existing Report, or
delete a Report. To edit a Report, select the Report and click Edit Selected Report.
For details on how to edit a Report, please refer to Creating and Editing Reports in
Chapter 7: Reports on page 70.

Scheduled Jobs

2 Configuration Management Settings

Node List

Security

Global Macro Settings
Notification Defaults
Custom Properties
Reports

Scheduled Jobs
Node Details Window
Ping Window

Node Monitoring
Search Configs
Configs

Network

Macros

+

+

5

Tools and Actions
Advanced

CECRCECECEE

& Scheduled Jobs
The list of scheduled Jobs can be customized

All Fields Selected Fields

Job 1D Enabled
Job Mame Job Name
Jab Type [I] Status lcon
Jab Type lcon Statug

Joh Filenarme Job Type
Enabled Schedule
Status

Status lcon

Creator

Devices

Seript

Repart

Enmar Actions

Send Results

Commets

Scheduls

Last Run

Next Run

[k

The Scheduled Jobs category is used to specify which columns are displayed when
viewing the Scheduled Jobs list. Use the appropriate arrow buttons to add /
remove fields, and to adjust the order of the layout.
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Node Details Window

The Node Details Window settings are related to what is displayed when editing
device details.

Node Details

%A Configuration Management Settings &

Node List [¥ MNode Details
Security

Global Macro Settings

Notification Defaults Include an “ssigned Macros' column when ediing Nods details

Custom Properties

Reports

Scheduled Jobs

= Node Details Window
Node Details
Interfaces
Device Inventory

Ping Window

Node Monitoring

Search Configs

Configs

Network

Macros

5

5

The ‘Assigned Macros' column will show the actual values of any Mode details with
the Macros includsd.

Tools and Actions
Advanced

CRCRCEGEGEE

Check this box to display the Assigned Macros column in Node Details.

Cancel

Interfaces

2 Configuration Management Settings El
Node List [¥ Interfaces
Security

+

Global Macro Settings
Notification Defaults
Custom Properties
Reports

Scheduled Jobs

= Node Details Window
Mode Details Auto Refresh the Interface List every 30 seconds

Set the Refresh Interval used when “Auto Refresh iz enabled on the Interfaces tab of the
Modde Details window.

+

Interfaces F >
Device |nventory

Ping Window

Node Monitoring

Search Configs

Configs

Network

Macros

Tools and Actions

Advanced

Use this slider to stipulate how often the Interface List is updated automatically
when viewing Interface statistics on the Interfaces tab within Node Details.
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Device Inventory

%A Configuration Management Settings E|
Node List ~| K Device Inventory
Security
- Global Macro Settings Details about each device can be added to the database during D evice Inventory
Community String
Login nformation “w'hich items should be included in the [nventary 7
Transfer Protocols Standard
= Notification Defaults ARP ARP Tahle
Email Defaults Brridge Table Layer 2 Forwarding Tables
SMTP Server Entity MIE Physical and Logical Entities
Custom Froperties Intetfaces Extended information about Interfaces
Reports I Addresses IP &ddress Tables
Scheduled o] sctive Ports TCP and UDP Parts
= Node Details Window Cisco
Node Detail
s Detals Cisco Cards Cards in each router f switch
Interfaces
- Cisco COP Ciseo Discovery Protocol
Device |nventany ) ) )
Ping Window [ Cisco Chassiz Cizco chassis type serial number, memary, etc
Node Monitoring Cizco Flash Cizco Flash Details
= Search Configs Cisco Image Details about the running 105
Mode List Cisco Memory Pools hemaory Pool Allocations
= Configs
Config E ditor
Config Transfers
Config Comparisons -

The Device Inventory category is used to establish which statistics will be collected
when performing Inventory on Nodes.

Ping Window

2 Configuration Management Settings El
Node List ) Ping Window
Security
+ Global Macro Settings The list of fields and grauping within the Ping \Window can be customized,

Notification Defaults

+

Custom Properties Group the Routers/Switches by : | <naones i
Reports Select the Properties that should be displayed in the list of Routers / Switches
Scheduled Jobs
+ Node Details Window All Properties Sl Fiepeits
Ping Window = Node Details s Mode Mame
Node Monitoring Mode ID E] Response Time E]
+ Search Configs Maode Mame Response Emor
+ Configs Mode Group E]
+ Network IF Address
+ Macros SHNMP Commurity String
+ Tools and Actions Comments
+ Advanced = Discovered Properties
Reverse DNS
Rezponze Time
Responge Enor
Device Status
CRIMP | aval M

The Ping Window category is used to specify which columns are displayed when
viewing the Ping results. To group the Nodes listed in the Ping Window, use the
dropdown list at the top to select what to group the Nodes by. Use the
appropriate arrow buttons to add / remove fields, and to adjust the order of the
layout.
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Node Monitoring

2 Configuration Management Settings g‘
Node List @ Node Monitoring
Security

+ Global Macro Settings
# Notification Defaults
Custom Properties

Manitar the Lp/Dowin status and periodically Rediscaver each Node

Folling Parameters

Reports
Scheduled Jobs Poll each Node's Up/Down status even 2 minutes
+ Node Details Window S b
Ping Window
Node Monitoring taximumn Polls per secand 5 per second
+ Search Configs S b4
+ Configs
+ Network Rediscover each Mode every G0 minutes
+ Macros < ¥

+ Tools and Actions
+ Advanced
Play Gounds when Nodes go Lp or Down

The Node Monitoring category is used to establish if and how nodes are polled for
status. Check the box at the top to enable Node Status monitoring. Use the sliders
to specify how often each Node is polled, Maximum polls per second, and how
often each Node's details are rediscovered. To play sounds when a Node goes up
or down, check the Play Sounds when Nodes go Up or Down box.

Search Configs

%A Configuration Management Settings g\
Node List @ Node List
Security
+ Global Macro Settings The list of fields and grouping within the Search Configs Node List can be customized.
# Notification Defaults
Custom Properties Group the Routers/Switches by | <hones v
R t
5::::]:Ie e Select the Properties that should be displayedin the list of Routers / Suitches
+ Node Details Window All Properties Selected Properties
:::‘i‘ﬂ::;;in = Node Details ~ E] Mode Mame
- 8 MNode 1D Machine Type
+ Search Configs e +
+ Configs
MNode Group
+ Network
+ Macros IP Address )
+ Tools and Actions SNMP Commurity String
+ Advanced Fommente
= Discovered Properties
Reverse DNS
Response Time
Response Enor
T ~

The Search Configs category is used to specify which columns are displayed when
viewing the Search results. To group the Nodes listed in the Search Results
Window, use the dropdown list at the top to select what to group the Nodes by.
Use the appropriate arrow buttons to add / remove fields, and to adjust the order
of the layout.
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Configs

The Configs category is used to determine how configuration files are displayed
when editing, and how the files are archived.

Config Editor

%A Configuration Management Settings El
Node List i3 Config Editor
Security

5

Global Macro Settings
Notification Defaults

5

Custom Properties Config Editor Font

Reports

Scheduled Jobs Courier New, 2 point
+ Node Details Window

Ping Window

Node Monitoring

Search Configs

Configs
Canfig E ditor
Conlfig Transfers
Config Comparizons
Config Mirror

+ Network

+ Macros

+ Tools and Actions

+ Advanced

&

“when configs are edited, only retain the last revision

The Config Editor category is used to specify how the configuration files are
displayed when editing. Click the Select Font button to select the preferred font

style.

When saving changes to configuration files, only the last revision is saved by
default. Alternately, to save all revisions, uncheck the When configs are edited,
only retain the last revision box.
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Config Transfers

%A Configuration Management Settings El
HNode List % Config Transfers
Security

5

Global Macro Settings
Notification Defaults

5

Simultaneous Downloads/Uploads 25 Sessions
Custom Properties < >
Reports
Scheduled Jobs
+ Node Details Window
Ping Window

Node Monitoring
Search Configs
Configs
Canfig E ditor
Config Transfers
Config Comparizons
Config Mirror
+ Network
+ Macros
o
o

&

Tools and Actions
Advanced

Adjust this slider to set how many simultaneous downloads and uploads can be
executed.

Config Comparisons

2 Configuration Management Settings le
Node List 2] Config Comparisons
Security

+

Global Macro Settings
Notification Defaults
Custom Properties

‘when comparing two Configs, a Comparison Overview can be displayed that highlights the
differences in the two Canfigs.

+

Reports

Scheduled Jobs Show the Comparizon Overview when comparing Configs
+ Node Details Window : )

Ping Window .ﬂ— Pl solanwindsner - 547005 01:38 PM . Run 1 talsolareit

Node Monitoring

Search Configs

Configs
Config E ditor
Config Transfers
Config Comparisons
Canfig Mirar

+ Network

+ Macros

+ Tools and Actions

+ Advanced

¥

Check this box to show the Comparison Overview when comparing to
configuration files. The Comparison Overview scales to fit the size of the window
allowing for an overview of the entire comparison. Click anywhere on the

Cancel

Comparison Overview to jump to the associated section of the configs being
compared.
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Config Mirror
7] Configuration Management Settings El
HNode List % Config Mirror
Security
+ Global Macro Settings Downlnaded Device Configurations are always saved in the Router Management database

Notification Defaults
Custom Properties

5

Reports A minor copy of each Configuration can also be saved in a seperate text file.
Scheduled Jobs Save a copy of each Canfig ta the Config-trchive folder when it is downlaaded.
+ Node Details Window
Ping Window Miror Configs in the database to the Config &rchive directony
Node Monitoring Config-#rchive directory
+ Search Configs
= Configs C:4Pragram FileshS olatwinds\Configuration ManagementiConfig-archive E
Canfig E ditor
Config Transfers Usze the following template when naming the Configuration files
Config Comparisons ${ModeGroup\${Caption} {0 ate}\${Caption}-$ConfigT ppel. Config
Config Mirrar
+ Network
+ Macros { @ Expoit all Configs to the Config-irchive directary now ]
+ Tools and Actions

+ Advanced

The Config Mirror category is used to determine if and where mirror copies of
configuration files will be saved. Check the Save a copy of each Config to the
Config-Archive folder when it is downloaded box to enable Config Mirror copies.
Click the Ellipsis button next to the first text box to select a path to save the
configuration files to. In the second text box, create a folder name template to
organize the configs. Refer to Appendix C: Macros on page 145 for a full list of
macros that can be used to create a folder structure.

Click the Export all Configs to the Config-Archive directory now button to copy all
configs from the database to the mirror location.
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Network

The Network settings are used to determine timeout and retry settings.

ICMP Settings

2 Configuration Management Settings

Node List

Security

Global Macro Settings
Notification Defaults
Custom Properties
Reports

Scheduled Jobs
Node Details Window
Ping Window

Node Monitoring
Search Configs

+

+

5

¥

i ICMP Settings

Thesze settings apply to all ICMP packets zent by Configuration Management

ICHP Packet Timeout
<

D ata portion of ICMP packet
Configuration M anagement Yersion 8.0, 255

¥

Configs

- Network
ICHP Settings
SNMP Settings
Telnet Settings

+ Macros

Tools and Actions

+ Advanced

¥

ICMP Packets will timeout in 2500 millseconds
FS

40 bytes

Adjust the ICMP Packet Timeout slider to establish how long Cirrus waits before

determining an ICMP packet has been lost.

To change the Data portion of the ICMP packet, add or remove text from the text
box provide. As textis added or removed, the number of bytes included in the
packed is updated automatically.
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SNMP Settings

%A Configuration Management Settings El
Node List % SNMP Settings
Security

5

Global Macro Settings
Notification Defaults
Custom Properties
Reports
Scheduled Jobs
Node Details Window <
Ping Window
Node Monitoring SHMP Retries 2 1etries
Search Configs < >
Configs
Network

|ICHMP Settings

SMMP Settings

Telnet Settings
Macros

These settings apply to all SNMP packets sent by Configuration Management

5

SMMP Packet Timeout SMMP Packets will timeout in 2500 millizzconds
>

¥

&

5

=

Tools and Actions
Advanced

5

+

Adjust the SNMP Packet Timeout slider to establish how long Cirrus waits before
determining an SNMP packet was not received.

Adjust the SNMP Retries slider to determine how many times Cirrus will resend
the SNMP request.

Telnet Settings

2 Configuration Management Settings le
Node List O Telnet Settings
Security

+

Global Macro Settings
Notification Defaults
Custom Properties

+

Reports

Scheduled Jobs Telnet Connection Timeout 45 seconds
+ Node Details Window ki >

Ping Window

Node Monitoring
Search Configs
Configs
- Network
ICHMP Settings
SNMP Settings
Telnet Settings
Macros
Tools and Actions
+ Advanced

¥

¥

+

¥

Adjust the Telnet Connection Timeout slider to establish how long Cirrus waits
before timing out a Telnet connection.
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2 Configuration Management Settings le
Node List %z Custom Macros
Security
+ Global Macro Sellings ‘r'ou can create your own Global Macros and then wse them in Device properties, Scripts, Jobs, etc.
+ Notification De!aulls Global Macra Value
Custom Properties H{GlohalEnableLevel) i
ge:":sl PR HGlobalCommunity} public
5 dez [l)‘:laiI:\:indnw FGlobalUsername admin
Ping Window F{GlobalPassword} admin
Nul?e Monitoring FiGlobslEnablePassword}  admin
+ Search Configs F{GlobalExecProtocol} TELMET
+ Configs F{GlobalTransterProtocol}  TELMET
+ Network
+ Macros
+ Tools and Actions
+ Advanced
S5 Ad Mew Giobal Macra | | X Delete Selected Macros|

Additional Global Macros can be created to use with device properties, scripts,
Jobs and more. To edit a macro’s value, click in the Value area of the macro and
just start typing. To create a new macro, click the Add New Global Macro button.

Add New Macro

Enter a name for the new Macio

Give the macro a name and click OK to save the macro.

Tools and Actions

The Tools and Actions category is used to add or edit actions that can be accessed
from the tool bar or right-click menus.
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Tools

%A Configuration Management Settings

Security
Global Macro Settings
Notification Defaults

5

5

Node List Ed Tools

Mew netwarking taals can be easily added to extend your Configuration Management system.

Custom Properties @‘
Reports
Scheduled Jobs L]
+ Node Details Window
Ping Window D)
Node Monitoring
+ Search Configs =2
+ Configs Q
+ Network
+ Macios @
= Tools and Actions ﬁ
Todls I
Show Commands
4B @
B Browser
+ Advanced &
@l

IP Metwork Browse Selected Address ..
Bandwidth Gauges for selected Interface .
Graph Selected Statistic ...

Ping

Telnet ...

“wieb Brovwser ...

Internal Wb Browser

Currert Traffic: ..

‘wirelesss Clients ..

TraceRoute ..

IP Metvwork. Browser

CPU Load ...

1B Browser ...

~ Hew

Toals can be dragged out of this list and dropped on any Menu or
Toolbar

The Tools listed here appear in the right-click menu and in the Tools menu. To
remove a Tool, select the Tool from the list and click Delete. To edit a Tool, select
the Tool from the list and click Edit.

Manme [Tetnet..

Frogram [

|
ICJ

Macros can be used to pass information about the selected device to the external program.

Example . telnet.exe §{AgentIF}
${hgentIP} IP Address ${Community} SNMP Community String
§{SysHame} System Name
${Wendor} Wendor

§{Now} Current date and time

Custom properties can also be passed on the command line ta the external program
Example : SomeProgran.exe §{5ysName} §{Building}

Toolbar Image

B | Change Tookar Image | 16x16 bitmap, GIF, ar icon

To create a new Tool, click the New button and then give the Tool a name. Selecta
Program using the ellipsis button to the right of the Program text box. Click the
Change Toolbar Image button to select a different icon for the Tool. Check the Add
new tool to Tools menu box to include the new Tool in the right-click and menu list.
Click OK to save the changes.

Y
U Details on how to customize toolbars can be found in Appendix B: Custom Toolbars.

Tools and Actions
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Show Commands

%A Configuration Management Settings le
Node List Ed Show Commands
Security

5

Global Macro Settings
Notification Defaults

Mew router ‘show commands' can be added as hot buttans.

5

Custom Properties

EHl Show Yersion ... New
Reports
Scheduled Jobs Show Interfaces ...
+ Node Details Window Al Show COP Meighbors ...
Ping Window

Node Monitoring
Search Configs
Configs
Network
Macros
Tools and Actions
Todls
Show Commands
MiBs
1B Browiser
+ Advanced

DRCRCEEGEE

‘shaw commands' can be dragged ot of this list and dropped on any
tMenu or Toolbar ak. Caneel

The Show Commands listed here appear in the right-click menu and in the Show
menu. To remove a Show Command, select the command from the list and click
Delete. To edit a Show Command, select the command from the list and click Edit.

A Show Command §|

Mame |E how ECOF Neighbors .. |

Command |Sh0w cdp neighbors |

Image (..] 18416 bitmap. GIF, or icon

I ok l’ Cancel ]

Type in the execute command and click the ellipsis button to select a different icon
for the Show Command if necessary. Check the Add to Show menu box to include
the new Show Command in the right-click and menu list. Click OK to save the
changes.

<
U Details on how to customize toolbars can be found in Appendix B: Custom Toolbars.
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MIBs

7] Configuration Management Settings El
Node List El MIBs
Security
+ Global Macro Settings New MIB references can be added using Solatwinds extensive MIB databass

Notification Defaults

5

Custom Properties Systern [nfa . e Hew
Reports
Scheduled Jobs Interfaces Table ...
+ Node Details Window ARF Table ..
Ping Window Raute Table

Node Monitoring . .
Edit Interface Descriptions ..

L]
g
%
s
+ Search Configs R
+ Configs @ Running Software ...
+ Network
Installed Soft
+ Macios ? ristal e. . oftware
= Tools and Actions . |P Statistics ..
Tools %, ICMP Statistics ..
Show Commands " 5
MiBs . SNMP Statisites ..
MIE Browser %5 TCP Statistics
# Advanced %, UDP Statistics ...
T RMOM Ethemet Statistics ... i
MIB references can be dragged out of this list and dropped on any
e or Toolbar

The MIBs listed here appear in the right-click menu, the MIBs menu, and on the

toolbar when clicking the ®- button. To remove a MIB, select the MIB from the
list and click Delete. To edit a MIB, select the MIB from the list and click Edit.

%2 MIBs X
Hame [BARP Table .. |
MIE Name or 01D ‘HFC121S-MIB:\pNetToMediaTab\e v \ D

Enter a MIB name such as RFC-1213-MIB:ifTable, or enter a specific 0ID, such
as 1.3.6.1.2.1.1

Multiple MIBs can be viewed at the same time by separating them with '&"
OLD-CISCO-SYS-MIB:whyReload & OLD-CISCO-SYSTEM-MIB:romlid

A single QID and the next 15 0IDs after it can be viewed by adding a ‘& Mext 15°
afterthe MIB name such as OLD-CISCO-MEMORY-MIB:bufferElFree & Next 15
or

OLD-CISCO-MEMORY-MIB:bufferElFree & Next 6

Toobarlmage % | Change Toobarmage | 16x16 bitmap, GIF, or icon

The MIBs dialog is displayed where a new OID can be selected, and / or the name
of the MIB can be changed. Click the Change Toolbar Image button to select a
different icon for the MIB. Click OK to save the changes.

To create a new MIB, click the New button. Give the MIB a name and then type the
MIB Name or OID into the second text box. There is a dropdown list of the most
common used MIBs to choose from.
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Click the Change Toolbar Image button to select a different icon for the MIB. Check
the Add this new item to MIBs menu box to include the new MIB in the right-click
and toolbar list. Click OK to save the changes.

2
U Details on how to customize toolbars can be found in Appendix B: Custom Toolbars.

MIB Browser
%A Configuration Management Settings E|
Node List Edl MIB Browser
Security
+ Global Macro Settings
+ Motification Defaults Solarwfinds Configuration Management can use an intemal or external MIB Browser

Custom Properties
. MIE Browser selection

Reports

Scheduled Jobs (%) Use Intemal MIB Browser
+ Node Details Window Nat supported within DL25 release

Ping Window

Node Monitoring () Use Extemal MIB Browser
+ Search Configs Reguires installation of Solarw/inds Engineer's Edition Toolset
+ Configs
+ Network
+ Macios SMMP Yersion
= Tools and Actions

Toalz [T] Limit the intemnal MIB Braowser to use SNMP Yersion 1 only

Show Cammands Limiting the MIB Browser to SNMP Version 1 queries will comect some of

MiBs problems experienced with older SMMP devices. SMMP Version 1 is also
1B Browser rmuch slower than SNMP Yersion 2.

+ Advanced

Use this category to select either the Internal or External MIB Browser. To use the
External MIB Browser, a SolarWinds Engineer’s Edition toolset must be installed
on the same machine.

“ The Desktop version of Cirrus does not include the internal MIB Browser.

To limit the Internal MIB Browser to SNMP Version 1, check the box in the SNMP
Version section. Limiting the MIB Browser to SNMP Version 1 queries will correct
some of the problems experienced with older SNMP devices. However, SNMP
Version 1 is much slower than SNMP Version 2.

Advanced

The Advanced options are used to determine how Cirrus is displayed. The
Advanced Tabbed Interface allows the user to move tabs to different locations in
the application, as well as creating new horizontal or vertical tab groups. The
Advanced Tabbed Interface allows for considerably more complex displays.
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Application Style

%A Configuration Management Settings El
HNode List % Application Style
Security

5

Global Macro Settings
Notification Defaults
Custom Properties
Reports (&) Advanced Tabbed Interface
Scheduled Jobs
Node Details Window
Ping Window o o Sl b oo —_ F———
Node Monitoring V] A =EN Y P . 3 Jdume bs
Search Configs 5 quick staet | [ 1oe mhode B
Configs i
Network
Macios
Tools and Actions
Advanced

Application Style

Toalbars

Session Tracing

5

() Traditional Multiple Document Interface

¥

£ Canfigueation Mansgemont [Canfiguration Mansgsman

GGG

Choose either Traditional Multiple Document Interface or Advanced Tabbed Interface
for the display preference, and click OK to save the changes.

Toolbars
2 Configuration Management Settings PX|
Node List “% Toolbars
Security
+ Global Macro Settings Solartwfinds Configuration M anagement toolbars can be displaged using various styles.

Notification Defaults
Custom Properties
Reports Office 98
Scheduled Jobs
Node Details Window Office 2000
Ping Window
Node Monitoring Office =P
Search Configs

Configs Office 2003
Network

Macros

+

5

Tools and Actions
Advanced
Application Style
Toolbars
Session Tracing

DREGRGEEGREEE

The Toolbars category is used to select the style of toolbars to display. Simply click
the button of the preferred style.
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Session Tracing

%A Configuration Management Settings

+

¥

GGG

Node List
Security
Global Macro Settings
Notification Defaults
Custom Properties
Reports
Scheduled Jobs
Node Details Window
Ping Window
Node Monitoring
Search Configs
Configs
Network
Macros
Tools and Actions
Advanced
Application Style
Toolbars
Session Tracing

% Session Tracing
A log file of each telnet session can be generated while commincating with each Node.

[] Tum on Session Tracing

The Session Trace files will be placed in the
'C:\Program Files'S olarwinds\Configuration ManagementsSession-Trace' directary.

Session Tracing creates a log file of each telnet session and places the file in the
Configuration-Management\ Session-Trace folder. Check the Turn on Session
Tracing box to enable logging of Session Traces.
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The Database Manager can be used to perform queries, view database and table
details, export data, and edit database values. The Database Manager can also be
used to repair, compact, restore, or backup the database.

Getting Started

The Database Manager is opened from the Windows Start Menu: Start >
SolarWinds Network Performance Monitor > Database Utilities > SQL Database

Manager. The SolarWinds Database Manager opens to display a splash screen
depicted in the illustration that follows.

= SolarWinds Database Manager [EIE]

Ble D I: windows  Help

. -

(] ? (3) dOLAIWINDY.NET
Add Server  Refresh Help @Nn\mrkuimgamammms @
[FEISaL Semvers =

7 RYAN\SOLARWINDS muq\vina). Nco

Network Management Tools

Cirrus Configuration Management

SQL Database Manager

The Database Manager is used ta perform various administration tasks on your Configuration
Management database. Use the Database Manager to create database backups, detach or attach a
database, compact 3 database, schedule automatic database backups. The Database Manager can
also be used to easily extract data fram the Configuration Management database.

=) N add SaL Server | To get started, Add a SQL Server

The SQL Database Manager can be used on Microsoft SQL databases only. If your Configuration
Management database is @ Microsoft Access database, then you should use Microsoft Access
instead of the SQL Database Manager.

Ater adding a SQL Server o the list of managed servers, expand the SOL Sewer ta explore the
databases and tables. Right click on a database or table 1o create backups, compact an object, or
perform ther tasks.

Some of the features available in this release of Cirrus Configuration Management are

Scheduled configuration backup of all netwark devices @ ﬁ &
7

Compare Runring vs. Startup Configurations in reaktime

Make configuration changes to entire groups of devices at once

Compare any historical or current configurations of any twa devices
Compare the last downloaded configuration to the curent Runring or Startup configuration

Execute commands on multiple devices in batch mode

Detald Dovice Imrtory 8 T

The Splash Screen provides additional application information and presents a
collection of buttons that can be used to perform the software's most common
functions. This functionality is also available from the application menu and
toolbar.

Adding a Server

After installing Cirrus, the SQL server that is to be managed needs to be added to
the Database Manager application. To do this, select Add Server from the toolbar
(or select File > Add Server from the menu). The NetPerfMon Database Manager
dialog is displayed.
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T SQL Database Manager, §|
SOL Server ¥ ]| Connect to
(*) Login using Windows NT |ntegrated Security DSLE;S:?E

) Login using an SAL Server uzend and password

Select the SQL server from the drop down or enter the IP address of the SQL
Server machine. Use the radio buttons provided to select the login style. Use
Windows NT Integrated Security to automatically pass the windows user ID and
password to the SQL server, or select to use a separate SQL Server user ID and
password. Upon selecting the later option, the dialog will dynamically change to
display text boxes for entry of the SQL Server user ID and password. After
making the selections, click Connect to Database Server. The selected server and
associated databases will be displayed in the tree structure of the Database
Manager window.

Database Backup

It is very important to periodically back up the Cirrus database. To back up the
database, right-click on the database name in the tree of the Database Manager
window and choose Backup Database.

The Backup Database dialog prompts to enter a description of the database backup
and specify a path and filename for the backup file. Enter the requested
information, and give the backup a name, typically, C:\ Program
Files\SolarWinds\ Data \ ConfigurationManagement.BAK. Refer to Creating a
Database Maintenance Plan on page 113, for details on how to schedule a regular
database backup.

2
U Ensure that the target location for the database backup has sufficient available disk space.

Restore a Database

To restore a database from backup, open the Database Manager and select
Database > Restore Database (or right-click the SQL Server in the tree and select
Restore Database from the list). The Restore Database dialog is displayed. Use the
Ellipsis button to navigate to the location of the desired database, or enter a valid
SQL Backup database name and complete path in the text box. Typically
C:\Program Files\ SolarWinds\ Data \ ConfigurationManagement.BAK.
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g Use the Verify button to check that a valid SQL Backup database name has been specified.

= Restore Database on RYAN\SOLARWINDS &‘

Select Database file to Restore

| | D [ Wity ]

Restare Database as the following Database name

Restare Database into the following MDF and LOG files

Select Backup Set

#  Backup Date Type of Backup Server D escription

Upon selecting a database, the remaining fields will be auto-filled. The Database
Name field is populated with the name SQL will use to refer to the specified
database. The remaining two fields displayed are the data files (mdf is the data
file and .1df is the log file) that the database is comprised of. The values that are
provided can be changed, noting that SQL does not create directories; therefore
the specified path must already exist. Also keep in mind that a database that is
currently in use cannot be restored. Click OK to restore the selected database.

Compact a Database

The database compact procedure can be run to remove white space, reindex, and
shrink the database. SolarWinds recommends compacting the database as it
approaches 1.5 -1.6 GB in size, as the max size of the SQL Desktop Engine that
ships with Cirrus is 2GB. Database compaction can be performed within Database
Manager by selecting Database > Compact Database (or by right-clicking the
database name and selecting Compact Database from the list). Upon completion, a
dialog listing the size of the database before and after compaction is displayed.

ﬁ The same value displayed in the before and after size is an indicator that there is not enough
free space in the database to rearrange data. Use the Compact/Rebuild Indexes option on
individual tables in order to free up enough space for the database compaction to occur.

Compact Individual Tables

Individual tables within a database may be compacted from the Database
Manager application. Right-click on the desired table and select Compact/Rebuild
Indexes from the list. A dialog listing the before and after size of the table is
displayed upon completion. Click OK to close the dialog.
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View Database Details

Details pertaining to the selected database can be viewed in Database Manager by
right-clicking the database name and selecting Database Details from the list (or by
selecting Database - Database Details from the menu). The Database Details page
is displayed with the Properties tab open. SolarWinds recommends monitoring
the value in the Total Space Used field. When the database size approaches 1.5 or
1.6 GB, the Compact procedure outlined on page 111 should be run, as the
maximum size of the SQL Desktop Engine that ships with Cirrus is 2GB. The Last
Backup field should also be noted to ensure that a regular database maintenance
plan is being adhered to. If this field is blank, a backup of the database should be
created, and refer to Creating a Database Maintenance Plan on page 113.

View Table Details

Database Manager’s Table Details page is comprised of three tabs used to display the
table's property, column, and index information. View the Table Details by
selecting Table > Table Details from the menu (or by right-clicking the table name
in the tree and selecting Table Details from the list).

The Properties tab includes general statistics pertaining to the table size and
creation date. The Columns tab describes the columns in the table, the keys, and
field types, while the Indexes tab lists the indexes used within the table. The table
may also be queried by selecting the Query button included on the top of the
display. A default SQL statement is provided, as well as radio buttons for
displaying the data in read or read/write view. Special care should be taken while
editing database values as the integrity of the database could easily be
compromised.

Exporting Data

The data displayed in the query view of the Database Manager can be exported to
one of several formats. To export the query data, select File > Export > Export to *,
substituting the desired format for *. Available formats include: Comma
Delimited, Text, HTML, Excel, or PDF. The Select Fields dialog will be presented
prompting for the data fields to be included in the export. Upon selection, the Save
As dialog will be displayed. Navigate to the desired location, specify a name, and
click Save.

2
U The Export directly to Excel option saves the file with the .xls extension and opens the file in
Excel for immediate use. The Export to Excel option saves the file with the .xls extension.
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Editing Database Fields

Database fields may be edited within the Database Manager application from the
query view. Itis very important to exercise great care when editing database
values, as the integrity of the database could be jeopardized. To edit a field, right-
click on the desired table and select Query Table from the list. Use the provided
SQL statement or enter a custom statement in the display. Click the Refresh
button to display the query results in table view. Select the Read/Write radio
button included at the top of the display to enable the ability to edit the fields.

Detach a Database

The database can be detached in order to leave the data files (.mdf is the data file
and .1df is the log file) that the database is comprised of in tact. Detaching a
database removes the reference from the SQL Server allowing the files to be
moved to different locations safely. Open Database Manager and select Database
- Detach Database from the menu or right-click the database name and select
Detach Database from the list.

Y
U SolarWinds does not recommend using the Detach Database option to move a database to a
new SQL Server. Please use the Backup and Restore procedures described on page 110.

Creating a Database Maintenance Plan

A database maintenance plan can be created that will automatically compact and
backup the database on a scheduled basis. To create a database maintenance plan
for the Cirrus database, follow these steps:

1. InDatabase Manager, right-click on the database, and choose Database
Backup Schedule.

2. The Database Maintenance Wizard will start.

3. Select the frequency with which to run the backup, set the time for it to
run, and click Next.

4.  Select the check box to compact and shrink the database before the
backup (recommended).

5. Choose the location where the database backup files are to be created
and the backup reports stored. Click Finish to continue.

2
U SQL Server Agent must be running in order for the database maintenance plan to be executed.
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Using Enterprise Manager

If a licensed copy of SQL Server 2000 Standard or Enterprise Edition already
exists, Enterprise Manager can be used to maintain the Cirrus database instead of
the SolarWinds Database Manager. SolarWinds recommends contacting a DBA
and referencing the documentation that Microsoft provides on Enterprise
Manager for instructions on using it to manage a SQL 2000 database.

If a DBA is not available, and would still like to use Enterprise Manager to set up a
maintenance plan for the Cirrus database, follow these steps:

1. Open Enterprise Manager and select the SQL Server group in the left
pane.

2. From the menu, choose Action > New SQL Server Registration.

3. Click Next to begin the SQL Server Register Wizard. Next, choose the
Cirrus Server/Instance Name from the list and click Add. If the SQL
Server does not show up in the list, it can be entered manually.

4. Choose the type of authentication that will be used to connect to the
SQL server. Select the Server Group to which the SQL Server should
be added and click Finish.

5. Expand the items on the left until the Cirrus database is visible.
6. Right-click on the database and choose All Tasks > Maintenance Plan.

7. The Maintenance Plan Wizard will walk through building a
maintenance plan for the Cirrus database. Click Next to start the
wizard.

8.  Select the database to which the maintenance plan should apply and
click Next. In most cases, the only database that needs to be selected is
the Cirrus database (Configuration-Management).

9.  Configure the database backup schedule. It is recommended that the
database be backed up as a regular part of the maintenance plan and
that the integrity of the backup is checked when complete. Normally,
it is recommended that the backup job is run nightly. Click Next to
continue.

10. Configure the directory where the database backups should be stored.
Be sure to specify a location with sufficient free space. Also, be sure to
specify how long to keep the database backups in the Remove Files
Older Than section. Click Next to continue.
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11. Configure the transaction log backup. It is not normally necessary to
back up the transaction log as a part of the maintenance plan. Click
Next to continue.

12.  Configure the report to be generated during maintenance. These
reports are especially important if there is a problem. Be sure to
specify the length of time to keep reports in Delete Text Report Files
Older Than. Click Next to continue.

13. Configure the maintenance plan history. It is not typically necessary to
write a maintenance plan history. Click Next to continue.

14. Finally, choose a name for the maintenance plan and click Finish.

For additional help with using Microsoft's Enterprise Manager, please visit the
Microsoft Support Website at http://support.microsoft.com
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Chapter 11: Cirrus Scenarios

This chapter discusses several different scenarios that demonstrate how to use
Cirrus in different network environments.

Updating the Login Banner

Various situations will arise prompting a change to the Login Banner for a router,
switch, or firewall. With Cirrus, this can be performed on one Node, or even a
group of Nodes all at once.

To update the Login Banner for a Node or group of Nodes, a command script must
first be created. Itis always a good idea to backup the running config prior to
making any changes, so right-click on the Node or group of Nodes that are to be
updated, and click Download Configs. Click the Download button to download and
save the configuration files to the database.

Right-click on a Node or group of Nodes and select Execute Command Script to
open the Execute Script dialog.

%A Cirrus Configuration Management [SolarWinds]

Elle Edit Modes Configs Schedule Inwentory Reports Show MIBs Tools Windows Help

e = e O i MBI DB G EBOES L
@ Quick Skart )ﬁ conf t, no snmp-s... )ﬁ conf t, no banner... ‘ 4k X

Nade ] ks

-4 Cisco Aps Erecute Script ]Rasulls ] Db'

¥ Q) SWLAPY =

9 SW-AP2 Select the Modes to run this Command Script on © ﬁ

=@ Cisco Test Routers Node Command Exec

i @ Ciscol2-2 @ Sni-aP1 TELMET
=@ Foundry Test Routers & SW-ap2 TELMNET

2 Foundry-Test o

g

=

e

2.

3

z

o

[ E}.‘ Add Devices ] I ¥ Remove Devices ] [ E:_ Glouping] I Select Nodes Directly 2

Commmand Seript to Execute

conf t

no banner login

barner login “Unauthorized use of these systems is punishable by death™
exit

W mem

le l ﬁ SaveScriptl A

¥ Erecute Command Script [ﬂ Toad®

+ devices |Solarwinds

Ensure the Nodes that are to be updated are listed in the top window. If more
Nodes need to be added, click the Add Devices button.
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Type the command script that is to be executed or load an existing script by
clicking the Load Script button. Once satisfied with the command script, click the
Execute Command Script button.

#a Cirrus Configuration Management [SolarWinds]
Flle Edit Modes Configs Schedule Inwentory Repaorts Show MIBs Tools Windows Help
F A CENR(EF L RREXAL. BRIl OE&E G EOES

4k X%

@ Quick Skart ﬁ conf k, no banner... |

Made [E]]

-1 Cisco Aps Execute Scrint F\esul I

sseIppY puld

* @ SW-AP1
+ @ SW-AP2 [@ SaveResuts ¥ Qutline Yiew

=14 Cisco Test Routers
@ Cisco12-2 - SW-AP1 (206.231.4.156) -~
=@ Foundry Test Routers =l conft
2 Foundry-Test Enter configuration commands, one per line. End with CHTLIZ.
no banner login
= banner login *Unauthorized use of these systems is punishable by death®
banner login “Unauthorized use of these systems is punishable $n *Unauthorizedd use of these systems:

syaddiug 610D

exit
= wr mem
m
Building configuration ..
(K]
=l SW-AP2 (206.231.4.157)
=l conft
Enter configuration commands, one per line. End with CHTLAZ
no banner login
= banner login *Unauthorized use of these systems is punishable by death*
banner login “Unauthorized use of these systems is punishablin “Unauthorized use of these systems i
exit
= wr mem
Building configuration ..

+ devices | Solarwinds

The Results tab will be opened automatically and the results of the script will be
displayed as the output is received.

To verify the script was executed successfully, open a Telnet session to one of the
updated Nodes by selecting the Node in the Node List and clicking the @ button
on the toolbar. A new window with a command prompt Telnet session will be
opened displaying the new Login Banner.
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& aEs|
Eile Edit Modes Configs Schedule Inwentory Reports Show MIBs Tools ‘Windows Help

R =R O wal Il o@Eas ag BB
hode List a ~ll |

Mode % Telnet 206.231.4.156
-1{J Cisco Aps THEITEI G use of these systems is punishable by death

Uerification

s584ppy puld

= Cisco Test [ElUEE
9 Cizcol2-2
=1 Foundry Te
& Foundry-"

sjaddus oy

no ba login
=l banner login *Unauthorized use of these systems is punishable by death*
banner login “Unauthorized use of these systems is punishablin “Unauthorized use of these systems

exit
= wr mem
Building configuration ...

v

+ devices |Solarwinds

Telnet to the selected Node

Another way to verify the script was executed successfully is to download the

running config and compare it to the previous running config. Right-click on the
Node or group of Nodes and download the running configs again, and check the
box that says Compare to last Config Downloaded, then click the Download button.

When the download completes, a comparison window will open automatically,
and the change to the Login Banner will be highlighted in Yellow if it is different
than the previous Login Banner, or highlighted in Red and Green if there was no
Login Banner previously.

Scenario References

Chapter Section Page
Chapter 4: Managing Configs Downloading Configs 31
Chapter 4: Managing Configs Comparing Configs 34
Chapter 5: Command Scripts Executing Command Scripts 60
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Configuring an Automated Nightly Backup

One of the great features of Cirrus is the ability to schedule daily backups of
configuration files. SolarWinds has provided an Example Job with Cirrus that
downloads the configuration files for all Nodes in the database every night. This
Example Job can be modified to suit specific needs, or a new job can be created
from scratch. This Scenario will demonstrate how to create the Nightly Backup
Job from scratch.

To setup an automatic Nightly Backup for all Configs, select Create New Job from
the Schedule menu. Select Download Configs from Devices and then click Next .

@mﬂ\ﬂna}.rﬁf Configuration Management - New Job Wizard

Network Management Tools

Execule Command Script on Devices
= Download Configs from Devices
Upload Changes o Devices
Febaol Selected Devices
Fun Repart

Update Inventory

Export Configs

Execule Frogram

OF@oe

Cancel

Give the Job a name, click Next >, then enter the time of day and choose the Job
frequency, and then click Next .

@ SOLAIWINDY.NET

Configuration Management - New Job Wizard
@ Metwork Management Toals

‘When should this Job un 7

Scheduls Job Start Time
Daily - 10:00 P
Starting On Ending On
9/27/2005

Every |1 dayls]

Cancel

120 Configuring an Automated Nightly Backup



&3 Recycled Paper Chapter 11: Cirrus Scenarios

Enter the Windows User Information and then click Finish. The Edit Job dialog is
now displayed. On the Nodes tab, All Nodes is selected by default. If this Job is
only for a specific group of Nodes, click the All Nodes in the Database button to
specify a list of Nodes or a Selection Criteria. Select what types of configuration
files to download on the Download Config tab, and set any Notification actions on
the Notification tab. Click OK to save the changes.

%A Cirrus Configuration Management [SolarWinds]

Elle Edit Modes Configs Schedule Inwentory Reports Show MIBs Tools Windows Help
FAHCPON | F ot EXHA, R HEHE e EHCES
—_ @ Quick Skart % scheduled ans| 4k X
Nade ] ks
£ @ SA-AR Enabled  Job Name Status  Status Job Type Schedule ;?S'
£ @ SA-AP2 £110:00 PM every day 8
. i 7 i . 1 X
=@ Cisco Test Routers Mightly Config Backup @ Mever Ran  Download Configs from Devices starting 272005
9 Cizco12-2
=@ Foundry Test Routers
(& Foundry-Test g
=
e
2.
b=
3
z
7
£ ks
+ devices |Solarwinds

Scenario References
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Changing Community Strings on Several Routers

This Scenario shows how to replace the public read-only community string with a
new read-only community string on several routers at the same time.

To update the community string for a group of Nodes, a command script must
first be created. Itis always a good idea to backup the running config prior to
making any changes, so right-click on the group of Nodes that are to be updated,
and click Download Configs. Click the Download button to download and save the
configuration files to the database.

Right-click on a Node or group of Nodes and select Execute Command Script to
open the Execute Script dialog.
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%A Cirrus Configuration Management [SolarWinds]

Elle Edit Modes Configs Schedule Inwentory Reports Show MIBs Tools Windows Help

F AP CrRY Bl REXARS R Y OR88 Y ECES
st

Wz

I o @ @ Quick Skart )ﬁ conft, no snmp-s...| 4k X
I
g
+ (@ Cisco Aps Erecute Script ]Rasulls | =
+{J Cisco Test Routers =
. . @
+ (4 Foundry Test Routers Select the Nodes to nun this Command Seript on : i
Mok Command Exec /
@ -AP1 TELMET
& SWi-AP2 TELKET
& Ciscol2-2 TELRET é:
4 Founclry-Test TELMET =3
Fl
b=
3
@
o
[ E}.‘ Add Devices ] l ¥ Remove Devices ] [ E:_ Grouping ] I Select Nodes Directly ~

Commmand Seript to Execute

conf t

no samp-server commurnity public RO
snmp-server community 123@dm1n RO
exit

W mem

¥ Erecute Command Script [ﬂ Load Script ] l e SaveScriptl 2

+ devices |Solarwinds

Ensure the Nodes that are to be updated are listed in the top window. If more
Nodes need to be added, click the Add Devices button.

Type the command script that is to be executed or load an existing script by
clicking the Load Script button. Once satisfied with the command script, click the
Execute Command Script button.

The Results tab will be opened automatically and the results of the script will be
displayed as the output is received.

To verify the script was executed successfully, download the running config and
compare it to the previous running config. Right-click on the group of Nodes and
download the running configs again, and check the box that says Compare to last
Config Downloaded, then click the Download button.

When the download completes, a comparison window will open automatically,
and the change to the community string will be highlighted in Red and Green.

Scenario References
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Changing Wireless Settings on All Access Points

This Scenario shows how to make a change in a Wireless Access Point’s web
interface, and then push that same change to additional Access Points by
uploading only the changed lines in the configuration file.

It is always a good idea to backup the running config prior to making any
changes. To do this, right-click on the group of Access Points, and click Download
Configs. Click the Download button to download and save the configuration files
to the database.

To open an Access Point’s web interface, right-click on the Node in the Node List
and select Browse Node. Make the necessary changes in the web GUI, and then
close the browser tab.

#a(Cirrus Configuration Management [SolarWinds]
Ele Edt Modes Corfigs Schedule Invertory Reports Show MIBs Tools Windows Help

00 CCONa @y P REXAL. AR BES R EHOBe®-

) quickstart €] 5W-AP1 - Cisco 105 Series A. | gL
todk F
5@ cieo Aps A RGP (6] =
0 creon EEEY: Q) ;
¥ Sh-AP2 Address | http://206.231 4.156/ap_network-i_802-11_c. shtml v‘ @
= Cisco Test Routers =
@ ciscai22 Cisco Svsreus 1
= @ Foundry Test Routers M \
Fourdry-Test . . . . o
S 5 Cisco Aironet 1200 Series Access Point N
A RADIOD-802.11G = ] (] é‘
(g STATUS T; DETAILED STATUS T; SETTINGS TE CARRIER BUSY TEST W E;
Hostname sw-ap1 16:36:24 Tue Sep 27 2005
NETWORK INTERFACES. Network Interfaces: Radio0-802.11G Settings
[PLSNTEED Enable Radio: & Enable " Disable
FastEthernet
Radio0 802116 Current Status (Software Hardware): Enabled upft
Role in Radio Network:  Access Paint Root (Fallback to Radio Island)
(Fallback mode upon loss & Access Paint Root (Fallback to Radio Shutdown)

of Ethemet connection,
2  Access Paint Rot (Fallaack to Repeater)

 Soanner
 Repeater
 Warkgroup Bridge

Data Rates: Best Range BestThioughput | Defaut |
1.0Mb/sec & Require  Enable © Disable
20Mbfsec @ Require © Enable © Disable
5.5Mbfsse @ Require  Enable © Disable
“B.OMb/sec  Require  Enable © Disable
*9.0Mb/sec © Reguire  Enable © Disable
41 Mhinne @ Mam v  Canbin  Pinnbia ™

Done
4 devices [Solarwinds

Next, download the new running config and compare it to the previous running
config. Right-click on the Node and download the running config again, and be
sure to check the box that says Compare to last Config Downloaded, then click the
Download button.

When the download completes, a comparison window will open automatically,
and the change to the configuration will be highlighted in Yellow if it is different
than the previous configuration, or highlighted in Red and Green if the setting did
not exist previously.
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Highlight the line(s) that has changed, right-click and select Create Snippet from
Selection. A new Config Snippet is created and added to the list of Config
Snippets. Open the Config Snippets window by clicking on the Config Snippets tab
located on the right side of the application by default.

Right-click on the Snippet and click Upload to Devices. Ensure the Nodes that are
to be updated are listed here. If more Nodes need to be added, click the Add
Devices button.

#a Upload Config... E@@

Upload Configs to the following Devices :

Nade
-1 Cisco Aps
@ SrLapt
@ srearz

(B addDevices | [ % Remove Devices | [ & Grouping

Additional actions after upload
‘wérite Config to MYRAM
[] Reboot Device

I Lreate Upload Script H Cancel l

Click the Create Upload Script button to display the Execute Script dialog. Click the
Execute Command Script button to upload the change to the remaining Access
Points.

The Results tab will be opened automatically and the results of the script will be
displayed as the output is received.

Once the script has finished executing, download the new running configs from all
the updated Access Points to add the new configuration files to the Cirrus
database.

Scenario References
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Chapter 4: Managing Configs Downloading Configs 31
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Chapter 4: Managing Configs Uploading a Config Snippet 47
Chapter 5: Command Scripts Executing Command Scripts 60
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Changing an Interface’s Description

To update an Interface’s description for a Node or group of Nodes, a command
script must first be created. It is always a good idea to backup the running config
prior to making any changes, so right-click on the Node or group of Nodes that are
to be updated, and click Download Configs. Click the Download button to
download and save the configuration files to the database.

Right-click on a Node or group of Nodes and select Execute Command Script to
open the Execute Script dialog.

%A Cirrus Configuration Management [test]

Eile Edit Modes Configs Schedule Inwentory Reports Show MIBs Tools ‘Windows Help
F AFEOEN S F oy B AL BWBE. DBEL G BOES
N‘:'d' i @ Quick Skart )ﬁ conft, interlace...| 4k X
Mode al
-1 (4 Cisco APs Execute Script ]Rasulls ] é
& Dw-aP1 9
@ Swi-ap2 Select the Modes to rn this Command Script on 3
-1 @ Cisco Test Routers e &
+ 14 Ciscol2-2 Node Pratocal
- Foundry Test Routers @ Cisconz-2
& Foundry-Test
[ E}.‘ Add Devices ] l ¥ Remove Devices ] [ E:_ Glouping] I Select Nodes Directly ~
Command Seript to Execute
conf t
interface ethemet 0
no description
description Link to Upstairs Lab
exit
it
Wi mem
| Eecuds Command Scrip (D oo sorpt | [ T Sevesoit] 4
Mode List | Find Address

Ensure the Nodes that are to be updated are listed in the top window. If more
Nodes need to be added, click the Add Devices button.

Type the command script that is to be executed or load an existing script by
clicking the Load Script button. Once satisfied with the command script, click the

Execute Command Script button.
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%A Cirrus Configuration Management [test]

Elle Edit Modes Configs Schedule Inwentory Reports Show MIBs Tools Windows Help

FRABCOENLEF - BREXALS. WY, DAL R ECES

Wz

@) cuickstart @ conft, interlace...| g2
Mode al
-1 @ Cisco APs Excute Script I =
@ Dwi-aP1 )
@ Sweap2 V¥ Dutline View gv
- (4 Cisco Test Routers i3
J Cisco12-2 - Cisco'l22 {206.231.5.2)
- {4 Foundry Test Routers = conft
4 Foundry-Test Enter configuration commands, one per line. End with CMTLIZ.
interface ethernet 0
ne deseri

description Link to Upstairs Lab
exit

Mode List | Find Address

The Results tab will be opened automatically and the results of the script will be
displayed as the output is received.

To verify the script was executed successfully, right-click on the Node in the Node
List and select Edit Selected Nodes. Click the Interfaces tab and then select Interface
! Port Configuration and then click the Refresh button to display the Interfaces
along with their Interface Descriptions.

A Cirrus Configuration Management [test]
Flle Edit Modes Configs Schedule Inwentory Repaorts Show MIBs Tools Windows Help

F A CENGEF - RREXAL, @ D8 G EOES

@ Quick Skart ﬁ conft, interface,.. & Ciscol2-2 ‘ 4D 23
Macle é\
B G;iz;: ::18 (J Ciscolz2 [ % Actions I [ EH Show ] l & Mies ] l & Tools ] &
L u
El
G?’ SW?P; - E] Device Detals  §  Interfaces l@ Configuration History 1 @ Inwertary I ﬁ
= isco Test Routers o
Q? Cisclm 2T-25t e Interface Details | Interface / Port Corfiguration [ Auto Refresh
e oundry Test Routers
@ Foundry-Test ~
Index  Interface Alias Type Type
1 BRIO anothing test Link Access Protocol
2 BRID:1 = .
3 BRI0:2 = e
4 Ethernetd Link to Upstairs Lak T[] Ethermet
5 Seriald & Frame Relay
6 Seriall Physical Interface for Frame Relay Connection <O Frame Relay
7 Nulld P Other
] Loophackl loopy43 ] Loophack
El Seriald. 101 <2 Frame Relay
10 Seriall 201 &0 Frame Relay
1 BRID-Physical anothing test IS |SDM ST Interface
12 BRI0-Signaling anathing test 150N ISDN and X 25
13 BRIO:1 -Bearer Channel ds Digital Signal Level 0 —
14 BRIC:2-Bearer Channel ds0  Dicital Signal Level 0 ¥
L3 | >
Mode List | Find Address

Another way to verify the script was executed successfully is to download the
running config and compare it to the previous running config. Right-click on the
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Node or group of Nodes and download the running configs again, and check the

box that says Compare to last Config Downloaded, then click the Download button.

When the download completes, a comparison window will open automatically,
and the change to the Interface Description will be highlighted in Yellow if it is

different than the previous Interface Description, or highlighted in Red and Green
if there was no Interface Description previously.

%A Cirrus Configuration Management [test]

Elle Edit Modes Configs Schedule Inwentory Reports Show MIBs Tools Windows Help
H& B0 S0 ., ctbBXAsd. @Y. I@as b ESE
@ Quick Skart !l Compare ‘ 4k X
Mode al
=1 (J Cisco APs Cisco12-2 - 9/28/2005 11:50 AM - Running Cisco12-2 - 9/28/2005 11:52 AM - Running | é,
& SWi-AP1 | | w
@ n-AP2 ip multicast-routing ip multicast-routing ﬁ
- (4 Cisco Test Routers 1 1 e
-4 Cisco12-2 | |
[@) arear005 11:50 , ,
[@) 92005 11:52 . .
-1 (4 Foundry Test Routers B B
. interface Loophack0 interface Loophack0
4 Foundry-Test .. ..
description loopy43 description loopy43
ip address 216.241.5129 255.255.255.255 | ip address 216.241.5129 255.255.255.255
1 1
interface Ethernet0 interface EthernetQ
description Link to Test Lab | description Link to Upstairs Lab
ip address 216.241.5.2 255.255.255.128 ip address 216.241.5.2 255.255.255.128
ip load-sharing per-packet ip load-sharing per-packet
ip pirm sparse-dense-mode ip pir sparse-dense-mode
ip route-cache same-interface ip route-cache same-interface
1 1
interface Serialo interface Serialo
bandwidth fid bandwidth fid
noip address noip address
encapsulation frame-relay encapsulation frame-relay
Mode List | Find Address . . )
.
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IOS and Firmware Upgrades

I0S images can be uploaded using Cirrus’s internal scripting engine. These image
files can be transferred via TFTP, FTP, HTTP, or any other transfer protocol.

“ Because managing IOS images can be very comple, it is recommend that the user follow the
upgrade guidelines outlined by the hardware manufacturer.

For this example, the SolarWinds TFTP Server (included with Cirrus) will be used
to transfer the IOS image to the router. The TFTP Server must be running and
configured to send and receive files. Also, the IOS image file must reside in the
TFTP Root Directory.

To push an IOS image to a router, a command script must first be created. Itis
always a good idea to backup the running config prior to running any scripts, so
right-click on the Node that is to be updated, and click Download Configs. Click the
Download button to download and save the configuration to the database.

Right-click on the router and select Execute Command Script to open the Execute
Script dialog.

A Cirrus Configuration Management [ConfigurationManagement]

Fle Edt Modes Configs Schedule Inventory Reports Show MIBs Tools Windows Help
G o4Ax BN e FlEclbBXAR Gl 9EE8 QG ECEe®-
@) quickstart ‘B copy titp flash, . | d b B
Node [H]
= Cisco Aps Execute Script IResuns ]
= @ SH-aR1
@ SW-aP2 Select the Modes ta run this Command Seript on
£ €@ Cisco Tast Routers Node Commanc Exec
gl EhEElad] @ Ciscor2-1 TELNET
+ € Ciscol 2-2
= Foundry Test Routers
%) @ Foundry-Test
=1 & Juniper Test Routers
® @ Juriper-Test
5% addDevices | [ % RemoveDevices | [ B Grouping SelectNodes Directly =
Command Seript to Execute : btore Irfomalion on Scrpts and Macias
capy tfp flash
2500111239 bin
1010217
v
%8 Evecute Command Seript T Load Seript Th SaveScipt | &
Mode ... | Confi... Find ...
£} |7 devices | ConfigurationManagement

Ensure the Nodes that are to be updated are listed in the top window. If more
Nodes need to be added, click the Add Devices button.

Type the command script that is to be executed. The script should mirror
commands entered when manually uploading an IOS image using the command
prompt. For example, when uploading an IOS image via a TELNET session, the
prompt requires the user to enter “y” to confirm the transfer. Add one line to the
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script that simply has “y” (without quotes) with a carriage return (ENTER key) at
the end of the line. Once satisfied with the command script, click the Execute
Command Script button.

g A previously saved script can be loaded by clicking the Load Script button.

The Results tab will be opened automatically and the outcome of the script will be
displayed as the output is received.

%A Cirrus Configuration Management [ConfigurationManagement]

Fie Edit Modes Configs Schedule Inverkory Reports Show MIBs Tools Windows Help
@ 'Zm BT @ L w4 GhE. BRI DEO8 HY EOBSeB-

@ quikstat 8 copy flash thtp, . | 4%

Execute Script Resuls \

[@ SaveResuls I iing View

=@ Cisco Test Routers

+ @ Cisoon21 Ciscol2-1 (10.10.4.18)
# @ Ciscol2-2 copx tftp flash
62500-1-1.123-9a bin
@ Foundry TestRowters. || |qpurae eilenane (17 2500-i-L.123-9a.bin
@ Foundry-Test 1010 2. 17
=1 Juniper Test Routers sddress or name of remote host (17 10.10.2.17

# € driper-Test

Destination filename [c2500-i-1.123-9a binl?

12501544 bytes copied in 333.08% secs (36368 bytes/sec)

Wade .., |Confi... Find ..,

Z% |7 devices | ConfigurationManagement:

Y

U This task can be scheduled to run at a later time/date. Save the script and then refer to Chapter
8: Scheduling Tasks for information on how to schedule a Job to Execute a Command Script.
When creating the Job, load the script from the saved file.
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Appendix A: Software License
Key

During installation, a window with the Install Software License Key screen
(illustrated below) will be displayed prompting for the user’s name, E-mail
address, phone number, Customer ID, and Password. If this is the case, follow the
instructions below. Once the software has been registered, proceed with the
installation.

@, SolarWinds Network Management Tools @\

Wi JIET
@ﬁ?l.é:! il )n:‘t

« Man n

Install Software License Key
“Vour Name |
E-Mail ddress
Phone Mumber

“four Customer 1D and Password were E-Mailed to you when
yau purchased a icense.

Customer [D

Password

Skip This and Enter

Software License Key Maw Continue

Cancel |

Cirrus Configuration Management V2 Enterprise DLX

Option 1 - Internet Connection: If the computer Cirrus is installed on is
connected to the Internet and not behind a proxy server, enter the information on
the Install Software License Key screen and click Continue. The SolarWinds license
registration server will issue a license key that will allow Cirrus to operate.

@, SolarWinds Network Management Tools E‘

Wi -
@:0uvme

ment Tools

Your Software License Key is Installed !

Cirrus Configuration Management V2 Enterprise DLX

Option 2 - No Internet Connection: If the computer Cirrus is installed on is not
connected to the Internet, the system will be unable to be authenticated on
SolarWinds' license registration server. Click the Skip This and Enter Software
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License Key Now button on the Install Software License Key screen. The following
screen will be displayed.

@, SolarWinds Network Management Tools g\

Wi NET
@?Ohﬁh ..nm NET

ement Tools

Install Software License Key

You will need to lagon to - http: //5 olarwinds. Net/Keys using any
weh brawser in order to generate a Software License Key.

The Computer Mame and Software Serial Number will need to be
pravided in order to obtain a Software Licerse Key.

Computer Name |WIN-XP-SP2-TEST
Software Serial

Murnber SN-QB-R4DK -ZVER-64WN -PL33-G992

Enter Software License Key ...

Continue Cancel

Cirrus Configuration Management V2 Enterprise DLX

A license must be obtained using a computer that is connected to the Internet.
Login to the customer area of the SolarWinds website at
http://solarwinds.net/Keys, and then click Software Keys from the Customer Area
menu. Choose the product that needs a key, and follow the instructions on the
page to obtain a key. The key can then be entered in the Enter Software License
Key... text box. Click Continue to complete the Software License Key installation.

@, SolarWinds Network Management Tools

Wi NET
@)OL‘F iND3.NET

# Network Management Tools

Your Software License Key is Installed !

Cirrus Configuration Management V2 Enterprise DLX
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Appendix B: Custom Toolbars

The toolbars and menus can be customized to meet individual needs. To
customize the toolbars or menus, right-click anywhere on the toolbar at the top of
the application and select Customize.

A Cirrus Configuration Management [Config-Mgmt]

File Edit Wodes Corfigs Schedule Invertory Reports Show MIBs Tools Windows Help

F B DD % L TRy AR ¥ HEE8 R EOCEed-
] ain TaclEar
N n
@ Edit Toolbar Sl ): o
= @ Cisco Access Points Tools Toobar — 2
G SW-ART Search Toolbar ﬁgigg&nro:ot E
+ 0 SaP2 5
= @ Cisco Test Routers o iTschay &
+ J Cisot 2-1 Customize, .. nd r H
S ranas Tostremare _@.m_w_-onflguratlon Management V2
@ Faundry-Test Enterprise DLX -
Welcome to SolarWinds Cirrus é{
Configuration Management. &

— et SolarWinds Cirrus Configuration Management
provides a guick and eficient method of managing the
configurations of network devices Routers,
Switches, WPN Concentrators, Wireless Access
Puoints, Firewalls, etc

Simply select a device and, click the right mouse
button ... the device's configuration is downloaded in
in real time via TELMET or SSH1. All downloaded
configurations are archived to a central database for
versioning, review, and easy comparison

Get started by Adding or Importing Metwark Devices.
*G  Add Devices Once youe added a Network Devices, right-click on it
to download it's configuration, execute command

scripts, update it's Inventary, etc

Customize...

The Configuration Management Customization dialog is displayed with five tabs;
Toolbars, Commands, Show Commands, MIBs, Tools, and Options.
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Toolbars Tab

£

7A Configuration Management Customization

'"Tﬁélb'é}sﬂ commands | mBs | Show commands | Tools | options |
Toolbars:
Hew
in ToolBar
Edit Toolbar
Tools Toolbar
Search Toolbar
[Tinventom Toolbar

Reset

Fieset &ll
Toolbars and
Menus

This tab is used to determine which toolbars will be displayed. Also, toolbars can
be created, edited or deleted.

To stretch a toolbar across the entire window, select the toolbar from the list and
check the Stretch Toolbar box.

To reset an individual toolbar to its original state, select the toolbar from the list
and then click the Reset button.

Click the Reset All Toolbars and Menus button to restore every toolbar and menu to
its original state.

To create a new toolbar, click the New button and then give the toolbar a name.

An empty toolbar will be added. Add commands, MIBs, Show Commands, and
Tools as needed. Refer to each section in this Appendix for specific instructions on
how to add actions and tools to the new toolbar.

Commands Tab

The Commands tab is used to add commands to a toolbar or menu.
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7A Configuration Management Customization &‘

Tookars  Commands I wiss | Show Commanss | Tools | Gptions |

To add a command to a Menu or Toolbar: select a category and drag the command
out of this window onto the Menu or Toalbar.

Categories: Commands:

Menus A | D Mew Configuriation Management Datab.
General =

5 DpenDasase
Print £ Close Database
Edit o

B 2K Startup Wizard
Modes & Import Devices
Configs B

Cortig Srippets #[8] Publish to'web ..
Schedule

Reports

Inventory

Show Commands bl

Open Database ...

For example, there is no Open Database option in the default File menu. To add it,
select the File Category on the left side and then drag the Command Open
Database to a location on the File menu.

File | Edk Modes Configs Schedule Inventory Reports Show MIBs Tools Windows Help
[ Wew Corfiguration Management Database ... |% E ¥ dh ﬁ' o @. B o W@ ﬂj @ Q @ @ @ |§| & .v E
L BN Startup Wizatd ... = s
= o
% Import Devicss .. bn Management Customization E‘ A5
Expart 3 &
ands I wBs | Show Commands | Tools | Gptians | E
Send T 3 B
N ind to a Menu or Toolbar: select a category and drag the command &
8 Publishto Web ... onta the Menu or Tookbar
&) Prink Preview ... Commands: ment V2
& print... #| |1 MNew Configuration Management D atab.
o
Bl Settings ... | ] = OpenDatabase ... =
= | § l inds Cirrus ml =
EF Customize Menus and Toolbars ... £ Close Database B
A Stantup Wizsrd hgement. @
| = A
Z Import Devices ... .
Configs N ) iration Management
Config Srippets *8] Publish toWeb.. It method of managing the
Schedule ices ... Routers,
Reparts rs, Wireless Access
Invertary
Show Commands >
Open Database ... click the right mouse
uration is downloaded in
SH1. Al downloaded
o a central database for
cormparison,
Tel stared by A0ding or mporting Metwork Devices:
5 Add Devices Onece youe added a Network Devices, right-click on it
to download it's configuration, xecute command
scripts, update it's Inventory, etc.
v

A black divider bar will show up between the menu items as the mouse cursor
moves up and down the menu. Place the divider bar between New Configuration
Management Database and Startup Wizard and release the mouse button. The Open
Database Command now appears in the File menu.
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File | Edk Modes Configs Schedule Inventory Reports Show MIBs Tools Windows Help
[ Wew Corfiguration Management Database ... |% E ¥ dh ﬁ' o @. B j{ i o W@ ﬂj @ Q @ @ @ |§| & .v E
1 Ey Open Database ... oy
£ Startup Wizard ... —— o
bn Management Customization X A5
& Import Devices ... &
ands I wBs | Show Commands | Tools | Gptians | g
Export == = b
ind to a Menu or Toolbar: select a category and drag the command &
endiinly ¥ W onto the Menu or Tookbar
¥30 Pubihto Web . Commands: ment V2
&) Print Praview ... #| |1 MNew Configuration Management D atab.
o
G Pt — [ OpenDatabase.. | 3
L A 9=
Settings ... £ Close Database inds Clr:us g
& agement. @
EF Customize Menus and Toolbars ... BN Startup Wizard g
& Import Devices ... :
0 ex B X iration Management
Config Srippets *8] Publish toWeb.. It method of managing the
Schedule ices ... Routers,
Reparts rs, Wireless Access
Invertary
Show Commands >
Open Database ... click the right mouse
uration is downloaded in
SH1. Al downloaded
o a central database for
cormparison,
Tel stared by A0ding or mporting Metwork Devices:
+ Onece youe added a Network Devices, right-click on it
RIS to download it's configuration, xecute command
scripts, update it's Inventory, etc.
v

MIBs Tab

#A Configuration Manageme ustomization

MiBs

Toolbars 1 Commands | Showe Commands 1 Tools I Qptions 1
MIBs:

Add/Edit MIBs o] Hew

System Info ...
Interfaces Table ..
ARP Table

Froute Table .
|P Famwarding Table ...

Edit Interface Descriptions

Runing Software

Installed Software .

IP Statistics .

ICMP Statistic:s

SMHMP Statisites ...

TCP Statistics ... bt

ER O N

MIBs can be dragged out of this list and dropped on any Menu or Toolbar

The MIBs listed here appear in the right-click menu, the MIBs menu, and on the

toolbar when clicking the @ button. Toremovea MIB, select the MIB from the
list and click Delete. To edit a MIB, select the MIB from the list and click Edit.
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Fle Edit Wodes Corfigs Schedule Inwentory Reports Show by
G RECPDD % s o g Name B4R Table.. |
! RFC1213-MIB:ipMatT ot ediaT able v =
Node List * %[ @ ok start MIE Name or DI | p 1)
Hade: . o
= @ Cisco Access Points </Lon ~ 0] | Enter a MIB name such as RFC-1213-MIB:ifTable, or enter a specific 01D, such [ E"
+ @ SWi-aP1 TEmharS} commands M| | 83 1.3.6.1.2.1.1 g
. a
G Si-aP2 MBS 3
= @ Cisco Test Routers Add/Edi MBS Multiple MIBs can he viewed atthe same time by separating them with '8 -
@ Cisco12-1 " OLD-CISCO-SYS-MB:whyReload & OLD-CISCO-SYSTEM-MIB:romid
142 Foundry Test Routers M System Info
# @ Foundry-Test
@ g Interfaces Table A single OID and the next 15 0IDs after it can be viewed by adding a '& Next 15' o
5
"/’J ARP Table .. after the MIB name such as OLD-CISCO-MEMORY-MIB:bufferElFree & Next 15 LS
4 Route Table ar %
% 1P Fonwsreling Tabls| | OLD-CISCO-MEMORY MIB:buiferEIFr e & Next 6 &
&
% EditInterface Desci
G, Running Saftware . Toobar Inage %  |_Change Toolbar Image | 18416 bitmap. GIF. or icon
@ Installed Software
2z
%, P Statistics
% ICHP Statvics ..
% SNMP Statisitcs . click the right mouse
4 e uration is downloaded in
SRR lalscs v SHI. All downloaded
MIBs can be dragged out of this list and dropped on any Menu or Toolbar 0 a central database for
comparison
Gl stared by Adding or mporting Metwork Devices
5 Add Devices Onece youe added a Network Devices, right-click on it
to download it's configuration, xecute command
scripts, update it's Inventory, etc.
v

The MIBs dialog is displayed where a new OID can be selected, and / or the name
of the MIB can be changed. Click the Change Toolbar Image button to select a
different icon for the MIB. Click OK to save the changes.

To create a new MIB, click the New button. Give the MIB a name and then type the
MIB Name or OID into the second text box. There is a dropdown list of the most
common used MIBs to choose from.

Mame [New MIB ‘
MIB Name or 0ID | v

Enter a MIB narme such as RFC-1213-MIB:ifTable, or enter 2 specific 0ID, such
as 1.3.6.1.2.1.1

Multiple MIBs can be viewed atthe same time by separating thern with '&"
OLD-CISCO-SYS-MIB:whyReload & OLD-CISCO-SYSTEM-MIB:romld

A zingle 01D and the next 15 OIDs after it can he viewed by adding a '& Mext 15"
after the MIB name such as OLD-CISCO-MEMORY-MIB:bufferElFree & Next 15
or

OLD-CISCO-MEMORY-MIB:bufferElFree & Next 6

Toalbar Image £ Change Toolbar Image | 16x16 bitmap. GIF. or icon

Add this nev item to MIBs menu

Click the Change Toolbar Image button to select a different icon for the MIB. Check
the Add this new item to MIBs menu box to include the new MIB in the right-click
and toolbar list. Click OK to save the changes.
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Show Commands Tab

7A Configuration Management Customization E

Toolbars 1 gnmmands] MiBs | Show Commands ;

1 Toots | options |

Show Commands:

Add/Edit Show Commands ... MNew

Show Version

Show Interfaces
Show COP Neighbars ...

Show Buffers ...

Show Processes CPL
Show DHCP Servers ..
Show Logging ..

Show IP Traffic

EEEEEEEE

Show commands can be dragged out of this list and dropped on any Menu or Toolbar

The Show Commands listed here appear in the right-click menu and in the Show
menu. To remove a Show Command, select the command from the list and click
Delete. To edit a Show Command, select the command from the list and click Edit.

Fle Edit Modes Corfigs Sthedule Inventory Reports Show MIBs Tools Windows Help

F EI DY S L Ol RBXARN: B Y. DEEL Y BB,

it method of managing the
Shaw 1P Traffic ices ... Routers,
rs, Wireless Access

i x
hode List [ | & ouckstart] 4px
Hade: £ ) o =&
= @ Cisco Access Points - 1
+ @ S-apt Toolbars | Commands | nBs  ShowZal A TIELY! 2
. e
2}, ST Show Conmmands: k)
= @ Cisco Test Routers - Nae |[5how £CDF Meighbors .. | &
1€ Ciseat 21 Add/Edit Show Commands ..
=& Foundry Test Routers Show Version Commnand | show e nghbers |
@ Foundry-Test Show Interfaces Image [ 16416 bitmap, GIF or icon o
& Show CDP Neighbors - a
— &
Show Buff o
Show Processes CPL -
Bl Show DHCF Servers .. iration Management
Al Show Logging .

click the right mouse
uration is downloaded in
SH1. Al downloaded
Shew commands can be dragged out of this ligt and dropped on any Menu or Toolbar 0 a central database for

COMmparson

Gl stared by Adding or mporting Metwork Devices

5 Add Devices Onece youe added a Network Devices, right-click on it

to download it's configuration, xecute command
scripts, update it's Inventory, etc.

The Show Command dialog is displayed where the command and the name of the
Show Command can be changed. Click the ellipsis button to select a different icon
for the Show Command if necessary. Click OK to save the changes.

To create a new Show Command, click the New button and then give the
command a name.
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%1 Show Command [‘S_<|

Mamme [Mew Show Command |

Command | show version |

Image g 16416 bitmap, GIF, or icon
Add to Show menu

[ Ok ll Cancel l

Type in the execute command and click the ellipsis button to select a different icon
for the Show Command if necessary. Check the Add to Show menu box to include
the new Show Command in the right-click and menu list. Click OK to save the
changes.

Tools Tab

#A Configuration Management Customization PS_<

Tools,

Add/Edit Tools o] Hew

IP Metwork Browse Selected Address .
8 Bandwidth Gauges for selected Interface .

Graph Selected 5tatistic
el Ping..

Telnet ...

Wieh Browser
Intemal'w/eb Browser
Current Traffic ...
Wirelesss Clients ..
TraceFloute

1P Metwork Bravser ...
CPU Load ... bt

Tools can be dragged out of this list and dropped on any Menu or Toolbar

The Tools listed here appear in the right-click menu and in the Tools menu. To
remove a Tool, select the Tool from the list and click Delete. To edit a Tool, select
the Tool from the list and click Edit.

UREECEON-NUR N -
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i Nodes Configs 3¢ Inventory Reports
- Hame [ Telnet ]
F EI DY S L ©
Pogam | =
i X
Mode List R %) Quick Sta
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U_ = . 22 Configuratio Macros can be uged to pass information about the selected device to the exdernal program.
=@ Cisco Access Points
+ @ S-apt Toolbars | Commai
@ SW-ap2 o Example: telnet.exe §{RkgentIP}
=14 Cisco Test Routers §{igentIP} IP Address ${Community} SNMP Comwunity String
7€ Cisco12-1 AIEDTY | ¢/ syoname; System Hame
= & Foundry Test Routers IPNetwork | | s 4vendars vendor
@ Foundry-Test @ Bandwidh | | $¢Now) Current date and time
[ Graph Sele:
i) Ping Custom properties can also be passed on the cormmand line to the external program,
‘. Telet Example . SomeProgram.exe §{SysName} ${Building}
& webBrows|
&) Irtemalwe Toolbar Image B | Change Toolbar Image | 1616 bitmap, GIF, or icon
By Curent Traf
G wirslesss O]
& TraceRoutg
[®] 1P Network Brower— e =
v| uration is downloaded in
B} CP1lLoad - SHI. Al downloaded
Tools can be dragged out of this list and dropped on any Meru or Toolbar 0 a central database for
comparison,
Gl stared by Adding or mporting Metwork Devices
5 Add Devices QOnece you'lve alddad a Metwork Devices, right-click on it
to download it's configuration, xecute command
scripts, update it's Inventory, etc.
v

The Tools dialog is displayed where the Program and the name of the Tool can be
changed. Click the Change Toolbar Image button to select a different icon for the
Tool if necessary. Click OK to save the changes.

To create a new Tool, click the New button and then give the Tool a name.

Name [Hew Tool

|
Program ‘ ‘ E

Macros can be used to pass information about the selected device to the external program

Example: telnet.exe §{AigentIP}

${igentIP} IP Address ${Community} SNMP Community String
§{3yshams}; System Nawme

#{Vendor} Vendor

#{Now} Current date and Cime

Custom properties can also be passed on the command line to the external program.
Example . SomeProgran.exe §{3ysName} #{Building}

Toolbar Image Change Toolbar Image 1E41E bitmap, GIF, or icon

Add new taol to the Tools menu

Select a Program using the ellipsis button to the right of the Program text box.
Click the Change Toolbar Image button to select a different icon for the Tool. Check
the Add new tool to Tools menu box to include the new Tool in the right-click and
menu list. Click OK to save the changes.
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Options Tab

7A Configuration Management Customization ﬁ‘

Toolbar Style

[ Oficese Ofice? |

J
[ ofeezon ] [ Oeezom |

Menu dnimations | System Default v

The Options tab is used to select the Toolbar Style and Menu Animations. To
change the Toolbar Style, simply click the button of the Style desired. To select a
Menu Animation, select a Style from the dropdown list to change how menus are
displayed when accessed.
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Appendix C: Macros

Cirrus Configuration Management uses a similar macro system as the one in
Orion Network Performance Monitor. Macros always begin with a dollar sign
and curly brace ${ and always end with a curly brace }.

Macros can be used within almost any custom property. They can also be used in
any of the user editable system properties.

Macros can also be nested and recursive. In other words, a single macro can refer
to a Node property that contains more macros that then contain more macros. The
following example demonstrates nested macros.

Node Property Value of Property

Location Rack ${Rack} on ${Floor} floor of
${Building} - ${SysLocation}

Building Building C

SysLocation Data Center A

Rack 15

Floor Second

The database value of Location is “Rack ${Rack} on ${Floor} floor of ${Building} -
${SysLocation}”, but the displayed value of Location would be “Rack 15 on
Second floor of Building C — Data Center A”.

Node Macros

All fields in the Nodes table can be used as Macros. This includes any custom
properties added to the Nodes table.

Nodes Table Field Description

NodelD Unique ID assigned to each Network Node

NodeCaption Displayed name for the Node. The default for
NodeCaption is a macro. “${SysName}”

NodeGroup Group that this Node belongs to. Some group

T

examples might be ... “Routers”, “Accounting”, or
simply “${Building}”. The last example refers to a
custom property named “Building”.

AgentIP The IP address used when communicating with
the Node. A router or server may have many IP
Addresses. This IP address is the one used
when making Configuration Management makes
SNMP requests or transfers configs.
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AgentIPSort Numeric equivalent of the AgentIP. Used for
sorting by IP Address in reports.
ReverseDNS Reverse lookup of the AgentIP

ResponseTime

Current response time of the Node in
milliseconds

ResponseError “OK” if the Node is responding. An error
message if the Node is not responding.

Status Numeric status of the Node.
1=Up
2 = Down

Community SNMP Community string

SNMPLevel The version of SNMP supported by the Node.
0 = SNMP not supported
1= SNMP V1
2 = SNMP V2
3 =SNMP V3

SysName System name of the Node.

SysDescr System description of the Node.

SysContact System contact information collected from the
Node.

SysLocation System location information collected from the
Node.

SystemOID System OID discovered from the Node.

Vendor Hardware vendor of this network Node.

Vendoricon Name of the Vendor icon used.

MachineType Type of hardware. This information is discovered
by SolarWinds Discovery Engine.

LastBoot Last time the Node rebooted.

OSImage Operating system running on the Node

OSVersion Version of the Operating System running on the
Node

ConfigTypes Types of Configs supported by this Node

NodeComments Any comments about this Node entered by the

user.

NextDiscovery

Time the next complete discovery of this Node is
scheduled

NextPoll Time the next poll (up/down and response time)
is scheduled

Username Login username

Password Login password

EnableLevel Enable level used when transferring configs or

running scripts

EnablePassword

Enable level password

ExecProtocol The protocol used when executing scripts. This
is set to ${GlobalExecProtocol} by default.
TransferProtocol The protocol used when downloading configs.
This is set to ${GlobalTransferProtocol} by
default.
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Config-Archive Macros

Cirrus Configuration Management stores all downloaded Configs in a database. It
can also store a copy of them in the Config Archive directory structure. The
directory structure can be specified using any of the previous macros.

Additional macros can also be used when specifying the Config Archive directory.
Many of these macros use the system’s localization settings for the current
language and region.

Property Description

DateTime Local date and time in “short date” and local
time format

Date Date in “short date” format

LongDate Date in “long date” format

MediumDate Date in “medium date” format

Time Time in “short time” format

LongTime Time in “long time” format

MediumTime Time in “medium time” format

ShortTime Time in “short time” format

DOW Day of the week (spelled out)

D Day of the month

DD Day of the month (with leading zero if needed)

ABREVIATEDDOW | Day of the week in abbreviated format

LocalDow Day of the week in the local language

Month Number of the current month

M Number of the current month

MM Number of the current month (with leading
zeros if needed)

MMM Abbreviated name of the month

MMMM Name of the month

LocalMonthName Name of the month in the local language

DAYOFYEAR Day number of the year

YYYY 4 digit year

YY 2 digit year

YEAR2 2 digit year

YEAR4 4 digit year

H Hour

HH 2 digit hour (with leading zero if needed)

N Minute

NN 2 digit minute (with leading zero if needed)

S Seconds

SS 2 digit seconds (with leading zero if needed)

AMPM AM or PM

CRLF Carriage return — linefeed combination

ConfigType Type of Config ( running, startup, etc )

Caption Caption of the Node (NodeCaption)

Config-Archive Macros
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Command Script Macros

Command Script Macros are used within Command Scripts as well as Device
Command Templates. For information on creating Command Scripts , refer to
Chapter 5: Command Scripts on page 57.

Property Description

ConfigType Value used to specify the type of Config

CR Carriage Return

CRLF Carriage Return — Linefeed combination

DownloadConfig Series of commands used to download a
Configuration from a device

Enableldentifier Only used when a device does not return

the “#” symbol at the end of a prompt to
indicate Enable Mode. Value that is
displayed while in Enable Mode for a device.

EnterConfigMode Series of commands used to enter the
Configuration Mode of a device

ExitConfigMode Series of commands used to exit the
Configuration Mode of a device

IPAddress The IP Address of the server Cirrus is
installed on

Reboot Series of commands used to reboot the
device

RebootAt Series of Commands used to reboot a

device at a specified time. Use the macros
listed in the Config-Archive Macros section
of this Appendix to assign the date and time.

RESET Series of commands used to set the length
and pagination of the session

Running Value used to specify a Running Config type

SaveConfig Series of Commands used to write the
Configuration to the devices memory

Startup Value used to specify a Startup Config type

Version Series of Commands used to display the

software version of the device
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Appendix D: Regular
Expression Pattern Matching

When editing Comparison Criteria, the following Regular Expressions can be used
for pattern matching.

Characters
Character Description Example
Any character All characters excep’F the l?sted special
AG | o% characters match a single instance of a matches a
except [\"$.17*+()
themselves.

\ (backslash)
followed by any of
[\$.17%+()

A backslash escapes special characters to

. . . \+matches +
suppress their special meaning.

Matches the character with the specified

FF where FF A t
UEFwhere FEare |, o Nigi value, which depends on the |0 Matches ©
2 hexadecimal . when using the

- code page used. Can be used in character .
digits Latin-1 code page.
classes.
Match an LF character, CR character and a|\r\n matches a
\n, \rand \t tab character respectively. Can be used in [DOS/Windows

character classes. CRLF line break.

Character Classes or Character Sets [abc]

Character Description Example

Starts a character class. A character class
matches a single character out of all the
possibilities offered by the character class.
Inside a character class, different rules

[ (opening square apply. The rules in this section are only

bracket

racket) valid inside character classes. The rules
outside this section are not valid in
character classes, except \n, \r, \tand
\xFF

Any character

except *-]\ add that
character to the All characters except the listed special [abc] matches a, b
possible matches  |characters. or ¢

for the character
class.
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\ (backslash)

A backslash escapes special characters to |[\"\]] matches *
followed by any of . . .
A\ suppress their special meaning. or |
- (hyphen) except  |Specifies a range of characters. (Specifies a |[a-zA-Z0-9]
immediately after |hyphen if placed immediately after the  |matches any letter
the opening [ opening [) or digit
A (caret) Negates tbe character class, Czjtusmg it to ["a-d] matches x
. . match a single character not listed in the
immediately after i ) (any character
. character class. (Specifies a caret if placed
the opening [ excepta, b, cor d)

anywhere except after the opening [)

Shorthand character classes matching

digits 0-9, word characters (letters and [\d\s] matches a
\d, \wand \s digits) and whitespace respectively. Can |character thatis a
be used inside and outside character digit or whitespace
classes
Negated versions of the above. Should be |\D matches a
\D, \Wand \S used only outside character classes. (Can |character that is
be used inside, but that is confusing).) not a digit
Dot
Character Description Example
Matches any single character except line matches x or
break characters \r and \n. Most regex
. (dot) . (almost) any other
flavors have an option to make the dot character
match line break characters too.
Anchors
Character Description Example

Matches at the start of the string the regex pattern
is applied to. Matches a position rather than a

A. matches a in
abc\ndef. Also

A (caret) character. Most regex flavors have an option to matches d in

make the caret match after line breaks (i.e. at the |, .
L . multi-line" mode.

start of a line in a file) as well.
Matches at the end of the string the regex pattern
is applied to. Matches a position rather th.an a $ matches fin
character. Most regex flavors have an option to abe\ndef. Also

$ (dollar)  |make the dollar match before line breaks (i.e. at )

the end of a line in a file) as well. Also matches
before the very last line break if the string ends
with a line break.

matches cin
"multi-line" mode.
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Matches at the start of the string the regex pattern

\A. matches a in

\A is applied to. Matches a position rather than a abe
character. Never matches after line breaks.
Matches at the end of the string the regex pattern
is applied to. Matches a position rather than a .
.\Z matches f
\Z character. Never matches before line breaks, \Z matches fin
. . . abc\ndef
except for the very last line break if the string
ends with a line break.
Match(.es at the end of the StI:ll:lg the regex pattern \z matches fin
\z is applied to. Matches a position rather than a abc\ndef
character. Never matches before line breaks.
Word Boundaries
Character Description Example
Matches at the position between a word character
(anything matched by \w) and a non-word
\b character (anything matched by [*\w] or \W) as |.\b matches cin
well as at the start and/or end of the string if the |abc
first and/or last characters in the string are word
characters.
Matches at the position between two word
\B characters (i.e the position between \w\w) as \B.\B matches b
well as at the position between twonon-word  |in abc
characters (i.e. \W\W).
Alternation
Character Description Example
Causes the regex engine to match either the part |abc|def|xyz
| (pipe) on the left side, or the part on the right side. Can |matches abc, def
be strung together into a series of options. Or Xyz
The pipe has the lowest precedence of all abc(def Ixyz)
| (pipe) operators. Use grouping to alternate only part of [matches abcdef or
the regular expression. abcxyz
Quantifiers
Character Description Example
Makes th ding it tional. d
? (question akes the preceding item optiona Gree Y80 | 12 matches ab
the optional item is included in the match if
mark) . or abc
possible.
”?

Makes the preceding item optional. Lazy, so the

abc?? matches ab
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optional item is excluded in the match if possible.
This construct is often excluded from
documentation because of its limited use.

or abc

* (star)

Repeats the previous item zero or more times.
Greedy, so as many items as possible will be
matched before trying permutations with less
matches of the preceding item, up to the point
where the preceding item is not matched at all.

"*" matches "def"
"ghi" in abc "def"
"ghi" jkl

Repeats the previous item zero or more times.
Lazy, so the engine first attempts to skip the

" *?" matches "def"

>(-? 1 t : nd fn " hin
(lazy star) previous item, before trying permutations with 11k11abc e
ever increasing matches of the preceding item.

Repeats the previous item once or more. Greedy,

so as many items as possible will be matched "+" matches "def"
+ (plus) before trying permutations with less matches of |"ghi" in abc "def"

the preceding item, up to the point where the "ghi" jkl

preceding item is matched only once.

Repeats. the previous item once or more. Lazy, so " 19" matches "def"
+? (lazy the engine first matches the previous item only i abe "def" "ohi"
plus) once, before trying permutations with ever . &

increasing matches of the preceding item. )
{n} wheren

is an integer
>=1

Repeats the previous item exactly n times.

a{3} matches aaa

{n,m} where

Repeats the previous item between n and m

. . . . a{2,4} matches aa,
n>=1 and m|times. Greedy, so repeating m times is tried 24
: . . aaa or aaaa
>=n before reducing the repetition to n times.
n,m}? Repeats the previous item between n and m
nm} P P a{2,4}? matches

wheren>=1
andm>=n

times. Lazy, so repeating n times is tried before
increasing the repetition to m times.

daaa, aaa Or aa

{n,} wheren
>=1

Repeats the previous item at least n times.
Greedy, so as many items as possible will be
matched before trying permutations with less
matches of the preceding item, up to the point
where the preceding item is matched only n
times.

a{2,} matches
aaaaa in aaaaa

{n,}? where n
>=1

Repeats the previous item between n and m
times. So the engine first matches the previous
item n times, before trying permutations with
ever increasing matches of the preceding item.

a{2,}? matches aa
in aaaaa
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Appendix E: Frequently Asked
Questions

Q Can I download more than one configuration file at a time?

A Yes. Select multiple Nodes from the Node List by using the Shift and
Ctrl keys, or selecting a group. Right-click and select Download
Configs. Choose the type of configuration to download and any After
Download actions, and then click Download. The configs will be
downloaded from selected nodes simultaneously.

By default, up to 25 simultaneous downloads can be allowed. To change
this, select Settings from the file menu, and then go to Config Transfers
under the Configs category.

Q Can I upload just a few lines of a configuration instead of the entire
configuration file?

A Yes. To upload only one line or selection of lines, highlight the lines
and then right-click and select Upload Selected Lines. For more
detailed instructions, please refer to Uploading Configs in Chapter 4:
Managing Configs on page 43.

Q Why do I receive a message prompting me to upgrade when I try to launch
TraceRoute, IP Network Browser, or MIB Browser?

A These tools are part of the SolarWinds Toolset packages. These
packages can be purchased and will need to be installed on the same
system running Cirrus. For information regarding the toolsets, please
visit this link: http://www.solarwinds.net/Toolsets.htm

Q How do I group Nodes so that I can roll out a config to part of the network?

A Nodes can be grouped a number of different ways. First, Nodes can be
grouped by Node Group. To assign a group to a Node, edit the
Node’s details by double-clicking the Node in the Node List. Then edit
the Node Group field to assign the group. The Node List can also be
grouped by almost any other Node Detail such as Location. To group
the Node List by another category, right-click anywhere in the Node
List and click Select Fields and Grouping. Change the Grouping
dropdown to the category desired and click OK to save the changes.
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Q

What types of equipment does Cirrus work with?

A Cirrus Configuration Management supports many types of network
Nodes from many hardware vendors. Device Command templates for
Cisco, Foundry, Dell, HP Juniper, Motorola, Arris and many others are
included.

How do Iintegrate Cirrus with Orion?

s of Fa , Cirrus does not directly integrate wi on Networ!

A As of Fall 2005, Ci d directly integr ith Orion N k
Performance Monitor. SolarWinds plans to release a version of Cirrus
in the future that will integrate with Orion and Orion’s website.

Can I import nodes from Orion into Cirrus?

A Yes. Select Import Devices from the File menu to start the import
process. For detailed instructions on how to import Nodes from an
Orion NPM database, please refer to Importing a List of Nodes in Chapter
3: Managing Nodes on page 21.

Can I import nodes from my Engineer’s Edition toolset to Cirrus?

A Yes. Select Import Devices from the File menu to start the import
process. For detailed instructions on how to import Nodes from an
Engineer’s Edition database, please refer to Importing a List of Nodes in
Chapter 3: Managing Nodes on page 21.

What is the upgrade price from Professional Plus to Cirrus?

A The toolsets and Cirrus are two separate packages. An upgrade path
from any of the toolsets is not available for Cirrus

Can Cirrus use an Oracle database?

A The Desktop version of Cirrus supports a Microsoft Access database
format. The Enterprise version of Cirrus supports both Microsoft
Access and SQL database formats.

Can Cirrus configure a router through the serial interface/console cable?

A Routers and all other Nodes can only be configured through Telnet
and SSH using Cirrus.

What new features are on the roadmap for Cirrus?

152



&3 Recycled Paper Appendix E: Frequently Asked Questions

A solarWinds plans to integrate Cirrus with Orion NPM and the Orion
Syslog Server in the near future. Additional features such as policy
control and additional device template support are just some of the
additional functions SolarWinds is planning to add.

Q Can Cirrus run on the same server as Orion?

A Yes. Cirrusis designed to be fully compatible with all SolarWinds
software including Orion NPM.

Q Can Cirrus share a database with Orion?

A The Cirrus and Orion database structures are significantly different.
However, Nodes can easily be imported from the Orion NPM
database. For detailed instructions on how to import Nodes from an
Orion NPM database, please refer to Importing a List of Nodes in Chapter
3: Managing Nodes on page 21.

Q Can the Cirrus database reside on the same SQL Server as Orion’s?

A Yes. Cirrus and Orion both have the ability to use remote databases.
This means that the same SQL server can host both the Orion and
Cirrus databases assuming the server is capable of handling the load of
multiple databases.

Q Can Cirrus run on UNIX?

A SolarWinds software is designed to run exclusively on Microsoft
Windows platforms.

Q My domain password changed, now my jobs won’t run and there is
nothing in the job log, what do I need to do?

A 1o reassign the new password to all jobs, open the New/Open Database
Wizard from the File menu, select Continue Using the Current Database,
and click Next. Continue clicking Next until the Scheduled Job
Authentication settings are displayed. Type the new username and
password, and then click Set Username and Password to update the
changes.
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Appendix F: Glossary

Access Point (AP)

Bandwidth

Community string

Config

Config Snippet

Custom Property

DNS

Event

ICMP

Interface

MAC Address

Macro

A Network Node that interconnects a wireless radio
network to a wired LAN (Local Area Network).

In digital communications, the rate at which data is
communicated (usually in bits per second).

The “password” required for an SNMP client to request
MIB information from an SNMP server.

Short for configuration file. An Industry standard term
referring to the configuration of a router, switch, firewall, or
other network Node.

A string of text that can be saved to a file allowing the user
to merge sections of configs with ease. Config Snippets can
be used to edit an existing config, or can even be uploaded
directly to a Node or group of Nodes.

Additional fields (country, building, asset tag, serial
number, etc.) that can be defined and stored in the Cirrus
database. Custom Properties are used to help identify and
group like Nodes.

An acronym for Domain Name Server. A system of
computers that convert domain names into IP addresses.

An unsolicited communication from a hardware device to
an application driver. Events are generally attention-getting
messages, allowing a person or process to know when a
task is complete or when an external event occurs.

An acronym for Internet Control Message Protocol. A
network-layer Internet protocol that provides message
packets to report errors and other information relevant to IP
packet processing.

A port or logical connection on a node.

An abbreviation for Medium Access Control Address. A
48-bit unique number administered by the IEEE and
assigned to LAN cards.

A statement in software code that is expanded into one or
more identifiers or statements and can consist also of one or
more parameters.
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MIB

Node

Node List

PING

Purge
SNMP

SSH

Telnet

An acronym for Management Information Base. A MIBis a
database of network performance information that is stored
on a network Node for access by network management
software.

Any device with an IP address; a network device that is
polled. A Node may contain many elements. An example
of a Node would be a router or network server.

In the Cirrus Configuration Management application, the
left-most pane of the program window that contains an
expandable list of Nodes and configuration files.

To test whether a particular network destination is online.
By bouncing a “signal” off a specified IP destination
address.

To remove records from a database.

An acronym for Simple Network Management Protocol. An
IP-based application layer protocol that is the industry
standard way that network Nodes communicate with
network management systems.

An Acronym for Secure Shell. A UNIX-based command
interface and protocol for securely getting access to a remote
computer. Network administrators use it to control Web
and other kinds of servers remotely.

A program that connects to other computers on the Internet.
The process by which a person using one computer can sign
on to a computer in another city, state or country.

Most definitions included in this Glossary were obtained from Newton’s Telecom
Dictionary by Harry Newton and published by CMP Books.
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